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For use with the following product codes [REF],

Main Module EXACTA-M (RoHS compliant); 2400-M (non-RoHS)
Load Cell EXACTA-LC (RoHS compliant); 2400-L (non-RoHS)
Display Module | EXM24DY; EXME24DY

Vial Rack EXACTA-VS; EXACTA-VLS; EXACTA-VL; EXACTA-V
Base Plate 2400-B

All the refurbished product codes of above modules are also applicable to this manual.

TERMS IN THIS MANUAL

WARNING
Indicates a risk of personal injury or patient harm if the instructions are not followed

é CAUTION
Indicates a risk of damage to equipment or data if the instructions are not followed

IMPORTANT! Provides important information
NOTE: Provides additional information
Tip! Provides a recommendation

In the electronic version of this manual, underlined text and Table of Contents entries provide
hyperlinks to other sections.
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Introduction

INTRODUCTION

The Baxter ExactaMix Pro 2400 Compounder is an automated pumping system that compounds
multiple sterile ingredients into a finished solution in a single patient bag. Using a formula
provided electronically or entered manually, the compounder withdraws a specified volume of
each ingredient from its source container in a specified sequence, and pumps each ingredient
into a patient bag. The finished solution is delivered to patients intravenously.

You can use the compounder to compound solutions such as:

Total Parenteral Nutrition (TPN)

Continuous Renal Replacement Therapy (CRRT)
Cardioplegia

Base solutions

Epidurals

WARNING
The compounder software is not intended to replace the professional judgment or

knowledge of a pharmacist or pharmacy technician.

WARNING
Operators should be trained according to this manual before using the ExactaMix

Pro compounder.
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Components

COMPONENTS

HARDWARE COMPONENTS

The compounder consists of these main hardware components:

Vial rack T

Load cell

Main module -

Base plate
Display

Barcode reader

Hardware components
NOTE: The vial rack extension (optional) and the printer (North America only) are not shown.
The main module contains the moving parts of the compounder, including these parts:
e The valve actuators open and close as needed to allow the delivery of individual
ingredients. When the pump is paused, the valve actuators automatically close.

Operator Manual

ExactaMix Pro 2400 Compounder
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Components

The occlusion detector detects occlusions (blockages) in the tube between the source

containers and the detector.

The bubble detector detects air bubbles as they pass through the tube over the
detector.

The pump door allows access to the pump rotor.
The pump rotor moves the fluid from the valve set to the destination bag.

Occlusion detector

Valve actuators

Bubble detector

Pump door

Pump rotor

\x

|

X

M
LN

Main module, with close-up view of the top

Operator Manual
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Components

The load cell weighs each destination bag
and sends this measurement to the
display, where calculations are performed.
A 2,000 g calibration weight for use in
calibrating the load cell is provided with
the compounder.

Load cell

The display operates the compounder
software and includes a touch screen for
data entry. The bottom and the side of the
display contains two USB ports each, which
can be used to connect a barcode reader,
keyboard, mouse, and printer or USB drive.
The bottom of the display also contains
one Ethernet port.

Display

The barcode reader is stored on the right
side of the display. This reader is used to
scan barcodes on the labels of source
containers, inlets and patient bags.

The barcode reader model may vary.

The barcode reader holder is attached to
the right side of the display module. It
stores the barcode reader when it is not in
use.

Barcode reader holder

Operator Manual ExactaMix Pro 2400 Compounder
Page 4 0719003109 Rev. A, Effective Jan 2022




Components

The vial rack attaches to the main module.
Adjustable vial holders and syringe holders | | |
attach to the vial rack. -

Vial rack
The base plate is the common base on
which the compounder’s components are -
mounted. -
\ ' .
~ = _ ‘
Base plate

A laser printer (North America only), used
for printing reports and labels, can be
connected directly to the display or to a
network.

Printer models may vary. —

Laserset Pro MAD4dn

Printer

The display cable is a serial cable that
provides communication between the
main module and the display module.

Display cable

Operator Manual ExactaMix Pro 2400 Compounder
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Components

DAILY USE COMPONENTS

e The valve set is a sterile, multiple-port valve with an outlet tube attached. The valve
body fits over the valve actuators on the compounder, protecting them from damage.
The outlet tube attaches to the destination bag. For ordering information, refer to Valve
Sets on page 17.

e Theinlet is a sterile tube with a spike or Luer end attached. The spike or Luer end
attaches to a source container, and the other end attaches to a port on the valve set.
The type of inlet that is used depends on the source container. For inlet types,
descriptions and ordering information, refer to Inlets on page 17.

NOTE: The valve set and inlets are collectively known as the tube set.

e The destination bag is a sterile container that holds the fluid pumped from the source
containers. There are two main types of destination bags, available in different sizes.
See Bags on Page 18 for bag descriptions and ordering information.

o The patient bag is used for delivering the finished solution to a patient. This bag
has three ports for filling the bag, adding ingredients manually and delivering the
finished solution.

o The calibration bag is used for collecting any fluid that is not intended for a
patient. Such as while calibrating and priming the compounder. This bag has only
one port for filling the bag. The calibration bag is available in North America only.

Valve set Inlet Patient bag Calibration bag

SOFTWARE

Baxter ExactaMix Pro 2400 Operating Software is installed on the compounder display.

To comply with regulations of the United States Food and Drug Administration (FDA), the
compounder has been validated and approved for use only with the software that Baxter
Healthcare Corporation provides.

License

The license to use the compounder software is granted to a single concurrent user on a single
ExactaMix Pro 2400 Compounder for the term of the equipment contract. Baxter retains
ownership of the software. Distribution or copying of this software, other than for backup
purposes, is expressly forbidden.

Operator Manual ExactaMix Pro 2400 Compounder
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Components

Permissions

The options that appear in the software depend on the permissions granted to the user. If you
have questions about your permissions, contact your supervisor. For more information about
setting up permissions, refer to Setting Up the Users on Page 120.

Navigation

On any screen or window that requires data entry, tapping a field displays an on-screen
keyboard or number pad that allows you to enter characters.

q W e r t y u i o p [ ]
a S d f g h j k | oK
Caps Lock z X C Y% b n m , . / Caps Lock
&123 @& British English Cancel

On-screen keyboard

[o
7 8 9 &
4 5 6 Cancel
1 2 3
OK
0
On-screen number pad
Operator Manual ExactaMix Pro 2400 Compounder
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Components

Menu Screen

The menu screen provides access to menus and settings.

Q0

RAINSE EDIT COMPOUND

R OIONES XEFORTS RISEAINE

Menu screen
The menu screen has the following six options:
e File menu: allows formula management, software log in/logout/exit, compounder
restart or compounder shutdown.

e Edit menu: for editing the configurations, formulary, ingredient groups, inlet
information and bag information

e Compound menu: sets up the compounder for operation, selects a formula to
compound and manage ingredients

e Tools menu: sets up options related to the system, users, security, directories used for
saving certain files. and software maintenance.

e Reports menu: allows users to view, print and export reports related to compounding
and other device activity.

e Help menu: provides tutorials and information about the hardware and software.

Tapping Close at the bottom right displays the pump screen (or a similar screen during the
setup process). You can also display the pump screen by selecting certain functions, such as
those on the Compound menu.

Operator Manual ExactaMix Pro 2400 Compounder
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Pump Screen

The pump screen shows a diagram of the valve set. It is used during the compounding process.
Similar screens are used during setup.

Formula Name: JaneDoeManualAddi... Formula Serial #: DE 30Sep2021 195427
Run
NaAc2 Csoll5 Hepl000 CaGluclo SWFI
‘( M. m. M i M i ‘( B v
OomL 900mL 1mL 10mL OomL
3 ] 9 114 115 113
NaPhos3 E NaCla E Dex70
M BB W
5mL o 28mL - - - 385mL
- L\ e I - " "
O o000 00 060 e e
4 6 8 10 12 14 16 18 20 22
E KPhos3 E KCi2 MTE5Conc E
=) LB =
o omL o 30mL ImL "
Rl e U2 [ 110 H
Inf:vA KA.cZ Mg.Sod SWFI
o ‘( = M Bl v ‘( B
10mL 0omL 2mL
] 7 ] 4 112 | 113

Volume: 2001.00mL
Loading Formula JaneDoeManualAddition/DE 30Sep2021 195427...Done.

Pump screen at the start of the compounding process

The appearance of the pump screen changes slightly during various steps of the compounding
process. However, the screen always includes these elements:

e The Formula: <formula name / patient name> and Serial #: <serial number> appear at
the top of the screen.

e Buttons appear on the left side of the screen. Tapping Run starts the compounding
process. Tapping Menu displays the menu screen.

e The total volume to be pumped for the order appears under the Menu button.

e A diagram of the valve set with numbered ports appears in the middle of the screen.
Ports that:

o Have no ingredient attached have an X over them

o Have an ingredient attached have an ingredient button connected
o Have the Universal Ingredient attached are identified by a U

o Make up an electronic Y-site are identified by colored highlighting

Operator Manual ExactaMix Pro 2400 Compounder
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Formula Name: DOE, JOHN 1234 Formula Serial #: DE 06Aug2021 150513

Pause l

NaAc2 Csolls CaGluclo SWFI
v v v v
0.00mL 900.00mL 10.00mL |429‘00mL
(¢ 3 ] 9 | 114 I 113

NaPhos3

| \,1 ‘( 8.
0.00mL

NaCla

5.00mL 28.00mL

=}

1
@ 8 & &
6 14 16 18

- | il

: KPhos3 Kci2 MTESConc

0 ‘( [ 6 v 10 R 14 Rv

o 0.00mL 30.00mL 1.00mL

H 5 \ 2 110

InfuvA KAc2 MgSed SWFI
L v v v | v
10.00mL 00mL 2.00mL 0.00mL
7 ] 4 112 I 113

Volume: 2000.00mL

Running 28 ghL of Na Chloride 4mEg/mR® from port 9
Abbreviated
ingredient name

g Port Number
. Green Checkmark
Ingredient status bar
28.00mL Ordered Volume
Pumping status bar - .
1 Number in sequence

Ingredient button details
On the pump screen, each ingredient button includes:

e The abbreviated ingredient name
e The port number

e A green check mark indicating that the inlet and port have been verified, or a red X
indicating that they need to be verified.

e The ordered volume of the ingredient
e A numberindicating the ingredient’s place in the compounding sequence

e A vertical bar showing how much of the ingredient remains in the container. during
compounding, this bar decreases as the remaining volume decreases.

e A horizontal bar showing how much of the ingredient is being used for the current

order. During the compounding process, this bar increases as the pumped volume
increases.

When an ingredient is being pumped, its button is shown in blue. An animation shows fluid
moving through the inlets and the outlet tube into the destination bag. Horizontal marks across
an inlet represent fluid, indicating that this inlet has been primed.

Operator Manual ExactaMix Pro 2400 Compounder
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Tutorials

The compounder software includes step-by-step tutorials about setting up the compounder.
To view the tutorials:

1. At the menu screen, tap Help > Tutorials.
2. At the tutorials window:

e With the Contents button, tap a topic to display the associated help content.
e With the Index button, enter and search for keywords.
[ ]

With the Search button, search any topics

ExactaMix Pro 2400 Compounder Tutorial

(4] Conterts [E] Index () Search

- Search - m
0 e e = Home > Help Guide > Starting Up and Logging In
[7] Starting Up and Logging In STARTING UP AND LOGGING IN
s Setting up the Compounder

@ Using the Compounder 1. On the main module, press and hold the power button until the power light illuminates.
@ Other Activities

Logging Out

Rebooting and Shutting Down 1
Cleaning the compounder | ‘ |
@ Troubleshooting

Replacing the Scanner Holder |
Replacing the Battery Door |

Power light | |
7] RTC replacement |
? 1 e L
9% \l
Power hutton
“‘\ | ‘ ,

Power light and power button

2. When the Login window appears:
a. Enter a Login name.

b. Enter a Password. (NOTE: Passwords are case-sensitive)
c. Tap Log In.

Login

Password

Tutorials window

Operator Manual ExactaMix Pro 2400 Compounder
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FEATURES

SUMMARY OF FEATURES

The compounder:

Accepts formulas created by order-entry software via 2D Formula Barcode/PAT/FRM file
interface, or by direct entry on the compounder

Uses barcodes on the source containers and inlets to promote proper setup
Includes software with a Setup Wizard to guide users through the setup process

Supports a maximum of 24 ingredients, source containers in volumes of 10-5,500 mL
and destination bags in volumes of 125-5,000 mL

Allows attachment of the same ingredient to more than one port, creating an electronic
Y-site

Allows specification of the sequence in which ingredients are pumped
Allows specification of accuracy limits for the finished solution

Uses volumetric delivery, gravimetric verification, and automatic calibration to help
ensure delivery accuracy

Uses a bubble detector and occlusion detector

Can be immediately stopped by lifting the pump door

Can track ingredient lot numbers and ingredient expiration dates
Generates a MixCheck Report for each finished solution

Can be set up to communicate with a printer

Can print reports and barcode labels at the compounder’s printer

Can be set up to communicate with the order entry system through a wired or wireless
network

Allows users to identify facility specific ingredients in the formulary

Allows authorization of MixCheck reports online

ORDER ENTRY

Order entry can be done through direct entry (see Page 78), or by using separate order-entry
software.

The ExactaMix Pro compounder operating software can communicate, via a network, with
order-entry software on a separate computer. The order-entry software must produce a
.PAT/.FRM file and a corresponding barcode. Scanning the barcode at the compounder
retrieves the .PAT/.FRM file.

Alternatively, the order-entry software must be able to produce a formula label, containing the
formula details in the 2D barcode. Scanning the 2D barcode loads the formula onto the
compounder. For more information, refer to Fulfilling the Order (Basic Process) on Page 70.

Operator Manual ExactaMix Pro 2400 Compounder
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FORMULARY

The formulary is the list of ingredients, and associated products, that may be attached to the
compounder.

An ingredient is a solution of a specific chemical entity at a specific concentration regardless of
container size, container type or manufacturer. One ingredient can have several associated
products. An ingredient can be made available or unavailable by authorized users.

A product is an ingredient in a particular container size and type from a specific manufacturer.
Several products can be associated to one ingredient group. When an ingredient is set to be
unavailable, all associated products also become unavailable.

For example:

e Ingredient: Dextrose 70%

e Products:
o Baxter Dextrose 70%, 2000 mL bag
o Baxter Dextrose 70% 1000 mL bag

INGREDIENT GROUPS

An ingredient group is a list of chemically similar ingredients. For example:

e Ingredient group: Phosphate

Ingredients: K Phos 3 mMol/mL, Na Phos 3 mMol/mL
e Ingredient group: Calcium

Ingredients: Ca Gluconate 10%, Ca Chloride 10%

Some ingredients can tolerate each other’s presence in the finished solution but must be
separated during compounding to ensure that they do not mix within the common fluid
pathway, or within the patient bag in the absence of sufficient volume. These ingredients are
considered to be incompatible. For example, calcium and phosphate should not be mixed in
their concentrated forms (in the absence of amino acids) or a precipitate will immediately
result. The compounder will pump ingredients from incompatible ingredient groups only if it
can pump a user-specified volume of another ingredient between them.

Each ingredient group has a list of other groups with which it is incompatible. When ingredients
are assigned to these groups, the software can detect formulas in which incompatible
ingredients are not sufficiently separated.

UNIVERSAL INGREDIENT

When a patient bag is removed, approximately 25 mL of the last ingredient pumped remains in
the common fluid pathway. This ingredient then becomes the first ingredient to enter the next
patient bag when the next solution is compounded. Because this ingredient must be suitable
for all formulas, it is called the Universal Ingredient (Ul).

Each formula must include enough Ul volume to allow a final flush, which flushes all previous
ingredients into the patient bag. Regardless of the total volume of the Ul to be delivered, the

Operator Manual ExactaMix Pro 2400 Compounder
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compounder reserves enough Ul volume to perform a final flush at the end of the compounding
process. You can change the volume used for the final flush when creating a configuration.

The Ul is specified by the facility and is typically water or dextrose.

CONFIGURATION

A configuration identifies the products that will be attached to the ports, the sequence in which
they will be pumped, any allowable auto-additions, the ingredient and volume to use for any
ingredient flushes, the Universal Ingredient and the volume to use for the final flush.

BARCODE VERIFICATION

WARNING
It is important to use a barcode reader for scanning labels during verification of the

setup.

A For the barcode verification to be effective, it is critical that the configuration be set up
properly. For instructions, refer to Attaching the New Ingredients and Inlets on
Page 45.

During daily setup, or when a source container must be replaced, the software guides you
through a process of barcode verification. You scan a barcode label on each inlet and each
associated source container to verify that the inlet is attached to the correct container.

Each inlet must be labeled with a barcode that identifies the port to which the inlet is attached.
These barcode labels are packaged with the valve set. The compounder software can also
generate a report that makes these labels available for printing.

Most source containers already have a manufacturer’s barcode label attached. For containers
that are filled or diluted in the pharmacy, the compounder software can also generate a report
that makes these labels available for printing.

Tip! Baxter strongly recommends using the manufacturer’s barcode whenever possible.

MEASUREMENT OF VOLUME AND WEIGHT

The compounder uses volumetric delivery to move fluid, with gravimetric verification to check
the final weight of the destination bag. The compounder also performs an automatic calibration
to maintain delivery accuracy.

Volumetric Delivery

The pump rotor moves as it pumps an ingredient into the destination bag. The amount of
movement determines the volume that is delivered.

Automatic Calibration

The pump is calibrated with water. A flow factor associated with each ingredient adjusts the
flow of that ingredient compared to the flow of water. The flow factor accounts for the
ingredient’s viscosity, the size and type of its source container, its inlet, its venting and other
factors that affect its delivery. As a result, calibrating with water automatically calibrates the
compounder for use with all the other ingredients.

Operator Manual ExactaMix Pro 2400 Compounder
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Every time the rotor pumps an uninterrupted delivery of 175 mL or more of water, the
compounder automatically performs a calibration of the rotor movement. Automatic
calibration maintains the rotor’s accuracy and reduces the need for manual adjustments.

Gravimetric Verification

The compounder provides feedback about its delivery accuracy by weighing the finished
solution and comparing that weight to the theoretical weight of a perfectly compounded
solution. This theoretical weight is computed by this formula:

z (V0|ume|ngredient X SpeCifiC GraVitylngredient)

PRINTING OPTIONS

The printer is used for printing reports and creating labels for inlets and source containers.
The printer can use standard 8.5 x 11 in. (21.6 x 28 cm) letter paper size for reports and Avery
6460 label sheets or equivalent for inlet labels.

To use A4 paper size, navigate to the Options window by selecting Tools > Options. Select the
directories tab. Then in the report’s section select Standard Report (A4 paper size) from the
drop-down menu.

You can connect the printer to a:
e USB port on the display
e USB port on the order-entry computer, for use on a network

e Network via an Ethernet cable
The compounder software includes the printer drivers.

IMPORTANT!
Use only Baxter-authorized printers with the compounder.

Operator Manual ExactaMix Pro 2400 Compounder
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NETWORK CONNECTIVITY

You can connect the compounder via an Ethernet cable or wireless connection to a:

e Facility network

e Mini-net that is typically shared only with the order-entry computer and the
compounder’s printer

The compounder uses the network only to retrieve .PAT/.FRM files, send print jobs, and back
up the database.

Baxter does not support network-related equipment, nor activities related to setting up or
troubleshooting network connectivity for the compounder.

Tip! If you connect the compounder to a network, Baxter recommends taking precautions to
minimize the compounder’s exposure to cyber threats. Refer to Baxter ExactaMix Pro
Cybersecurity Guide document for more information about network security or contact Baxter
Technical Support. Refer to Getting Help on Page 20.

WARNING

Cybersecurity is a shared responsibility. The following guidance should be considered
during implementation and use of your ExactaMix Pro compounder. For further
guidance, refer to the ExactaMix Pro Cybersecurity Guide which can be found at
Baxter’s Product Security website www.baxter.com/product-security.

e Physical access to the device should be limited to only authorized users

e Prepare and perform training for personnel, cautioning them against
credential sharing

e Ensure that IT maintains cybersecurity of the facility’s environment around
the device by performing the following:
o Network segmentation
o Firewalling each network segment, limiting inbound and outbound

connections

o Scanning for unauthorized network access
o Scanning for vulnerabilities and viruses

If you have discovered a potential vulnerability related to the ExactaMix Pro product,
please report this information to productsecurity@baxter.com or call +1-888-887-0098
(if calling from the U.S.).

Operator Manual ExactaMix Pro 2400 Compounder
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Ordering Supplies

ORDERING SUPPLIES

Order supplies through normal channels. For USA/Canada, you can contact Baxter Customer
Service at +1.800.567.2292. For all other countries, find your local customer service contact

details by visiting www.baxter.com/location-selector , selecting your location and using the

contact link.

WARNING
Use only sterile inlets, bags and valve sets validated by Baxter.

VALVE SETS

The following valve sets are approved for the ExactaMix Pro compounder.

Product Order Number O
Case

EM2400 Valve Set H938724 10 Includes:
e Numbered inlet labels with
barcodes
e 10 calibration bags (H938735RS)
EM2400 Valve Set— H938724E 10 Includes:
Except Calibration bags e Numbered inlet labels with
barcodes

Baxter valve sets are sterile, bio-compatible, non-pyrogenic, non-DEHP and contain no natural
rubber latex components.

INLETS

The following inlets are approved for use on the ExactaMix Pro compounder.

Standard Minimum

Order Quantity

Product Number / Case For use with: Priming Priming
Volume Volume
Non-vented H938173 25 Large-volume, vented or collapsible 50-60 25-30 mL
High-Volume containers (such as bags of dextrose and mL
Inlet water)
Vented High- H938174 25 Large-volume, non-vented containers 50-60 25-30 mL
Volume Inlet that require a spike to vent air into the mL
container
Vented Micro- H938175 25 Small-volume vials 5-6 mL 2.5-3mL
Volume Inlet
Micro-Volume H938751 25 Small-volume bags or bottles that 5-6 mL 2.5-3mL
Inlet, with require a large-bore spike
Large-Bore
Spikes
Syringe Inlet H938176 25 50 or 60 mL Luer syringes (regardless of | 5-6 mL 2.5-3mL
the volume they contain)

OEM inlets are sterile, bio-compatible, non-pyrogenic, non-DEHP and contain no natural rubber
latex components.

Operator Manual ExactaMix Pro 2400 Compounder
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NOTE: The compounder will automatically use the highest available value for the standard
priming volume and half of that value for the minimum priming volume. However, you can
adjust these priming volumes in the Inlet Editor. For instructions, refer to Using the Inlet Editor

on Page 149.

BAGS

The following empty bags are approved for the ExactaMix Pro compounder.

Product Product Code Qo Notes
Case
ExactaMix EVA Container, 250 mL H938737 50 N/A
ExactaMix EVA Container, 500 mL H938738 50 N/A
ExactaMix EVA Container, 1000 mL H938739 50 N/A
ExactaMix EVA Container, 2000 mL H938740 50 N/A
ExactaMix EVA Container, 3000 mL H938741 50 N/A
ExactaMix EVA Container, 4000 mL H938742 50 N/A
ExactaMix EVA Container, 5000 mL H938743 50 N/A
ExactaMix EVA Calibration Bag, 1000 mL H938735 50 Can be used for functions
other than calibration; refer to
calibration bag on Page 6.
EVA Dual Chamber Container, 1500 mL H938901 42 250 mL upper chamber
1250 mL lower chamber
EVA Dual Chamber Container, 3000 mL H938905 42 500 mL upper chamber
2500 mL lower chamber
EVA TPN BAG, INT THR, 250 mL E30020D 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 250 mL (5 pack) E30020D5 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 500 mL E30050D 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 500 mL (5 pack) E30050D5 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 1000 mL E30100D 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 1000 mL (5 pack) E30100D5 50 mfr. Haemotronic
EVA TPN BAG, INT THR, 2000 mL E30200D 30 mfr. Haemotronic
EVA TPN BAG, INT THR, 3000 mL E30300D 30 mfr. Haemotronic
EVA TPN BAG, INT THR, 4000 mL E30400D 30 mfr. Haemotronic
EVA TPN BAG, INT THR, 5000 mL E30500D 30 mfr. Haemotronic
EVA TPN Bag, 125 mL (LL Fill Port) E1301-OLPF 50 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 250 mL (LL Fill Port) E1302-OLPF 50 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 500 mL (LL Fill Port) E1305-OLPF 50 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 1000 mL (LL Fill Port) E1310-OLPF 40 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 2000 mL (LL Fill Port) E1320-OLPF 35 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 3000 mL (LL Fill Port) E1330-OLPF 35 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 4000 mL (LL Fill Port) E1340-OLPF 30 Luer Lock port; mfr. Diffuplast
EVA TPN Bag, 5000 mL (LL Fill Port) E1350-OLPF 25 Luer Lock port; mfr. Diffuplast
EVA TPN BAG MULTILAYER 125 mL E14010D 50 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 250 mL E14020D 50 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 500 mL E14050D 50 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 1000 mL E14100D 40 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 2000 mL E14200D 35 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 3000 mL E14300D 35 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 4000 mL E14400D 30 Lg. Bore port, mfr. Diffuplast
EVA TPN BAG MULTILAYER 5000 mL E14500D 25 Lg. Bore port, mfr. Diffuplast
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Product Product Code Quantity / pRiee
Case
TPN EVA UV BAG 125mL with female connector BX0001BP 150 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 250mL with female connector BX0002BP 150 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 500mL with female connector BX0003BP 150 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 1000mL with female connector BX0004BP 125 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 2000mL with female connector BX0005BP 80 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 3000mL with female connector BX0006BP 80 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 4000mL with female connector BX0007BP 60 Lg. Bore port, mfr. Valmed
TPN EVA UV BAG 5000mL with female connector BX0008BP 50 Lg. Bore port, mfr. Valmed
TPN MULTILAYER BAG 125mL with female BX0009BP 150 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 250mL with female BX0010BP 150 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 500mL with female BX0011BP 150 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 1000mL with female BX0012BP 125 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 2000mL with female BX0013BP 60 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 3000mL with female BX0014BP 60 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 4000mL with female BX0015BP 60 Lg. Bore port, mfr. Valmed
connector
TPN MULTILAYER BAG 5000mL with female BX0016BP 50 Lg. Bore port, mfr. Valmed
connector

ExactaMix bags are sterile, bio-compatible, non-pyrogenic and contain no natural rubber latex
components. These bags have a large-bore, threaded fill-port connector or a Luer lock fill-port

connector.
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GETTING HELP

Always contact Baxter Technical Support if you encounter any issues.

Baxter Technical Support can be contacted by emailing COtechsupport@baxter.com or calling
1.800.678.2292 (if from the U.S. or Canada). Regional Technical Support contact information
can also be found by visiting www.baxter.com/location-selector , selecting your location and
using the contact link.

Before you call for technical support, you will need your compounder’s software version and
build number. To obtain this information follow the instructions below.

1. Atthe menu screen, tap Help > About.
The About window appears. It provides information about the hardware and software.
2. Atthe About window, identify the Operating Software Version and Build Number.

About ExactaMix Pro 2400 Compounder

Build Number: 0.9.0.20210914034434
Software Version: 0.9.0

Copyright © 2021 Baxter Healthcare Corporation.
Baxter Healthcare Corporation

One Baxter Parkway

Deerfield, IL 60015 USA

Technical Services: In the United States call 1-800-678-2292.
Elsewhere, please visit www.baxter.com/location-selector

o )

About window
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Alternatively,

IMPORTANT! These instructions require the user to have System Settings permissions. For
more information about user groups and permissions, refer to Setting Up the Users on
Page 120.

1. Atthe menu screen, tap Tools > System Settings.
The System Settings window appears. It provides information about the hardware and
software along with other operating system settings.

2. Select the Device Information option in the left pane.

3. Inthe right pane, identify the Software Version and Build Number.

System Settings

Display Device Type: EM2400

Device Information Software Version: 0.9.0

Date & Time Software Build Number: 0.9.0.20210914034434
Language Display Serial Number: EB1041

Ethernet Display Manufacturing Date: 16/09/2021

Wi-Fi Board ID:

Firewall Settings PCBA Revision: EB1.5

Printer Management PCBA Serial Number: EMIX-2400-2021-021

Device IP Address:
Device Mac Address: 00:04:f3:bc:75:34
Device Hostname: ccimx6qpsbc-761a30
Real Time Clock Battery Voltage: 3.02v [Prescribed 2.7v to 3.3v]
Device Certificate Validity Status: Not Enrolled
Wi-Fi Certificate Availability: Not Available
Printer Availability: Available

Close

System Settings window
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INSTALLING THE COMPOUNDER

Your Baxter service provider will install the compounder at your site.

If you must reinstall the compounder, relocate the compounder or replace a component,
verification tests must be performed before you use the compounder again. Contact Baxter
Technical Support for assistance. Refer to Getting Help on Page 20.

NOTE: If a compounder needs to be moved to a new location, please contact Baxter Technical
Support at least 30 days prior to the date of relocation.

To start, open the packaging, remove all the items, and inspect them to make sure that they are
not damaged.

Tip! Save the packaging material for future use in case the modules ever need to be shipped for
technical service or repair.

WARNING
i Do not use sharp objects to open the packaging. Personal injury could result.

The compounder should be always placed on a level and stable surface to prevent
the compounder or its individual modules from falling. Always hold the modules as
shown below to avoid dropping them.

1. Route the power cord out through the routing hole in the back of the main module.
2. Place the main module onto the base plate.

Placing the main module

Operator Manual ExactaMix Pro 2400 Compounder
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3. Place the load cell on the left of the base plate.
4. Place the display on the right of the base plate.
5. Tip the main module back and extend the support legs.

Support legs

Extending the support legs

NOTE: If the main module is near a wall, there may not be enough space behind the
main module to tip it back. You can move the compounder forward by lifting the front
of the base plate slightly and sliding it toward you.

WARNING

Using the support legs will reduce the possibility of pinching your hands when

f‘j you connect the cord and cables.
The power cord must be unplugged from the main AC power source whenever
you connect or disconnect the display and load cell.
The power cord must be positioned so that the plug is easily accessible.

CAUTION

A Ensure the system is fully powered down before disconnecting the display
cable. Failure to unplug the power cord before disconnection of the display can
result in the system becoming inoperable.
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6. Under the main module, connect the following cord and cables. Reach under the main
module with your palm facing up.
a. Connect the power cord.
b. Connect the larger end of the display cable. Squeeze the ends of the connector to
unlock it, connect it, and then release to lock it into place.
c. Connect the load cell cable. Squeeze the ends of the connector to unlock it,
connect it, then release to lock it into place.

Power cord

Display cable
large end

Cable for the
load cell

Connecting the cord and cables

NOTE: Connector locations may vary depending on the model.
7. Retract the support legs so that the main module rests fully on the base plate.

8. Route the cables through the two routing cut-outs, pushing any excess cable length
through the holes. Ensure cables are not pinched under the main module.
IMPORTANT! Ensure the cables are routed through their respective cut outs and not

pinched under the main module.

Routing a cable
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9. Install the load cell.
a. Place the load cell onto the base plate.
b. To lock the load cell, move the black lever back until it clicks into place.

™

Installing the load cell

10. Display preparation:
a. Place the display face down on a flat clean surface with the scanner side edge
positioned flush to the edge of the workstation.

b. Position the scanner holder so that the two screw holes in the scanner holder
align with the two threaded holes of the display.

/9
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c. Use the supplied hardware and a 2.5 mm hex driver to secure the scanner holder
to the display. Baxter recommends tightening to 4 in-lbs. (0.45 N - m) of torque.
IMPORTANT! Do not over tighten.
11. Attach the smaller end of the display cable to the connection on the bottom of the
display.

Display cable small end

12. Install the display onto the mounting arm.
The white locking pin snaps into the locked position.

Installing the display

NOTE: To remove the display, pull the locking pin out to the unlocked position, then
rotate the pin 90 degrees to keep it in this position while lifting the display.

Operator Manual ExactaMix Pro 2400 Compounder
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13. Place the barcode reader on the barcode reader holder with the trigger facing away
from you.

Placing the barcode reader

14. Connect the USB cable from the barcode reader to a USB port on the bottom of the
display.
15. If desired:
e Connect the USB cable from the printer to a USB port on the display.
e Connect a cable to the Ethernet port on the display.
NOTE: To perform administrative work, you can also connect a keyboard and mouse to
the USB ports on the display. Disconnect keyboard and mouse before starting normal

compounding operation.

o - — - - - - -

Ethernet

port usB

ports

For Symbol definitions, refer to Symbols on Page i

ExactaMix Pro 2400 Compounder
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16. Move the arm of the display to the desired position by doing the following:
a. Unlock the lever on the right by rotating it forward.

NOTE: Pulling the lever slightly out to the right may make it easier to rotate.

b. Adjust the arm of the display forward or backward.
c. Lock the lever by rotating it backward.

Lever on the right
17. Move the display to the desired position by doing the following:
a. Unlock the lever on the left by rotating it backward.
NOTE: Pulling the lever slightly out to the left may make it easier to rotate.

b. Adjust the display up or down.
c. Lock the lever by rotating it forward.

Lever

Lever on the left
18. Check that the cables:
e Are not kinked or pinched
e Do not touch the base of the load cell
19. Plug the power cord into an uninterruptible power supply (UPS).

NOTE: Baxter recommends the ExactaMix Pro compounder be connected to an
uninterruptible power supply (UPS) with battery backup. This will prevent power spikes
and/or a hard shutdown of the device.
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20. Install the vial rack onto the back of the main module. On each end, slide the slot on
the vial rack over the bolt on the main module.

S
g

g
E gl
[

Installing the vial rack

21. Install the vial holders in the desired locations on the vial rack.
22. Adjust the position of each top and bottom vial holder.

a. Rotate the cam up to the unlocked position.

b. Push the holder to the desired location on the pole.

c. Rotate the cam down to the locked position.

Cam locked
/Cam unlocked

Top vial holder

Bottom vial holder

Adjusting the vial holders
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STARTING UP, LOGGING IN AND OUT, AND SHUTTING DOWN

STARTING UP AND LOGGING IN

1. On the main module, press and hold the power button until the power light
illuminates.

Power light

Power light and power button

2. If the Login window appears:

a. Enter a Login name.
b. Enter a Password. (NOTE: Passwords are case-sensitive)

c. TapLoglin.

Login |\ |

Password ‘

{ Login ] [ Cancel ]

Login window

Tip! Baxter recommends setting up each user with a unique login name and password.
If the compounder is connected to a network, Baxter recommends that the
compounder be logged in to the network automatically. For details, contact Baxter

Technical Support. Refer to Getting Help on Page 20.

ExactaMix Pro 2400 Compounder
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NOTE: To require each user to log in, refer to Setting Up the Security Options on
Page 108. To set up password expiration, refer to Password Expiration on Page 108.

Next, the software may display a Confirm screen. Several styles of the Confirm screen may
appear, but each includes this text: Compounder is not ready for operation. Do you wish to
run the setup wizard? The screen also lists the conditions that prevent the compounder from
being ready for operation. The screen appears if any of these conditions exist:

e The calibration of the load cell has expired.
e The calibration of the pump has expired.
e The tube set has expired.

NOTE: To set up the options for tube set expiration, refer to Tube Set Expiration on
Page 105.

[connrm

| @ Compounder is not ready for operation.

Do you wish to run the setup wizard?
1. Configuration must be verified.
2. Configuration must be primed.

3. Pump must be calibrated.

[ Yes ] [ No )

Confirm screen

3. If the Confirm screen appears:
o Tap Yes if you want to use the Setup Wizard now. For instructions on using the
Setup Wizard, refer to Setting Up the Compounder on Page 33.

o Tap No if you want to continue using the software in the current state.

Tip! Baxter recommends always tapping Yes. If you tap No, you will be instructed
to perform any required setup steps before compounding.

LOGGING OUT

When you have finished using the compounder, or another user needs to log in, you can log out
of the software without shutting down the compounder.

At the menu screen, tap either:
e File > Logout

e Tools > Users > Change User

NOTE: The Confirm screen may appear if the compounder is not ready for operation. To set up
the automatic logout option, refer to Auto-Logout on Page 108.
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REBOOTING AND SHUTTING DOWN

Tip! Baxter recommends shutting down the compounder when you are finished using it. Baxter
also recommends fully shutting down and starting up the compounder once a day, to allow the
software to perform routine database maintenance at startup.

1. Atthe menu screen, tap File > Exit.
The Exit Options window appears.

o You have requested to exit the application.

(®Shutdown the computer?

(_JReboot the computer?

[ OK ] [ Cancel ]

Exit Options window

2. Tap one of these options:
e Shutdown the computer? to shut down the software and turn off the compounder
e Reboot the computer? to shut down the software, turn off the compounder and
restart the compounder
3. Tap OK.
NOTE: You cannot turn off any part of the compounder by pressing the power button on the
main module. This button is used only to turn the power on.

CAUTION

To reboot a nonresponsive display, press and hold the Reset button on the bottom left

A of the display. To shut down the compounder (main module and display), press and
hold the power off button on the bottom right of the main module. However, either of
these actions can corrupt the database. Do not press the Power or Reset buttons at
any time unless directed to do so by Baxter Technical Support.
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SETTING UP THE COMPOUNDER

ACCESSING THE SETUP WIZARD
The Setup Wizard guides you through the setup process.

You can access the Setup Wizard in two ways:

e Tap Yes at the Confirm screen if it appears during startup.

e Tap Compound > Setup Wizard at the menu screen to access the Setup Wizard at any
time.

NOTE: The Compound menu also includes options that allow you to perform individual steps of
the setup process without completing the entire Setup Wizard.

Tip! Baxter recommends always using the Setup Wizard to guide you quickly through the
necessary steps in the proper sequence.

Setup Wizard

Select Formula

EANEE Change Tube Set

Edit Source Remainders
Prime and Verify

Select Configuration

Calibrate Load Cell

Calibrate Pump
T@® LS RIE IPIOIRAIES EREINP

Close

Menu screen, Compound menu
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IMPORTANT! These functions require Compounder permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

The Setup Wizard guides you through these main steps:

1.
2.
3.

SETUP WIZARD

Calibrate Load Cell guides you through calibrating the load cell.

Select Configuration allows you to select a configuration to use.

Change Tube Set guides you through installing a new tube set and new ingredients for
the selected configuration.

Prime and Verify guides you (and an optional cosigner) through the process of priming
the inlets and verifying the setup.

Calibrate Compounder calibrates the compounder’s pump to ensure that it will
deliver the intended volume of each ingredient.

Authorization Report allows you to view and print the Authorization Report, if
desired.

Calibrate

Load Cell Select Change Prime and Calibrate
Configuration Tube Set Verify Compounder

Touch Here to
Begin

Next step: Calibrate Load Cell
Touch the highlighted button to continue.

( Exit )

Setup Wizard screen

Operator Manual ExactaMix Pro 2400 Compounder
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CALIBRATING THE LOAD CELL

This procedure calibrates the load cell to ensure that it measures weight accurately.
The load cell must be calibrated:
e Daily when the calibration expires

e Using a 2,000 g weight that Baxter provides
Tip! Baxter recommends:

e Using gloves to handle the weight, to minimize the accumulation of oils and dust
e Storing the weight in its storage case

To calibrate the load cell:

1. Atthe Setup Wizard screen, tap Calibrate Load Cell.

SETUP WIZARD

Calibrate

Load Cell Select Change Prime and Calibrate
Configuration Tube Set Verify Compounder

Touch Here to
Begin

Next step: Calibrate Load Cell
Touch the highlighted button to continue.

| Exit )

Setup Wizard screen, calibrating the load cell

NOTE: To calibrate the load cell without using the Setup Wizard, you can tap
Compound > Calibrate Load Cell at the menu screen.

The Load Cell Calibration Requested message appears.
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IMPORTANT! If any items touch the load cell during the calibration, the calibration will

Information

o Load Cell Calibration Requested.
Empty Load Cell And Select OK To Continue.

_ox J{

cancel )

Message

not be accurate.

2. Make sure that:
e There is no weight on the load cell.

e There is nothing touching any part of the load cell (for example, there are no cables

touching the base).

3. Atthe Load Cell Calibration Requested message, tap OK.
This message appears and then disappears:

Load Cell Calibration

Load Cell Calibration

step 1 in progress.

Message

The Place Calibration Weight message appears.

Operator Manual

o Place Calibration Weight (2000.0 grams) On Load
Cell And Select OK To Continue.

_ox JI

Message

Cancel ]

ExactaMix Pro 2400 Compounder
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4. Place the 2,000 g weight on the load cell, aligning it with the holes in the load cell.

Aligning the calibration weight

5. Wait five seconds to allow the weight to stabilize.
6. Atthe Place Calibration Weight message, tap OK.

This message appears and then disappears:

Load Cell Calibration

Load Cell Calibration

step 2 in progress.

Message

When calibration is finished, a Load cell calibration complete message appears.

o Load Cell Calibration Complete.

Remove calibration weight.

Message

7. If the Load cell calibration complete message appears, tap OK.
8. Remove the calibration weight.
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SELECTING THE CONFIGURATION

The configuration identifies which ingredients are attached and at which ports on the
compounder.

This procedure is required only if both of the following conditions exist:

e More than one configuration is available.
e You want to use a configuration that is different from the last one that was used.

The software automatically selects the last configuration that was used, and a check mark
appears in the Select Configuration portion of the Setup Wizard.

If you want to change the configuration:

1. Atthe Setup Wizard screen, tap Select Configuration.

SETUP WIZARD
Calibrate W Select Prime and Calibrate
Load Cell | |Configuration Verify Compounder
Touch Hereto ! Touch Here to Touch Here to
Edit ‘ Edit .
| Begin
I
I
0 |
Next step: Change Tube Set
Touch the highlighted button to continue.
( Exit )

Setup Wizard screen, selecting the configuration

NOTE: To select the configuration without using the Setup Wizard, you can tap
Compound > Select Configuration at the menu screen.

The Select Configuration screen displays the last configuration that was used.

Operator Manual ExactaMix Pro 2400 Compounder
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2. Inthe Name list, select the desired configuration.

3. Tap OK.
Select Configuration
Name
‘EM2400 DEMO - ‘ Nahez
Universal Ingredient 6
‘Sterile Water for In v r Clinolip NaPhos3 Nacla
a
Final Flush Volume N . s
- I i i I
+ 1 3 5 7 9 11 13 15 17 19 21 23
{ ® O 006 OOOOOL GO
Auto - Additions ]
*P00O0QCOEQRQROeO
i i i i I
[ Edit Sequence ] ' E C M'" .
‘ 2 5 9 10
[ OK ] KPhos3 KCI2
n ﬂ
[ Cancel ] 3 ! 4

Select Configuration screen

NOTE: When you select a different configuration, you most likely will need to change
the tube set, then prime and verify it.
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CHANGING THE TUBE SET
The tube set must be changed:

e When you select a different configuration, in some cases
e During the daily setup, if the tube set is expired

NOTE: To set up the options for tube set expiration, refer to Tube Set Expiration on
Page 105.

WARNING

To maintain delivery accuracy, the tube set must be replaced after it has delivered
A 150 L of fluid or been installed for 24 hours, whichever comes first.

Check that the materials of the inlets, valves and bags are compatible with all
ingredients used. Contact the ingredient manufacturer to confirm compatibility.

Checking the Tube Set Statistics
1. Atthe Setup Wizard screen, tap Change Tube Set.

SETUP WIZARD
Change
Calibrate Select Tube Set Prime and Calibrate
Load Cell Configuration Verify Compounder
Touch Here to Touch Here to
Edit Edit Touch H_ere to
Begin
Next step: Change Tube Set
Touch the highlighted button to continue.
Exit |

Setup Wizard screen, changing the tube set

NOTE: To change the tube set without using the Setup Wizard, tap Compound >
Change Tube Set at the menu screen.
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A screen with tube set statistics and recommendations appears. The statistics show
how long the current tube set has been installed and how much fluid has been
pumped during that time. Based on the usage, the software recommends whether the
tube set should be changed.

Change Tubeset

Tube Set Statistics:

The current tube set has been in use since 12/30/2020 10:00:00 AM, a period of 24 hours.

2 liters have been pumped through this tube set.

Recommendations:
The maximum allowable time for this tube set to be used has expired.

The set should now be changed.

L Tube set will be changed ]

L Continue with current tube set ]

Tube set statistics and recommendations

2. Tap one of these options:
e Tap Tube Set will be changed, then continue with Changing the Tube Set on
Page 93.

NOTE: Selecting Tube Set will be changed resets the expiration counter for the tube
set and resets the ingredient remainders (values in the software that represent the
actual volume of fluid remaining in the source containers).

e Tap Continue with current tube set.

NOTE: Selecting Continue with current tube set does not reset the expiration
counter or the ingredient remainders.

For removing the expired tube set and ingredients, refer to Removing the Expired Tube Set and
Expired Ingredients on Page 92.
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Installing the New Valve Set

é CAUTION
If the valve set is not installed properly, the compounder may not pump accurately.

1. Check that the valve actuators are not broken or damaged.

!56

Normal Damaged Broken

Valve actuators

WARNING

A Do not use the compounder if a valve actuator is broken or damaged.
Patient harm can result. For assistance, contact Baxter Technical
Support. Refer to Getting Help on Page 20.

2. Open the pump door.

3. Remove the valve set from the packaging.
NOTE: Always use aseptic technique when installing the valve set.
IMPORTANT! Check the expiration date on the valve set before installing it. Do not use
a valve set that is past its expiration date.

4. Place the valve set onto the valve actuators.

5. Push the end tabs down and out using your thumbs until you hear a click on each end.

Installing the valve set

NOTE: The appearance of the valve set may differ from the example shown above.
6. Make sure that the valve set is installed securely by pulling up on both ends gently.

CAUTION
A Once the valve set has been installed, do not attempt to remove it during
operation.
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WARNING

m To avoid pinching your fingers, grasp the pump rotor from the top and rotate it
counterclockwise, keeping your fingers away from other surfaces while moving
the rotor.

7. Route the outlet tube into channel 1, around the pump rotor and into channels 2 and
3 as shown. Move the pump rotor counterclockwise only. Do not pull or stretch the
outlet tube.

Pump rotor Outlet tube in channel 1

Channel 3 Channel 2

Routing the outlet tube

a. Make sure that the tube is in proper position at the bottom of channels 1.
Tip! Press down firmly on the silicone tubing to ensure contact with the bottom
of the channel. This will ensure the tubing is properly seated in the bubble
detector and over the occlusion detector.

T (T

Proper position Improper position

b. Make sure that the tube is in proper position against the wall around the pump
rotor.

Operator Manual ExactaMix Pro 2400 Compounder

0719003109 Rev. A, Effective Jan 2022 Page 43



Setting Up the Compounder

Proper position Improper position

8. Close the pump door.
9. Connect the end of the outlet tube to the tube holder on the vial rack.

Tip! Optionally, you can attach the calibration bag to the outlet tube to avoid interference while
connecting source containers.

Connecting the outlet tube

Preparing the New Ingredients

WARNING
The compounder is not for use with non-sterile containers.

WARNING
Review each drug product's safety profile before use.

Source containers that can be used with the compounder are:

e Large-volume, vented or collapsible containers
e Large-volume, non-vented containers

e Small-volume vials

e 50 or 60mL Luer syringes depending on brand

Tip! Baxter recommends using only sterile BD 50 mL Luer syringes. If you plan to use a different
type, contact Baxter Technical Support. Refer to Getting Help on Page 20.
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1. Gather all the new ingredients.

Tip! Baxter recommends using a configuration’s previous Authorization Report at the
end of attaching all the ingredients and inlets to quickly identify the ingredients
needed for a specific configuration. For more information, refer to Authorization

Report on Page 165.
2. Check that each source container has a barcode label attached.
Tip! Baxter strongly recommends using the manufacturer’s barcode whenever
possible.
NOTE: For containers that are filled or diluted in the pharmacy, the Product Barcodes
Report can make labels available for printing. For more information, refer to Product
Barcodes Report on Page 176.
IMPORTANT! Any container labeled with a barcode printed from ExactaMix Pro
software should be verified and initialed by a pharmacist prior to connecting it to the
compounder.

Attaching the New Ingredients and Inlets
Always use aseptic technique when attaching the ingredients and inlets.

Follow all the steps of this process for one ingredient and inlet pair before continuing with the
next pair. This practice helps to ensure that you attach the ingredients and inlets correctly.

Tip! To keep track of the steps, Baxter recommends working from one end to the other in the
sequence of the port numbers (example: 1, 2, 3 and so on). You might find it helpful to
remember the main steps of this process (covered in more detail on the upcoming pages) by
remembering the term iTASL, which signifies:

1. identify the port you are going to be working with by turning the cap.
2. Touch (tap) the ingredient button on the screen.

3. Attach the inlet to the port on the valve set.

4. Spike and hang the source container.

5. Label the inlet with the numbered barcode label.
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To attach an ingredient:

1. identify the port you are going to be working with by turning or slightly raising the
cap.

Turning Cap

2. Touch (tap) its ingredient button on the screen.

Hang Source Containers

" Naac2
Tutorial
Rem 100.00mL
Inlet: 175
Clinolip NaPhos3 NaCla
Rem 250.00mL Rem 50.00mL Rem 100.00mL Rem 2000.00mL
Inlet: 173 Inlet: 175 Inlet: 175 Inlet: 173
I I I
1 3 5 7 9 11 13 15 17
2 4 6 8 10 12 14 16 18
oK I 11 I
Infuva KAc2 Csolls MTESConc
10
tem 100.00mL Rem 100.00mL Rem 200:0.00mL Rem 10.00mL Rem 100.00mL
Inlet: 175 Inlet: 175 inlet- 173 Inlet: 175 Inlet: 175
KPhas3 Kciz MgSod SWFI
Rem 50.00mL Rem 30.00mL Rem 50.00mL Rem 2000.00mL
Cancel Inket: 175 Inket: 175 Inket: 175 Inlet: 173

Hang Source Containers screen, no ingredients attached

Operator Manual
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The ingredient detail window appears.

IMPORTANT! Always view the ingredient detail window. It includes details not visible
on the ingredient button. For example, it includes the full product description, which
you must check.

Product ‘Baxter Sterile Water for In 2000 Bag v ‘
Inlet Non-Vented, Macro Inlet
Part # 173
Remainder (mL) 2000.00
[ ]Use Last Container [ OK ] [ Cancel ]
/|

Ingredient detail window

3. Attheingredient detail window, review the information.
a. Check that the Port number is correct.
b. Check that the Product description matches the source container to be used.

NOTE: If desired, you can tap the arrow to the right of this field to see a list of
similar products in the same ingredient group. If you select another product in
this list, the Inlet type and Part # may change accordingly.

c. Check that the Inlet type and Part # are correct.

NOTE: The Part # shows the last three digits of the complete part number. For a
list of complete part numbers, refer to Valve Sets in Page 17. The complete part
number also appears on the packaging materials for the inlet.

d. Check that the Remainder (mL) matches the current volume of the source
container.

NOTE: When you attach a full, unopened container, the Remainder (mL) should
equal the volume indicated on the container. When you attach a partially full
container, change the Remainder (mL) to the actual volume in the container.
Remainders on syringes should always be verified. The compounder will use this
information to help track the volume used, to alert you when the container needs
to be changed.

e. If required, enter or check the Lot Number and the Expiration.

NOTE: To set up these tracking options, refer to Track Product Expiration Date
and Lot Number on Page 103.
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WARNING

A It is important to use the correct inlet type for the container. Using the incorrect
inlet type can lead to occlusions and incorrect ingredient delivery, resulting in
patient harm.

4. Attach the inlet to the port.
a. Locate the inlet type specified in the ingredient detail window.
b. Remove the inlet from its packaging materials and gently uncurl it. Do not pull or
stretch the inlet.

WARNING

A kink in the tube, a plugged vent on a vial or bottle inlet or a plugged
inlet spike can cause the compounder to deliver incorrect ingredient
volumes, resulting in patient harm. After attaching the inlets, visually
check that the tubes are not kinked or plugged.

c. Checkthat the inlet is not kinked or plugged.
d. On the valve set, locate the port number specified at the ingredient detail
window. This port should match the identified port in step 1.

Tip! To locate an odd-numbered port, Baxter recommends locating the next,
even-numbered port in the front row. For example, to attach an inlet to port 3,
look for port 4 in the front row and then attach the inlet to the port directly
behind it (port 3). Avoid leaning over the compounder.

e. Grasp the port cap with one hand, remove the port cap and immediately attach
the inlet with your other hand.
5. Spike and hang the container.

CAUTION

A The pictures and instructions on the following pages are for reference only.
When spiking the container, use proper technique as identified by your
facility’s protocol.
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o To spike and hang a bag:
NOTE: To prevent dropping the bag, you can hang it on the hood hanger.

a. Turn the bag with its spike port facing down.
NOTE: This step helps to reduce the possibility of
air bubbles entering the inlet tube.

Turning

WARNING

Failure to insert the spike completely
m into the bag port may restrict flow and

cause the delivery of incorrect
ingredient volumes, resulting in patient 2.
harm.

b. Insert the spike fully into the bag, all the way to
the flange.

Inserting
Rotate the spike 180° to prevent occlusions.

d. Hang the bag on the hood hanger, if the bag is not
already there.

o To spike and hang a bottle:
NOTE: To prevent dropping the bottle, you can hang it on the hood hanger.
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a. Turn the bottle with its septum facing down.
NOTE: This step helps to reduce the possibility
of air bubbles entering the inlet tube.

Turning

b. Locate the shoulder of the spike.
Shoulder

"'-

Shoulder

c. Insert the spike into the septum of the bottle up
to the shoulder of the spike.
NOTE: Inserting the spike up to the shoulder
helps ensure that the maximum amount of fluid
and the minimum amount of air is withdrawn
from the bottle.

d. Hang the bottle on the hood hanger, if the
bottle is not already there.

Hanging
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o To spike and hang a vial:

a. Turn the vial with its septum facing down.

NOTE: This step helps to reduce the possibility
of air bubbles entering the inlet tube.

b. Insert the spike fully into the vial.

IMPORTANT! Baxter recommends grasping
the inlet alongside the vent as shown to
ensure the vent does not get obstructed.

c. Push the bottom of the vial (now facing up)
against the top holder. Make sure that the
vent faces you, is unobscured and is not
dislodged.

NOTE: If the vent faces away from you (into
the bottom vial holder), the air flow may be
obstructed, causing an occlusion or limited
flow. Also, the vial will not be seated securely.

d. Slide the spiked end of the vial into the
bottom vial holder.

NOTE: In the event the inlet vent cap comes
off of the inlet, discard the inlet and replace Hanging
with a new one.
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o To spike and hang a syringe:

a. Turn the syringe with its Luer end facing TR
down. i '
NOTE: This step helps to reduce the
possibility of air bubbles entering the inlet
tube.

NOTE: Only syringes that have been verified
by a pharmacist should be hung on the
compounder.

Rotating

b. Rotate the inlet onto the syringe.

c. Hang the syringe on the vial rack by snapping
the syringe flanges into the syringe holder.

NOTE: The flanges on the syringe should go §
into the slot between the spring clips on the 4

T my

g »

\wng__’
syringe holder. \i

Hanging

6. Label the inlet with the appropriate port numbered barcode label that was packaged
with the valve set. Attach the label close to the source container. The number on the
label must match the number of the port to which the inlet is attached.

Tip! Baxter recommends placing the barcode label on the inlet tube about an inch
(2.5cm) below the spike, so the user can see observe the fluid flowing.

7. Check that the correct inlet is:
a. Attached to the correct ingredient and port
b. Labeled with the correct barcode label

Tip! Baxter recommends rotating the source container so that the barcode label faces
you, for easy scanning during barcode verification.

8. Atthe ingredient detail window, tap OK.
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At the Hang Source Containers screen, the color of the ingredient button beco
indicate that the ingredient is attached and waiting to be primed.

mes blue to

Hang Source Containers
" MaAc2
Tutorial
Rem 100.00mL
Inlet: 175
Clinalip NaPhos3 [ NacCla
1] a
Rem 250.00mL Rem 50.00mL Rem 100.00mL Rem 2000.00mL
Inlet: 173 Inlet: 175 L Inlet: 175 Inlet: 173
T Il I
1 3 5 7 9 11 13 15 17 19
2 4 [} 8 10 12 14 16 18 20
Infuva KAc2 Csalls MTESConc
g
Rem 100.00mL Rem 100.00mL Rem 2000.00mL Rem 10.00mL Rem 100.00mL
Inlet: 175 Inlet: 175 L Inlet: 173 Inket: 175 Inlet: 175
KPhos3 [-H MgSed
Cancel Rem 50.00mL Rem 30.00mL Rem 50.00mL
Inlet: 175 Inlet: 175 Inlet: 175

Hang Source Containers screen, one ingredient attached

9. Repeat the previous steps for all the ingredients you want to attach.

When all the ingredient buttons are blue, you are finished changing the tube set.

10. Tap OK.

NaAc2

Rem 100.00mL
Inlet: 175

Hang Source Containers

NaPhos3

Rem 50.00mL

Re

em 2000.00mL
Inlet: 174

15 17
O O
O O
16 18

MTE5Conc

Rem 10.00mL
Inlet: 175

Rem 100.00mL
Inlet: 175

Rem 100.00mL
Inlet: 175

Rem 2000,00mL
Infet: 175

R

KPhos3 KC12 MgSod

Rem 50.00mL
Inlet: 175

Rem 50.00mL
Inlet: 175

Rem 30.00mL
Inlet: 175

em 100.00mL
Inlet: 175

e 00mL
Inlet: 173

Hang Source Containers screen, all ingredients attached

If you started this procedure from the Setup Wizard screen, a check mark now appears

in Change Tube Set portion of the Setup Wizard screen.
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PRIMING AND VERIFYING

After the ingredients and inlets are attached, they must be primed and verified. This process
includes scanning the barcodes on each container and inlet, priming the inlets and verifying the

setup.

1. Atthe Setup Wizard screen, tap Prime and Verify.

SETUP WIZARD

Prime and
Calibrate Select Change Verify Calibrate
Load Cell Configuration Tube Set Compounder
Touch Here to Touch Here to Touch Here to
Edit Edit Edit TOuCBhegiire e
Next step: Prime and Verify
Touch the highlighted button to continue.
[ Authorization Report ] [ Exit ]

Setup Wizard screen, priming and verifying

NOTE: To prime and verify without using the Setup Wizard, you can tap Compound >
Prime and Verify at the menu screen.

WARNING
A It is important to use a barcode reader for scanning labels during verification of
the setup.

2. If your facility:
e Uses barcode verification, continue with Verifying the Ingredient and Inlet Barcodes

on Page 55.
e Does not use barcode verification, skip to Priming the Inlets and Verifying the Setup
on Page 58.
Operator Manual ExactaMix Pro 2400 Compounder

Page 54 0719003109 Rev. A, Effective Jan 2022



Setting Up the Compounder

Verifying the Ingredient and Inlet Barcodes

WARNING
For the barcode verification to be effective, it is critical that the configuration be set up
properly. For instructions, refer to Attaching the New Ingredients and Inlets on
Page 45.
IMPORTANT! This procedure requires barcode scanning to be enabled. To enable barcode
scanning (and, if desired, to require it for verification), refer to Barcode Reader on Page 109.

Tip! Baxter recommends enabling barcode scanning at all times.

On the BARCODE VERIFICATION screen, the ports appear empty until the barcodes on the
attached inlets and source containers are scanned.

BAR CODE VERIFICATION

Close |

e OO0 0606006086086
P RPFPRPRRILE PR

Scan an inlet

BARCODE VERIFICATION screen, no barcodes verified
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BAR CODE VERIFICATION

Close

OO0 0000d0o00obH
PP PRRRIRRIRLR

Scan the corresponding product

BARCODE VERIFICATION screen, Inlet scanned, asking to scan the corresponding product

WARNING

A Scan only the barcodes attached to the inlet and the corresponding source container.
Do not scan unattached barcodes or old (used) containers. Doing so may result in
incorrect ingredient delivery, resulting in patient harm.

Tip! Baxter strongly recommends scanning from left to right (or from right to left) to prevent
skipping any ingredients or ports.
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1. Scan the barcode label on an inlet.
2. Scan the barcode label on the corresponding source container.

If you scanned the correct source container, the corresponding ingredient button
appears on the screen.

BAR CODE VERIFICATION

| Close l

I Nelclcl ol clo e loMc oMo le
Q000 0Q0QQQQQ
2 4 6 8 10 12 14 16 18 20 22 24

SWFI

Ex

Sequence: 13

Scan an inlet

BARCODE VERIFICATION screen, one pair of barcodes verified

If you scanned an incorrect source container, the compounder beeps and displays
Incorrect scan, try again at the bottom of the screen. Scan the correct source
container.

If the scanned product is not the specific product identified in the configuration but is
the same ingredient, a Warning message appears. Tap Yes if you want to use the
scanned product.

p The product just scanned ( Baxter Sterile Water for In
» 1000 Bag ) contains the correct ingredient, but is
NOT the product normally used on this configuration.

Do you want to use this different product?

[ Yes ] [ No ]

Message

-

3. Repeat the previous steps until an ingredient button appears for each attached
ingredient.

4. After all inlets and ingredients are scanned successfully, the Barcode verification
completed message will appear, tap OK.
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o Barcode verification completed.

Message

Priming the Inlets and Verifying the Setup

Usually, a cosigner must log in and verify the setup. Refer to your facility’s protocol.

WARNING

It is important to always have a cosigner independently verify the setup, to help ensure
that the first user attached each ingredient’s inlet to the correct port. Incorrect setup
could result in patient harm.

IMPORTANT! The cosignature option requires Verification permissions. For more information
about user groups and permissions, refer to Setting Up the Users on Page 120. To require that a
cosigner verify the setup, refer to Cosignature on Page 109.

1. Attach a calibration bag, if not already attached. Refer to Attaching the Calibration Bag
on Page 68.
2. If the Cosignature required message appears, the cosigner should:
a. Tap OK.

Cosignature required. Configuration must be verified
by second person.

Message

b. Enter a Login name.
c. Enter a Password.
d. Tap Log In, then continue with the next steps.

S

Login |
Password
[ Login ] [ Cancel ]
x J
Cosignature window
Operator Manual ExactaMix Pro 2400 Compounder
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When an X appears on the ingredient button, it indicates that priming and verification
are needed.

PRIME AND VERIFY

Close

CaGluclo

i % ‘( i %

13 15 17 19 23
© O 0 @ U
e O O @ o
14 16 18 20 24
MTESHCnnc
(14D 4
1
MgSod SWFI
‘( mix| | Eix
] 1
Configuration: EM2400 CONFIG. User: ADMIN

PRIME AND VERIFY screen, no inlets primed

CAUTION

Do not prime calcium and phosphate ingredients consecutively. Interaction of these
ingredients can cause a precipitate, which may block the common fluid pathway and

require a replacement of the tube set.
If the configuration includes a lipid, you should prime the Universal Ingredient
immediately after priming the lipid.

Always follow the configuration setup that Baxter recommends, and prime ingredients
in the sequence of the port numbers (1, 2, 3 and so on).

Tip! Baxter recommends physically rotating each source container so that its product
label faces you, for easy verification.
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3. Tap aningredient button.
The ingredient detail window appears.

Baxter Clinolipid 20% 250 Bag

Port Number 1
Ingredient Clinolipid 20%
Sequence Number 1
Drug ID 0338-9540-02
Container Size (mL) 250.00
Spec. Gravity 1.00
Remainder (mL) 250.00
Spike Type Non-Vented, Macro Inlet
Time Spiked 5/28/2021 7:44:02 PM
{ Prime ] { Close ]

Ingredient detail window before priming

4. At the ingredient detail window, review the information.
a. Check that the product information in the title bar of the window is correct.
b. Check that the Port Number is correct.
c. Check that the Ingredient description matches the source container to be used.
d. Check that the Remainder (mL) matches the current volume of the source
container to be used.
e. Check that the Spike Type (inlet type) is correct.
5. On the valve set, locate the port for this ingredient.
6. With one hand, hold the inlet that is attached to the port, and with the other hand,
follow the inlet up to the source container.
7. While continuing to hold the inlet near the source container:
a. Check that the number on the inlet label matches the port number.
b. Check that the product attached to the inlet matches the information on the
screen.
c. Attheingredient detail window, tap Prime.
d. Check that a calibration bag is attached.
e. Atthe Priming pump message, tap OK.

@ . Priming pump. Attach bag or waste container.

[ oK ] [ Cancel ]

Message
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f.  Watch and feel for fluid moving through the inlet that is in your hand.

When an ingredient is being primed, its button becomes blue. The screen
displays an animation of the process.

PRIME AND VERIFY

L=

Pause

NaPhos3 Nacl4
xJ ‘H nxJ
| _ ]
1] 1]
5 7 9 11 13 15 17
® ® &6 O O O O
® 6 6 O 0 O O
6 8 10 12 14 16 18
|
l(.lld Cs«lvll.s MTELlcon( CaGlucld
H X} ‘ IEXW ‘H X‘ 22p 4
] ] ]

Running 30 mL of Clinolipid 20% from port 1

PRIME AND VERIFY screen, priming in progress

WARNING
A The ingredient must be attached to the proper port. Patient harm can occur if
the location of an ingredient is incorrect.

8. If the fluid:
e Does flow through the inlet that is in your hand, continue with the next step.

e Does not flow through the inlet that is in your hand, resolve any problems, check
that the inlet is attached to the correct port and prime it again.

Operator Manual
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After the inlet has been primed, the ingredient detail window includes a Verify button,
and the Prime button becomes a Re-Prime button.

Baxter Clinolipid 20% 250 Bag

Port Number
Ingredient
Sequence Number
Drug ID

Container Size (mL)
Spec. Gravity

Remainder (mL)

1

Clinolipid 20%
1
0338-9540-02
250.00

1.00

190.00

Spike Type Non-Vented, Macro Inlet
Time Spiked 5/28/2021 7:44:02 PM
[ Re-Prime ] [ Verify ] { Close ]

Ingredient detail window after priming

NOTE: The first prime uses the standard priming volume. Any subsequent primes use

t

he minimum priming volume.

9. Check the inlet to be sure that it primed properly, leaving no air in the inlet tube. If
necessary, tap Re-Prime.
10. When priming is finished:

Operator Manual

a. Release the tube from your hand.

b. Tap Verify to confirm that the ingredient’s inlet is attached to the correct port.
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The connecting lines between the ingredient button and the port include horizontal
marks, indicating that the ingredient has been primed. On the ingredient button, the
red X becomes a green check mark, indicating that the ingredient has been verified.

PRIME AND VERIFY

=
o
]
=
(]
w

o O
50O O

2@ O
o0
e O

[y
[=2)
)
%)
[\
=

SWFI ‘

| E=

Configuration: EM2400 DEMO User: ADMIN

PRIME AND VERIFY screen, one inlet primed and verified

11. Repeat steps 3—10 for all the attached ingredients. If the calibration bag becomes full,
remove it and attach a new one. Refer to Attaching and Removing the Calibration Bag
on Page 68.

12. When you are finished, tap Close.

PRIME AND VERIFY

Close

ole
16 18
V
Configuration: EM2400 DEMO User: ADMIN

PRIME AND VERIFY screen, all inlets primed and verified
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13. At the Fluid path will be flushed with Ul message, tap OK.

o Fluid path will be flushed with UI.

Message

The compounder flushes the common fluid pathway with the Universal Ingredient, and
tests for proper function of the occlusion detector. If the test fails, you cannot
continue compounding a solution. Refer to Issues with the Occlusion Detector / “Flow
Sensor” on Page 203.

14. At the Ul flush complete message, tap OK.

o Ul flush complete.

Message

If a cosigner was logged in, the software automatically logs out the cosigner and logs in
the original user.

If you started this procedure from the Setup Wizard screen, a check mark now appears
in the Prime and Verify portion of the Setup Wizard screen.
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CALIBRATING THE COMPOUNDER

This procedure calibrates the compounder’s pump to ensure that it delivers the intended
volume of each ingredient.

1. Atthe Setup Wizard screen, tap Calibrate Compounder.

SETUP WIZARD

Calibrate

Calibrate
Load Cell

Touch Here to

Select
Configuration

Touch Here to

Change
Tube Set

Touch Here to

Prime and
Verify

Touch Here to

Compounder

Touch Here to
Begin

Edit Edit Edit Edit

v

O O

Next step: Calibrate Compounder

v

Touch the highlighted button to continue.

[ Authorization Report ] [ Exit ]

Setup Wizard screen, calibrating the compounder

NOTE: You can calibrate the compounder at any time by tapping Compound >
Calibrate Pump at the menu screen.

AN

2. If a calibration bag is not already attached, attach it. Refer to Attaching the Calibration
Bag on Page 68.
3. Atthe Calibrating pump message, tap OK.

CAUTION

A calibration bag must be used during all priming/verifying and Universal
Ingredient flushes.

Calibrating pump. Make sure calibration bag is
attached and placed on load cell.

GECTI

Message

Cancel ]

Operator Manual
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4. If the Bag currently on the load cell does not appear to be empty message appears,
visually check the contents of the bag.

e If the bag is empty, refer to The bag currently on the load cell does not appear to be
empty on Page 202.

e If the bag contains fluid, continue with the next step.

5. Check whether the bag has space for an additional 200 mL of fluid.
e |If the bag does not have space:
Tap No.
At the Operation Cancelled message, tap OK.
Remove the calibration bag. Refer to Removing the Calibration Bag on Page 69.

Attach an empty calibration bag. Refer to Attaching the Calibration Bag on
Page 68.

e. Returnto Step 1.
e If the bag has space, tap Yes.

o 0o oo

IMPORTANT! It is acceptable to calibrate the pump when the calibration bag
contains fluid. However, the calibration procedure is the only time you should tap
Yes at this message. Never tap Yes when compounding a solution into a patient bag.

o The bag currently on the load cell does not appear to

be empty. Continue?

[ Yes ] [ No ]

Message
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6. Atthe Select Bag Type window:
a. Select the type of bag you are using.
b. Tap OK.

Select Bag Type

Please select a bag type.

() x37 EVA Container 250mL
(O x36 Calibration 500mL

(O x38 EVA Container 500mL
() 735 Calibration 1000mL

(O x39 EVA Container 1000mL
(O 901 Dual Chamber 1500mL
(O x40 EVA Container 2000mL
(O 905 Dual Chamber 3000mL
(O x41 EVA Container 3000mL

(O x42 EVA Container 4000mL

Select Bag Type window,
sample North American version

IMPORTANT! If any items touch the load cell during the calibration, the calibration will
not be accurate.
7. Make sure that:
e There is no weight on the load cell.

e There is nothing touching any part of the load cell (for example, there are no cables
touching the base).

The compounder pumps 100 mL of water, checks the weight, makes any necessary
adjustments to the movement of the pump rotor, pumps 100 mL again and checks the
weight again. If the Universal Ingredient (Ul) for the configuration is something other
than water, the compounder automatically flushes the common fluid pathway with the
identified Ul.

This message appears and disappears:

Load Cell

Sampling weight for highest accuracy. Please be patient...

Message
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8. At the Pump calibration completed successfully message, tap OK.

o Pump Calibration Completed successfully.

Message

NOTE: If calibration fails, refer to Pump calibration failed on Page 200.

If you started this procedure from the Setup Wizard screen, a check mark now appears
in the Calibrate Compounder portion of the Setup Wizard screen.

9. Remove the calibration bag. Refer to Removing the Calibration Bag on Page 69.

ATTACHING AND REMOVING THE CALIBRATION BAG

Attach and remove the calibration bag when other procedures direct you to do so.

Attaching the Calibration Bag
Always use aseptic technique when attaching the bag.

1. Connect a sterile calibration bag to the outlet tube.

Tip! Baxter recommends twisting the bag onto the outlet tube before attaching the
bag to the load cell to prevent twisting or straining of the connection.

2. Attach the bag to the load cell. Place the holes in the corners of the bag over the guide
pins on the load cell.

Route the bag’s fill port through the load cell’s fill port holder.

4. Make sure the outlet tube is curved, not twisted or kinked.

w

Attaching the calibration bag to the outlet tube and the load cell
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Removing the Calibration Bag
Always use aseptic technique when removing the bag.

1. Remove the bag’s fill port from the load cell’s fill port holder.
2. Remove the bag from the load cell.

3. Clamp the bag’s fill port, unless the bag is not full and it will be used for other

recalibrations.
Disconnect the outlet tube from the bag.

Cap the bag’s fill port.

4,
5. Connect the end of the outlet tube to the tube holder on the vial rack.
6
7

Discard the bag, or if not full, set aside the bag for re-calibration or flushing.

NOTE: If saving the bag, keep it in the hood to preserve aseptic.

VIEWING THE AUTHORIZATION REPORT

When the setup steps are finished, the Authorization Report button becomes active at the

Setup Wizard screen.

At the Setup Wizard screen, tap Authorization Report.

SETUP WIZARD

Calibrate Select Change Prime and
Load Cell Configuration Tube Set Verify
Touch Here to Touch Here to Touch Here to Touch Here to
Edit Edit Edit Edit

O O 0 ¢

Calibrate
Compounder

Touch Here to
Edit

v,

The compounder is now ready for operation.

Touch the Exit button to return to the application.

*

*® G
) [ Authorization Report ]:1 [ Exit

¥ e
"Tsaappuunnns?®

Setup Wizard screen, viewing the Authorization Report

NOTE: You can view the Authorization Report at any time by tapping Reports > Authorization

Report at the menu screen.

For more information, refer to Authorization Report on Page 165.

To exit the Setup Wizard screen, tap Exit.
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USING THE COMPOUNDER

After you finish setting up the compounder, you are ready to load formulas and fulfill orders.

FULFILLING THE ORDER (BASIC PROCESS)

Loading a Formula by Scanning a Barcode
Most facilities use this method.

IMPORTANT! This method requires:

e Order-entry software on a separate computer. This software must be able to produce

both a .PAT/.FRM file and a corresponding label / report with a barcode. Both the
.PAT/.FRM file and barcode must be compatible with the compounder.
Alternatively, the software must also be able to produce a formula label, containing the
formula details in the 2D barcode and the 2D formula barcode must also be compatible
with the compounder. For more information, contact Baxter Technical Support. Refer to
Getting Help on Page 20.

e Network connection between the order-entry computer and the compounder

e Barcode reader at the compounder

The pharmacist creates an order in the order-entry software, which creates a .PAT/.FRM file
that contains the patient information and the formula. A corresponding label with a barcode
also prints at the same time. Alternatively, the order-entry software creates and prints a 2D

Formula Barcode label which directly contains the patient information and the formula.

Baxter recommends the following process:
1. Attach the bag label to the patient bag.

2. Attach the patient bag to the compounder. Refer to Attaching the Patient Bag on page 71.

3. Scan the barcode for the order.

The compounder retrieves the order through the network and populates the pump screen
with the patient name, formula serial number and volume of each ingredient to be pumped.
The compounder reads the Drug ID number of each ingredient in the formula and matches
this number to one in the formulary. In the United States, the Drug ID number is usually the
National Drug Code (NDC).
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WARNING

The Drug ID number for each product in the formula must exactly match the
Drug ID number for that product in the compounder’s formulary. If a Drug ID

A number is assigned to one product in the order-entry software, and that
number is assigned to a different product in the compounder’s formulary, the
compounder will pump the wrong ingredient, resulting in patient harm. It is the
user’s responsibility to ensure that Drug ID numbers are properly and
consistently assigned in both systems.

NOTE: If any ordered ingredients are not in the configuration on the compounder, are
not allowed as auto-additions or have a volume less than 0.2 mL, the compounder
software will identify these ingredients as manual additions.

Attaching the Patient Bag
Always use aseptic technique when attaching the bag.

1. Connect a sterile patient bag to the outlet tube.

Tip! Baxter recommends twisting the bag onto the outlet tube before attaching the
bag to the load cell to prevent twisting or straining of the connection.

2. Attach the bag to the load cell. Place the holes in the corners of the bag over the guide
pins on the load cell.

Route the bag’s fill port through the load cell’s fill port holder.

4. Make sure the outlet tube is curved, not twisted or kinked.

w

Attaching the patient bag to the outlet tube and the load cell
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Compounding the Solution

IMPORTANT! This function requires Compounder permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

5. Atthe pump screen, verify the patient’s name and bag serial number at the top of the
screen matches the name and serial number on the bag. If they match, tap Run.

Formula Name: DOE, JOHN 1234 Formula Serial #: DE 06Aug2021 150513

Run
NaAc2 Csoll5 CaGlucl0 SWFI
[ 7 11 14 10 ¥ B v
0.00mL 900.00mL 10.00mL 429.00mL
[ 13 [ 109 |14 113
NaPhos3 E NacCla . E Dex70
3. ‘( v o m
5.00mL B 28.00mL W 385.00mL
15 ¢ 1 o  J11
a B I H
0600000 e
6 8 10 12 14 16 18 20
g i | W
KPhos3 : KCi2 MTE5Col
NN 10 % ‘( 14 Q¥
0.00mL o 30.00mL 1.00mL
16 # 2 —_]10
KAc2 MgSod SWFI
B ‘( B v ‘( B
0.00mL 2.00mL 0.00mL
7 14 112 113
Volume: 1800.00mL
Configuration: EM2400 DEMO User: ADMIN

Pump screen, ready to start compounding the solution

6. If the message shown below appears, visually check the contents of the bag.

e [f the bag is empty, refer to The bag currently on the load cell does not appear to be
empty on Page 202.

e |If the bag contains fluid:

Tap No.

At the Operation Cancelled message, tap OK.

Remove the bag. Refer to Removing the Patient Bag on Page 75.

Attach an empty bag. Refer to Attaching the Patient Bag on Page 71.
Return to Step 1.

oo oo

o The bag currently on the load cell does not appear to

be empty. Continue?

[ Yes ] [ No ]

Message
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AN

WARNING

If you tap Yes, the compounder will reset the measured weight to zero, despite
the fact that the bag contains fluid.

The finished solution may contain an unintended volume or ingredient, even if
the final measured weight is within the acceptable range. This unintended
volume or ingredient may result in patient harm.

The Details section of the MixCheck Report will indicate that you continued
compounding despite the warning that the bag did not appear to be empty.

For instructions on how to handle a finished bag in this situation, refer to your
facility’s protocol.

7. Atthe Select Bag Type window:
a. Select the size of the bag you attached.
b. Tap OK.

Operator Manual

Select Bag Type

Please select a bag type.

() x37 EVA Container 250mL
(O x36 Calibration 500mL

(O x38 EVA Container 500mL
(0 735 Calibration 1000mL

(O x39 EVA Container 1000mL
() 901 Dual Chamber 1500mL
(O x40 EVA Container 2000mL
(0 905 Dual Chamber 3000mL
(O x41 EVA Container 3000mL
() x42 EVA Container 4000mL

Select Bag Type window
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At the pump screen, the Run button becomes a Pause button. The compounder pumps each
ingredient, one at a time into the patient bag in the specified sequence and volume. When an
ingredient is being pumped, its button becomes blue.

Formula Name: DOE, JOHN 1234 Formula Serial #: DE 06Aug2021 150513

Pause

CaGlucl0o
v
10.00mL

114

SWFI
v
429.00mL

113

n
S
3

5 3 _E> 7 11 13 15 17 19

O O ®© 6 6 6 O O O @

O @& @ e 6 O 6 O O e

2 4 6 ] 10 12 14 16 18 20
E KPIE)53 E KEIZ MTESuCun[
l[ v | B 10 RV ( 14 %
u 0.00mL u 30.00mL 1.00mL
Rl Bl C—J2 —— 10
Inf:vA KA.tz MgSod SWFI
Y LY 12 -
10.00mL 0.00mL 2.00mL 0.00mL
7 1 4 112 113

Volume: 2000.00mL
Running 28 mL of Na Chloride 4mEg/mL from port 9

Pump screen, compounding the solution

NOTE: For information about messages that might appear just before or during the
compounding process, refer to Fulfilling the Order (OTHER COMMON ACTIVITES) on
Page 83.

If you need to stop compounding temporarily, you can perform either of the following actions.
The MixCheck Report will indicate that you performed the action.
e Tap Pause, then tap Resume to start compounding again.

e Open the pump door, then close the pump door and tap Resume to start
compounding again.

When compounding is finished, a message displays this information about the patient
bag:

o Expected weight

o Actual weight

o Difference

o Statement about whether or not the difference is acceptable

NOTE: If the difference is not acceptable, refer to Issues with the Weight and Load Cell
on Page 201. The acceptable difference is typically set to + 5%. To change this setting,
refer to Acceptable Weight Variances on Page 106.
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8. Atthe message with information about the patient bag, tap OK.

Expected Weight: 250.00 gm
Actual Weight: 250.01 gm
Difference: 0.00%

The final weight of this solution is within
the acceptable limit of +/- 5.00%

oK l

Message

9. If the selected formula contained manual add ingredients, the following message will
appear as a reminder, tap OK.

Solution contains manual add ingredients which must be added
to the final bag

Ingredient Volume
Albumin 25% 10.00 ml
Zinc 1mg/ml 1.00 ml

OK '

Message

Removing the Patient Bag
Always use aseptic technique when removing the bag.

1. Remove the bag’s fill port from the load cell’s fill port holder.

Clamp the bag’s fill port according to facility protocol.

Remove the bag from the load cell.

Disconnect the outlet tube from the bag.

Connect the end of the outlet tube to the tube holder on the vial rack.
Cap the bag’s fill port.

dnhwnN

Completing the Order

WARNING
A It is important to inspect the finished solution to make sure that it complies with
standards.

1. If necessary, perform any manual additions. Refer to Performing a Manual Addition on
Page 84.

2. Visually inspect the finished solution in the patient bag for precipitates and particulates.
Follow your facility’s protocol.

3. View and approve the MixCheck Report according to your facility’s protocol. For
instructions, refer to MixCheck Report on Page 160.
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UNDERSTANDING AUTOMATIC UNLOADING OF FORMULAS

As a safety precaution, the software automatically unloads the formula in these two situations:

e The software unloads the formula if you leave the pump screen after loading the
formula and before starting the compounding process.

The message below, or one similar to it, appears and then automatically disappears.

The only exception is that the software does not unload the formula when you
perform an auto-addition.

The current formula entered into the pump will be
removed for safety purposes.
Select OK to Save the Formula for future use. When
ready to pump, select the Formula from the Formula
List.
Select Cancel to abort entering a formula and exit to
the Menu Screen.

[ oK ] [ Cancel ]

Message

e The software usually unloads the formula when compounding is finished, regardless of
the outcome.

No message appears; however, you cannot use the formula for compounding again.
The only exception is that the software does not unload the formula when both of the
following conditions occur together:

o The solution limit is more than 1 and has not yet been met, or the solution limit
is disabled. For more information, refer to Solution Limit on Page 109.

o Barcode scanning is not required to load a formula, but the formula was loaded
through this method. For more information, refer to Barcode Reader on
Page 109.

NOTE: In the event there is a power interruption during compounding, upon
restarting the compounder and initiating pumping, the formula will be unloaded
and the system will perform a flush as follows:

e Power interruption during pumping — prime and verify the open port, then
flush occurs.

e Power interruption during idle state — formula unloads, then flush occurs.

Write a large “X” on the label of the patient bag after the flush, then remove and
discard the bag.
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OTHER METHODS OF LOADING THE FORMULA

There are several methods for loading a formula onto the compounder. They are:
e Automatically loading a formula by scanning a barcode to retrieve the .PAT/.FRM file
(recommended)

e Automatically loading a formula by scanning the 2D formula barcode containing the
formula details.

e Manually entering a formula through direct entry
e Manually selecting a saved formula

Tip! Baxter strongly recommends loading a formula by scanning a barcode, and using the
manual entry or selection methods only when the barcode method fails. If the network
connection to the order-entry system fails, you can still load a formula by scanning a barcode.
For instructions, refer to Loading a Formula by Connecting a USB Drive on Page 206.

NOTE: To enable barcode scanning (and, if desired, to require it for loading formulas), refer to
Barcode Reader on Page 109.
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Entering a Formula through Direct Entry

Some facilities may use this method if the order-entry software is temporarily unavailable. With
this method, you must manually enter the volume of each ingredient to create a new formula.

This process creates a formula with a unique ID, but it does not create a 2D Formula
Barcode/.PAT/.FRM file or a corresponding label with a barcode.

WARNING
A Formulas entered directly into the compounder should be checked by a pharmacist.
The compounder does not verify the formulas.

IMPORTANT! This function requires Formula Entry permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

1. Atthe menu screen, tap Tools > Direct Entry.

Change Universal Ingredient

Direct Entry

Options

Users

COMPOUND
Database

System Settings

Software Update

IEOIONES RIE BIOIRITES FEENSE

Close

Menu screen, Tools menu

NOTE: To stop using direct entry, you can tap Tools > Cancel Direct Entry at the menu
screen.
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The pump screen appears. The text DIRECT ENTRY appears on the left side.

Formula Serial #: NEW FORMULA
NaAc2
| 7
16
Clinolip NaPhos3 E NaCla
[ 1 A3t 3v
DIRECT ENTRY ﬂ 0.00mL ﬂ 0.00mL B 0.00mL
I ] 1 I ] 4) # 8
o I H |
e O 00000 DD
2 4 6 8 10 12 14 16 18
g n B o
InfuvA : KAc2 : Csoll5 MTES5Conc
«:( v :( 10 p9 ( i
0.00mL q 0.00mL o 0.00mL 0.00mL
] 2) & ] 5) # ] 9 110
KPhos3 KCz
( [ 4 g ( [ 8 v
0.00mL 0.00mL
13 7
Volume: 0.00mL
Configuration: EM2400 DEMO User: ADMIN

Pump screen during direct entry

2. Obtain the formula from the pharmacist. Refer to your facility’s protocol.
3. Tap the ingredient button for the first ingredient in the formula.

The ingredient detail window appears.

Baxter Sterile Water for In 2000 Bag

Port Number 24
Ingredient Sterile Water for In
Sequence Number 14
Drug ID 0338-0013-06
Container Size (mL) 2000
Ordered Volume (mL) l:l
Remainder (mL) 1810.00
Spike Type Non-Vented, Macro Inlet
Time Spiked 5/28/2021 7:44:02 PM
[ Change Container ] [ Save ] { Close ] [ Next ]

Ingredient detail window during direct entry
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4. Atthe ingredient detail window:
a. Check that the Ingredient shown matches the ingredient ordered. Check its
description, concentration and so on.
b. Enter the Ordered Volume of the ingredient to be delivered.
c. Tap Save or tap Next to view the next ingredient detail window.

The Run button becomes available on the pump screen.
5. Repeat steps 3—4 for each ingredient in the formula.
6. If youwantto:
e Use the formula now, continue with Saving and Using a Direct-Entry Formula on
Page 80.

e Save the formula for using later, continue with Saving a Direct-Entry Formula to Use
Later on Page 81.

Saving and Using a Direct-Entry Formula

NOTE: For information about automatic unloading of formulas, refer to Understanding
Automatic Unloading of Formulas on Page 76.

1. Attach the patient bag. Refer to Attaching the Patient Bag on Page 71.
2. Atthe pump screen, tap Run.
3. Atthe Formula Information window:

a. Enter a Formula Name.

b. If desired, enter a new Serial Number.

Tip! Baxter recommends not changing the serial number.
c. Tap OK.

Formula Information

Serial Number |DE 26May2021 204748 |

Formula Name ‘ ‘

{ Ok ][ Cancel ]

Formula Information window

4. Continue with Compounding the Solution on Page 72.

NOTE: You do not need to tap Run again.
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Saving a Direct-Entry Formula to Use Later

1. Atthe pump screen, tap Menu.
2. Atthe Information message, tap OK.

The current formula entered into the pump will be
removed for safety purposes.

Select OK to Save the Formula for future use. When
ready to pump, select the Formula from the Formula
List.

Select Cancel to abort entering a formula and exit to
the Menu Screen.

o< J{

Message

Cancel ]

3. Atthe Formula Information window:
a. Enter a Formula Name.
b. If desired, enter a new Serial Number.

Tip! Baxter recommends not changing the serial number.
c. Tap OK.

Formula Information

Serial Number |DE 26May2021 204748 |

Formula Name ‘ ‘

ok )

Formula Information window

Cancel ]

4. When you want to compound the solution, continue with Selecting a Saved Formula

on Page 82.
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Selecting a Saved Formula

Some facilities may use this method to select a saved formula, which has already been loaded
onto the compounder by scanning a barcode or direct entry.

IMPORTANT! This function requires that formulas can be loaded without scanning barcodes.
For more information, refer to Barcode Reader on Page 109.

1. Atthe menu screen, tap Compound > Select Formula.
The Select Formula window appears.

Select Formula

Formula Name Serial Number

DE123 DE 26May2021 204748

rFilter

(OShow All Formulas (@ Show Unpumped Formulas () Show Pumped Formulas

[ OK ] [ Cancel ]

Select Formula window

2. Atthe Select Formula window, tap one of these filter options:
e Show All Formulas to view all the formulas that are stored

e Show Unpumped Formulas to view all the formulas that have not been used for
compounding

e Show Pumped Formulas to view all the formulas that have been used for
compounding

Tip! Baxter recommends selecting only Show Unpumped Formulas.

NOTE: You can tap Formula Name to sort by name or tap Serial Number to sort by
number. Formulas are stored for a specified time period. To set up the storage of
formulas, refer to Storage on Page 104.

Select a formula.
4. Tap OK.

The formula is loaded and appears on the pump screen.
5. Continue with Fulfilling the Order (Basic Process) on Page 70.

w
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FULFILLING THE ORDER (OTHER COMMON ACTIVITES)

To complete some orders, you may need to perform additional steps along with the basic steps
already explained. Interruptions to the compounding process may occur. These additions and
interruptions are part of normal operation.

Replacing a Source Container

If you are fulfilling a series of orders, an ingredient may become depleted and need to be
replaced. When a formula is loaded and requires more ingredient volume than what remains in
the source container, the vertical bar on the ingredient button flashes. You can replace the
container now or start compounding. If you start compounding, the Swap Container window
appears when the source container is almost empty.

Swap Container

Your container of Na Phosphate3mMol/mL PO4 at port 5 is empty.
You have 3.00 mL left to run. Please change the container now.

[ Swap is Complete ] [ Use a Different Container ]

[Stop filling and throw bag away] [ Use some overfill ]

- “

Swap Container window

1. Check that the source container is appropriately depleted.

WARNING
ii If there is a large amount of fluid remaining in the source container, or if the

container has emptied completely and forced air into the inlet, there may be
a delivery problem. For assistance with troubleshooting, contact Baxter
Technical Support. Refer to Getting Help on Page 20.

2. Atthe Swap Container window, tap one of these options:
e Tap Swap is complete to replace the empty container with an exact match (same
ingredient, container size, container type and manufacturer). Use aseptic technique
to replace the source container.

e Tap Use a different container to replace the empty container with the same
ingredient from a different container size, container type or manufacturer. Use
aseptic technique to replace the source container.

NOTE: This is the recommended action.

Operator Manual ExactaMix Pro 2400 Compounder

0719003109 Rev. A, Effective Jan 2022 Page 83



Maintaining the Compounder

WARNING

The remainder value in the software must accurately represent the
A actual volume remaining in the source container. Change a remainder
value only when you know the precise amount remaining in the source
container. Incorrect remainder values can lead to bubbles, occlusions,
and under-delivery of an ingredient if its source container runs empty.

NOTE: Using a different container may require you to change and prime the inlet.
Refer to Attaching the New Ingredients and Inlets on Page 45 and Priming and
Verifying on Page 54.

e Tap Stop filling and throw bag away to cancel the order. At the pump screen, tap
Stop and follow the on-screen instructions.

e Tap Use some overfill to use the fluid remaining in the current container to
complete the order. At the Overfill Volume window:

a. Enter the Overfill volume to use.

WARNING

Adjusting the value improperly in the Overfill volume to use field
can lead to bubbles, occlusions and under-delivery of an ingredient if
its source container runs empty.

b. Tap OK.

Overfill Volume

Overfill volume to use:
\1.00 ‘

[ oK ] [ Cancel ]

Overfill Volume window

Performing a Manual Addition

A manual addition allows you to add an ingredient to the finished solution manually. This type
of addition may be necessary when the loaded formula includes an ingredient that meets one
or more of these conditions:

e [tis notin the configuration.

e [tis notidentified as an allowable auto-addition.

e Its ordered volume is less than the 0.2 mL minimum required for use on the
compounder.

If a formula loaded by scanning a barcode includes an ingredient that must be added manually:

e A Manual Add button appears on the left side of the pump screen. You can tap this
button to view information about the ingredients that must be added manually.
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Formula Name: JaneDoeManualAddi... Formula Serial #: DE 30Sep2021 195427
Run
NaA:Z Csol15 CaGluclo SWFI
™ El v
I 113
Clinolip NaPhos3 E NaCl4 E E Dex70
Manual Add ( 1 v ‘( (5 K% :( Ev | . 21 Ko
200mL 5mL B 28mL B : 385mL
18 — - - — Y - L — &
e OO0 00000 0Oe @
2 4 6 8 10 12 14 16 18 20 22
KPhos3 E KCiz MTESCnn: E
‘ | 6 Rl V‘ 110 :
omL B 3GmL :
5) d
InfuvA KAc2 MgSod SWFI
jE-| g E LN
10mL omL 2mL
17 [ 14 112 113

Volume: 2000.00mL
Loading Formula JaneDoeManualAddition/DE 30Sep2021 195427...Done.

Pump screen with manual addition

e The MixCheck Report includes a list of any ingredients that must be added manually. For
more information, refer to MixCheck Report on Page 160.

To add ingredients manually, follow your facility’s protocol.

NOTE: To set the maximum volume allowed for a manual addition, refer to Manual Add on
Page 107.

Handling an Air Bubble

An air bubble can occur at any time, but it most frequently occurs after attaching a source
container and priming the inlet. A bubble can be caused by an improperly spiked container, an
empty container or incomplete priming.

When the bubble detector finds a bubble in the outlet tube over the detector, the
compounding process stops and an alarm beeps. A message also appears.

1. Atthe Bubble was detected while pumping from port <port number> message, tap OK.

‘\_ Bubble was detected while pumping from port 24.

(o )

Message

NOTE: This does not mean that the bubble came from port 24. The bubble could have
come from any of the previous ingredient deliveries.
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IMPORTANT! A bubble in the common fluid pathway displaces the volume of one or
more ordered ingredients, causing an under-delivery of these ingredients.

2. Determine the impact of the bubble:

a. Check the size of the bubble using the EM2400 Bubble Chart to determine the
volume of fluid displaced. Use the bubble chart to determine the size of the
bubbles within the tube set.

b. If more than one bubble is present, evaluate each bubble and add the values
together to determine the total volume of fluid displaced.

c. ldentify all the ingredients pumped prior to the alarm, the ingredient pumped
during the alarm and the volume of each ingredient ordered.

Tip! Baxter recommends that a pharmacist evaluate the clinical significance of bubbles
encountered during the compounding process.

3. Ask a pharmacist to determine if the displaced volume is clinically significant for any of
the ingredients pumped. Assume that the total displaced volume applies to each
ingredient ordered.

4. |If the clinical significance:

e [s acceptable, tap Resume at the pump screen to continue compounding the
solution, and do not continue with the steps below

e Is not acceptable, or cannot be determined, continue with the next step to cancel
the order

Tip! Baxter recommends documenting all decisions according to your facility’s
protocol.

5. Immediately write a large “X” on the label of the patient bag.
6. Atthe pump screen, tap Stop.
7. Atthe Really abort the current solution? message, tap Yes.

Really abort the current solution?
Current formula entered into the pump will be
removed for safety purposes. When ready to pump,

select the formula from the Formula list.Select Yes to
continue.

[ Yes ] [ No ]

Message

The software unloads the formula.
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8. At the Operation Cancelled message, tap OK.

‘\ Operation Cancelled

Message

9. At the Fluid path will be flushed with Ul message, tap OK.

o Fluid path will be flushed with UI.

Message

10. Check that the fluid moves properly during the flush.
11. At the Ul flush complete message, tap OK.

0 Ul flush complete.

Message

12. Remove the bag. Refer to Removing the Patient Bag on Page 75.

13. Discard the bag.
NOTE: To help reduce the occurrence of bubbles and make their detection more accurate, you
can:

e Use proper technique to spike the containers. Refer to the steps for spiking a container,
starting on Page 48.

e Re-prime any inlets that have visible bubbles. Refer to Priming the Inlets and Verifying
the Setup on Page 58.

e Increase the priming volume in the configuration. Refer to Adding or Editing a
Configuration on Page 128.

e C(Clean the channel over the bubble detector. Refer to Cleaning the Compounder on
Page 93.

e Make sure that the outlet tube is in the proper position. It should be at the bottom of
the channel over the bubble detector. Refer to Step 7a on Page 43.
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Handling an Occlusion

An occlusion can be caused by an empty syringe, stuck syringe plunger, kinked tube or other
obstruction in the inlet.

When the occlusion detector detects that a vacuum was drawn, indicating an occlusion
somewhere between the source container and the detector, the compounding process stops
and an alarm beeps. A message appears, and a red occlusion symbol also appears near the
ingredient button.

SWFI

30mL

lv |

Occlusion symbol

1. Immediately write a large “X” on the label of the patient bag.
2. At the Occlusion was detected while pumping from port <port number> message, tap
OK.

Q Occlusion was detected while pumping from port 24.

Message

3. Atthe pump screen, tap Stop.
4. At the Really abort the current solution? message, tap Yes.

Really abort the current solution?
Current formula entered into the pump will be
removed for safety purposes. When ready to pump,

select the formula from the Formula list.Select Yes to
continue.

[ Yes ] [ No ]

Message

The software unloads the formula.
5. At the Operation Cancelled message, tap OK.

Q Operation Cancelled

Message
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6. Check that:
e Each syringe has fluid and its plunger is not stuck.

e The appropriate inlet is used with each source container.

e The inlets have no obstructions, kinks, tangles or plugs. If necessary, replace the
inlets. Refer to Changing the Tube Set on Page 40.

e The occlusion detector is not damaged or dirty.
e The outlet tube is straight and flat on the occlusion detector.
7. At the Fluid path will be flushed with Ul message, tap OK.

0 Fluid path will be flushed with Ul.

Message

8. Check that the fluid moves properly during the flush.
9. Atthe Ul flush complete message, tap OK.

o Ul flush complete.

Message

10. Remove the bag. Refer to Removing the Patient Bag on Page75.
11. Discard the bag.
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Performing an Auto-Addition

An auto-addition allows you to add an ingredient to the existing configuration temporarily, to
fulfill the current order, instead of selecting a new configuration (which would require you to
prime and verify all the inlets and ingredients).

If the loaded formula includes an ingredient that is not attached to the compounder but is
identified as an allowable auto-addition in the formulary and the current configuration, a
Confirm message appears.

1. Atthe Confirm message, tap OK.

. @ \  This formula contains Heparin 1000 units/mL, which
" is not currently on the configuration.
Do you wish to add it to the configuration?

[ OK ] [ Cancel ]

Message

-

2. Atthe Select port window:
a. Select the port to which you will attach the ingredient.
b. Tap OK.

Select Port

Select port on which to add ingredient Heparin 1000 units/mL and click OK.

Click on Cancel to abort adding this ingredient

15 ¢

[ oK ] [ Cancel ]

Select port window
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3. Atthe Specify New Container window:
a. Select the Product Name.
b. Tap OK.

Specify New Container

Port Number: 15

Ingredient Name: Heparin 1000 units/mL

Product Name: Fresenius Kabi Heparin 1000 units/mL 30 Vial

Container Size (mL): 30

Specific Gravity: 1

Remainder (mL): 30.00

Time Spiked: 9/30/2021 8:22:44 PM

ok )|

Cancel ]

Specify New Container window

4. Attach the new ingredient and inlet. Refer to Attaching the New Ingredients and Inlets

on Page 45.

5. If you have already attached the patient bag, remove it. Refer to Removing the Patient

Bag on Page 75.

6. Attach a calibration bag. Refer to Attaching the Calibration Bag on Page 68.

7. Prime and verify the new inlet and ingredient. Refer to Priming and Verifying on

Page 54.

8. Remove the calibration bag. Refer to Removing the Calibration Bag on Page 69.

9. Attach the patient bag. Refer to Attaching the Patient Bag on Page 71.

NOTE: You can reattach the original patient bag.

10. Continue with compounding the solution. Refer to Compounding the Solution on

Page 72.
NOTE: The formula is not unloaded from the pump screen.

Handling Other Interruptions and Errors

For more information about handling interruptions and errors, refer to Troubleshooting on

Page 192.
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REMOVING THE EXPIRED TUBE SET AND EXPIRED INGREDIENTS

CAUTION

A Do not remove the valve set until you have removed all source containers.
This precaution helps to prevent a dropped source container from damaging the
valve actuators.

WARNING

A The only time the rotor should be rotated manually is under “Tube Set Will Be
Changed” or when the compounder is powered OFF. Turning the rotor at any other
time while the compounder is powered on will result in a fault state error message.

If an expired tube set and expired ingredients are already installed:

1. Attach a calibration bag. Refer to Attaching the Calibration Bag on Page 68.

2. Place a waste container in front of the hood and align in front of the compounder.

3. Remove one source container from the vial rack or hanger and turn the source
container right side up.

4. Lower the source container below the height of the valve set between the load cell
and the display. Bags can be lowered directly into the waste container.

5. Repeat the previous steps for each source container.

6. Press the tabs on the ends of the valve set, then lift to remove it.

Removing the valve set

NOTE: The appearance of the valve set may differ from the example shown above.
7. Turn the pump rotor counterclockwise while removing the outlet tube from the pump.
8. Remove the calibration bag.
a. Remove the bag’s fill port from the load cell’s fill port holder.
b. Remove the bag from the load cell.
9. Discard the valve set and the attached calibration bag into the waste container.
10. Discard the inlets, spikes and Ingredient source container(s) per the facility protocol.

Tip! Baxter recommends cleaning the compounder before installing a new valve set.
Refer to Cleaning the Compounder on Page 93, and follow your facility’s protocol.
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MAINTAINING THE COMPOUNDER

To keep the compounder in the best possible condition, perform these routine maintenance
tasks daily:

e Calibrate the load cell

e Change the tube set

e (Clean the compounder

e Calibrate the compounder

e Shut down and start up the compounder

And perform these tasks regularly:
e Back up and compact the database (Baxter recommends Weekly)
e (Clean the rotor (Baxter recommends Monthly)

CALIBRATING THE LOAD CELL

This procedure is usually performed as part of the daily setup.
For instructions, refer to Calibrating the Load Cell on Page 35.

CHANGING THE TUBE SET

This procedure is usually performed as part of the daily setup.
For instructions, refer to Changing the Tube Set on Page 40.

CLEANING THE COMPOUNDER

Clean the compounder when indicated by your facility’s protocol. Use only these approved
materials:

e Non-abrasive cloth

e Soap and water

e 70% isopropyl alcohol or another self-drying disinfectant
Tip! Baxter recommends cleaning the compounder daily or whenever you change the tube set,
or whenever there is a spill.
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CAUTION

Cleaning is required to ensure that the compounder operates as intended. Failure to
clean the compounder can impair its operation.

Do not immerse the compounder in liquid or use sodium hypochlorite solutions (for
example, Clorox®).

Disassembling the compounder beyond what is needed for cleaning as described in
A this procedure voids the manufacturer’'s warranty.
Power off the device during routine cleaning.
Using the support legs will reduce the possibility of pinching your hands when you
connect/disconnect the cord and cables while cleaning.

To avoid pinching your fingers while cleaning, grasp the pump rotor from the top and
rotate it counterclockwise, keeping your fingers away from other surfaces while
moving the rotor.

1. Shut down and turn off the compounder. Refer to Rebooting and Shutting Down on
Page 32.

2. If the tube set is installed, remove and discard it. Refer to Removing the Expired Tube
Set and Expired Ingredients on Page 92.

3. Open the pump door.

4. Remove and retain the thumbscrew and washer used to attach the rotor.
NOTE: The rotor should be cleaned at least monthly, or when there are visible signs of
contaminants.

Removing the thumbscrew

5. Remove the pump rotor from the spindle.

Removing the pump rotor
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6. Using the approved materials, clean the:
e Pump rotor, making sure that the rollers spin freely. If rollers are not spinning
freely, contact Baxter Technical Support.
e Pump rotor area
e Channels near the pump rotor area
7. |Install the:
e Pump rotor, aligning the notch on bottom of the rotor with the pin on the spindle
e Washer and thumbscrew
8. Close the pump door.
9. Using the approved materials, clean the:
e Valve actuators
e Surface of the main module
e Load cell
e Poles and holders on the vial rack

CALIBRATING THE COMPOUNDER

This procedure is usually performed as part of the daily setup. For instructions, refer to
Calibrating the Compounder on Page 65.

SHUTTING DOWN AND STARTING UP THE COMPOUNDER

Tip! Baxter recommends fully shutting down and starting up the compounder once a day, to
allow the software to perform routine database maintenance at startup.

For instructions, refer to Starting Up, Logging In and Out, and Shutting Down on Page 30.

BACKING UP AND COMPACTING THE DATABASE

The compounder’s database accumulates data related to solutions, formulas and logs. For
example, the software records important device activity in a Blackbox log, which Baxter can
access through the Blackbox Report when needed. The compounder stores this data for a
specified time period. To set up the storage options, refer to Storage on Page 104.

When you shut down the software, the compounder automatically backs up the database. If
required during troubleshooting, you can use the backup data to restore the software settings
to an earlier state. When you start up the software, it notifies you if more than seven days have
passed since the last backup occurred. In this situation, perform a manual backup.

Tip! Baxter recommends performing a manual backup at least once a week or after changing
the system settings.

You can also compact the database to reduce its space on the hard drive and keep the
compounder operating efficiently. To set up the compaction options, refer to Database

Compaction on Page 106.
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Backing Up the Entire Database
This procedure backs up the entire database, including the Blackbox log.

1. Atthe menu screen, tap Tools > Database > Backup All.
2. Atthe Backup Database Location window:
a. If desired, change the location of the backup by tapping the button to the right of
the current location (not recommended).
b. If you want to:

e Replace all the previous backup files to save space, select the Overwrite
Existing File? check box.

o Keep the previous backup files, clear the Overwrite Existing File? check box.
c. Tap OK.

Backup Database Location

Database File Name

‘:’1 /EM/em2400bak2021-10-04-16-57-27.db ‘ [..])

Overwrite Existing File?

[ oK ] [ Cancel ]

Backup Database Location window

3. Atthe Backup succeeded message, tap OK.

Backup succeeded: file is /EM/
em2400bak2021-10-04-16-57-27.db.
o)

Message

-
h

Backing Up the Blackbox Log
This procedure backs up only the Blackbox log.

1. Atthe menu screen, tap Tools > Database > Backup Blackbox.
2. Atthe Backup Blackbox Location window:
a. If desired, change the location of the backup by tapping the button to the right of
the current location (not recommended).
b. If you want to:
e Replace all the previous backup files to save space, select the Overwrite
Existing File? check box.

e Keep the previous backup files, clear the Overwrite Existing File? check box.
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c. Tap OK.

Backup Blackbox Location

Blackbox File Name

‘EJ [EM/blackboxbak2021-10-04-16-56-48.db ‘ I

[ ]Overwrite Existing File?

{ OK ] { Cancel ]

Backup Blackbox Location window

3. Atthe Backup succeeded message, tap OK.

Backup succeeded: file is /EM/
em2400bak2021-10-04-16-57-27.db.

Message

-

Compacting the Database

1. Atthe menu screen, tap Tools > Database > Maintenance.
2. Atthe Do Database Maintenance? message, tap OK.

. @ y Do Database Maintenance?

[ OK ] [ Cancel ]

Message
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PERFORMING ADVANCED TASKS

Perform these tasks only when directed by Baxter Technical Support.

CHANGING THE UNIVERSAL INGREDIENT

IMPORTANT! This function requires Change Universal Ingredient permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To change the Universal Ingredient for the most recently used configuration when you are not
in the process of compounding a solution, do the following procedure. To change the volume
used for flushing after a Ul change, refer to Flush Between Ul Changes on Page 107.

If you are prompted to change the volume of the Ul during the compounding process, refer to
Formula Conflict on Page 198.

1. Atthe menu screen, tap Tools > Change Universal Ingredient.

Change Universal Ingredient
Direct Entry

Options

Users COMPOUND

Database

System Settings

):ftware Update

IFCIONES RYEIRIGIRGIRS CIREINE

Menu screen, Tools menu

A Change Universal window appears. It lists any ingredients that are available in the
current configuration and have been specified as Universal Ingredients in the
Formulary Editor. To specify the Universal Ingredients, refer to Using the Formulary
Editor on Page 138.

Operator Manual ExactaMix Pro 2400 Compounder

Page 98 0719003109 Rev. A, Effective Jan 2022



Performing Advanced Tasks

2. Atthe Change Universal window:

a. Select the Universal Ingredient you want to use.
b. Tap OK.

Change Universal

Replace current universal ingredient, Sterile Water for In , with 30 ml of...

() Dextrose 70%

§ [ OK ] [ Cancel ]

Change Universal window

The compounder requires a flush of the new Universal Ingredient to clear the old
Universal Ingredient from the common fluid pathway.

w

Attach a calibration bag. Refer to Attaching the Calibration Bag on Page 68.
At the Flushing with Universal Ingredient message, tap OK.

Flushing with Universal ingredient.
Please attach a flush/calibration bag.

Message

The pump screen shows an animation of the flush.

5. When the Completed flushing message appears, remove the calibration bag. Refer to
Removing the Calibration Bag on Page 69.

6. If you will continue with compounding a solution, attach a patient bag. Refer to

Attaching the Patient Bag on Page 71.
7. Atthe Completed flushing message, tap OK.

Completed flushing - remove flush/calibration bag
and attach original bag.

Message
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CHANGING THE INGREDIENT REMAINDERS

For each ingredient, the compounder tracks the volume that is used and the volume that
remains in the source container (the remainder). If necessary, you can manually change each
remainder shown in the software.

WARNING

The remainder value in the software must accurately represent the actual volume

A remaining in the source container. Change a remainder value only when you know the
precise amount remaining in the source container. Incorrect remainder values can
lead to bubbles, occlusions and under-delivery of an ingredient if its source container
runs empty.

IMPORTANT! This function requires Compounder permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

1. Atthe menu screen, tap Compound > Edit Source Remainders.
2. Atthe Edit Source Remainders window:
a. Forthe desired ingredient, change the Remainder to correspond to the volume
remaining in the container.

NOTE: You can tap Reset to change the remainder to its default value, or tap
Reset All to change all the remainders to their default values at the same time.

Tip! Baxter does not recommend using Reset All unless the entire list of
ingredients has been changed.

b. Tap OK.

Edit Source Remainders

Ports: 1,4, 5,6, 7, 8,9, 10, 11, 14, 19, 20, 21, 23, 24

1 Clinolipid 20% 1000 940.00 Reset

4 Infuvite Adult 100 94.00 Reset

5 NaPhosphate3mMol/mL PO4 15 9.00 [ Reset )
6 K Phosphate 3mMol/mL PO4 15 9.00 Reset

7 Na Acetate 2mEg/mL 100 94.00 [ Reset ]
8 K Acetate 2mEg/mL 50 44.00 [ Reset ]
9 Na Chloride 4mEg/mL 100 94.00 Reset

10 K Chloride 2mEg/mL 250 244.00 | Reset )|
11 Clinisol 15% 2000 1940.00 Reset

14 Multitrace-5 Concentrate 10 4.00 ( Reset )|
19  Ca Gluconate 0.465mEg/mL 100 94.00 Reset

20  Magnesium Sulfate 4.06mEq 20 14.00 [ Reset ]
21 Dextrose 70% 2000 1940.00 | Reset )|
23 Sterile Water for In 1000 820.00 Reset

24  Sterile Water for In 2000 1890.00 [ Reset ]

[ Resetal )| oK ) cance )
Edit Source Remainders window
Operator Manual ExactaMix Pro 2400 Compounder

Page 100 0719003109 Rev. A, Effective Jan 2022



Setting Up the Options

SETTING UP THE OPTIONS

IMPORTANT! These functions require Administration permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

NOTE: At any tab of the Options window:

e Tapping OK saves the changes made on all the tabs and requires you to exit the

software.

e Tapping Cancel closes the window without saving any changes.

SETTING UP THE SYSTEM OPTIONS

Use the System tab to set up the general system options.

To access the system options, tap Tools > Options at the menu screen.

At the Options window, the System tab is selected.

[ System Cont.]{Security][DirectoriesJ [ OEM J[OEM Only][OEM Only (Cont.)
rMixCheck Report rLogging Demo
Use Online MixCheck Report [ ]Log All ( )OFF) Demo Mode
Enable Auto Display [ ]Comm O‘-Wrap Factor
Enable Auto Print [_]verbose Comm i
[ ]sequencer Pump Skew 1.05
rAuthorization Report— rMixCheck Data Export— “Load Cell
@ N . .
(@) Auto Fill 1( (OOFF)Enable (@@ Use Load Cell
. SN
~Tube Set Expiration @@ ) Check For Empty Bag

(@) Max Duration to Use Tube Set (Hours) Min Empty Weight (g) ‘18-00 ‘

H > B Max Empty Weight (g) |145.00 |

rTrack Product Expiration Date and LotNumber— Storage
(® Use previous Values, No Confirm Solution Storage (Days) . T
QUse previous Values, Confirm Foltnitlhr Sl i DR - +
(O Require Entry Log Storage (Days) - +

Authorization Report Storage (Days) - 45 I’
[ oK ] [ Cancel ]

Options window, System tab
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MixCheck Report

The MixCheck Report is available after compounding is finished. For more information about
the contents of this report, refer to MixCheck Report on Page 160.

[ System Cont. J[SecurityJ[Directories] [ OEM J[OEM OnlyJ[OEM Only (Cont.):
rMiXCheck REROIt T e s s s e e e nnnns rLogging Demo
lgse Online MixCheck Report [ ILog All ( ) OFF) Demo Mode
[v]Enable Auto Display | |Comm

Q} Wrap Factor

asssmmnmn?®

[%rjable Auto Print L %\S/Z;?stnecg:mm Prump Skew 1.05
rAuthorization Report— rMixCheck Data Export—) | -~

.IAuto Fill §‘ ‘.E Enable m Use Load Cell
~Tube Set Expiration ChE‘Ck For Empty Bag

"Max Duration to Use Tube Set (Hours) Min Empty Weight (g) ‘18.00 ‘

- 20 I’ MaxEmptyWeight(g}‘MS.OO ‘

rTrack Product Expiration Date and LotNumber— [Sterage
‘.m (®Use previous Values, No Confirm Solution Storage (Days) - +
(OUse previous Values, Confirm Pt e e - +
(ORequire Entry Log Storage (Days) - +

Authorization Report Storage (Days) - 45 I’

[ OK ] [ Cancel ]

Options window, System tab

Enable Auto-Print is enabled by default. Ensure one or both of the options Enable Auto-Display

and Enable Auto-Print are selected; otherwise, an error message results. Use Online MixCheck
Authorization is optional.

Select Use Online MixCheck Authorization if you want to require a qualified user to log
in with a password to approve each MixCheck Report on the screen. For details, refer to
Using Online MixCheck Authorization on Page 160.

Select Enable Auto-Display if you want the MixCheck Report to appear automatically on
the display after compounding is finished.

Select Enable Auto-Print if you want the MixCheck Report to print automatically after
compounding is finished.

Authorization Report

The Authorization Report is available after the Setup Wizard is finished, or from the Reports

menu. For more information about the contents of this report, refer to Authorization Report on
Page 165.

Select Auto Fill if you want to make the Assembled and Verified columns of the report
populate automatically with the name of the person who logged in to perform the task.
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Load Cell

IMPORTANT! Baxter does not recommend changing these settings. Before changing any of
these settings, contact Baxter Technical Support. Refer to Getting Help on Page 20.

Select Use load cell if you want to use the compounder’s scale. This box should always be
selected, except if the load cell is not functional and an external scale is available. If you select
this check box, the following options become available.

Select Check for empty bag if you want to make the load cell check for the absence of a bag or
the presence of a non-empty bag. If you select this check box, numbers appear in both of these
fields:

e For Min Empty Weight, enter the minimum expected weight of an empty bag. If the
load cell measures a weight less than this number at the start of compounding, a
warning message indicates that a bag may not be attached to the load cell.

e For Max Empty Weight, enter the maximum expected weight of an empty bag. If the
load cell measures a weight greater than this number at the start of compounding, a
warning message indicates that the bag on the load cell may not be empty.

Tip! Baxter recommends selecting Check for empty bag.

Track Product Expiration Date and Lot Number

Select Enabled if you want to track the expiration date and lot number for every source
container that is attached to the compounder. If you select this check box, these options
become available:

e Select Use Previous Values, No Confirm if you want the compounder to use the
previous date and lot number without requiring confirmation.

e Select Use Previous Values, Confirm if you want the compounder to use the previous
date and lot number but require confirmation.

e Select Require Entry if you want the user to enter values each time a new container is
attached.

Logging
IMPORTANT! Baxter does not recommend changing these settings.

Regardless of the Logging settings, the compounder stores records in a Blackbox log. For
information about viewing the contents of this log, refer to Blackbox Report on Page 179.

In most cases, it is not necessary to change the Logging settings. Selecting any of these check
boxes may cause the log to grow to a size that slows the performance of the software.
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Demo

Demo mode uses a “virtual compounder” to simulate the compounder’s operation. It can be
used during training.

Select Demo mode if you want to enable demo mode. If you select this check box, these
options become available:

e Select Warp factor if you want to make the virtual compounder perform compounding
operations faster than normal.

e For Pump Skew, enter a number. Entering a number other than 1.05 forces the virtual
compounder to pump inaccurately, for training purposes.

NOTE: Operating in demo mode affects the ingredient remainders.

Tip! Do not use demo mode with ingredients attached.

Storage

The storage fields set the number of days that the database stores solution, formula and log
(Blackbox) information. Information older than the specified storage period is purged when the
software starts up.

You can increase or decrease these settings:
e For Solution Storage (Days), enter the number of days that used formulas are available
in the database.

e For Formula Storage (Days), enter the number of days that unused formulas are
available in the database.

e For Log Storage (Days), enter the number of days that Blackbox information is available
in the database.

e For Authorization Report Storage (Days), enter the number of days that authorization
data is available in the database.

The minimum duration available for the above-mentioned storages are 30 days and maximum
are 15 months. By default, all the above storage days are set to 45 days.
MixCheck Data Export

Select Enable if you want the compounder to export data directly to the Baxter DoseEdge®
Pharmacy Workflow Manager.

For this feature, the DoseEdge system must be specified as the printer. For assistance with
setting up printers, contact Baxter Technical Support. Refer to Getting Help on Page 20.
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[ System Cont.][Security}[Directories} [ OEM J[OEM OnIyJ[OEM Only (Cont.)]
rMixCheck Report rLogging Demo

Use Online MixCheck Report [ |Log All Demo Mode

Enable Auto Display __|Comm O_-Wrap Factor

Enable Auto Print es=lasluaie [ ]Verbose Comm '

“‘ﬂ‘ e, X DSequencer Pump Skew 1.05
rAuthorization Report Mi)gc’heck Data Export— -ch;'ad Cell
N . " =
@) Auto Fill W( (9OFF) Enable @Use Load Cell
’V, ‘¢’ N

rTube Set Expiration ‘e oot mCheck For Empty Bag

£
ay .
LT T L LA

(@) Max Duration to Use Tube Set (Hours) Min Empty Weight (g) ‘18-00 ‘

H » A Max Empty Weight (g) |145.00 |

rTrack Product Expiration Date and LotNumber— Storage
@Use previous Values, No Confirm Solution Storage (Days) _ +
(O Use previous Values, Confirm FEl T e RS - +
O Require Entry Log Storage (Days) - +

Authorization Report Storage (Days) - 45 I’
[ OK ] [ Cancel ]

Options window, System tab

Tube Set Expiration

IMPORTANT! Before changing any of these settings, contact Baxter Technical Support. Refer to
Getting Help on Page 20.

Select Enable if you want the compounder to display a message when the tube set has been
used longer than recommended.

For Max Hours to Use Tube Set, enter the maximum number of hours that the tube set should
be used.

Tip! Baxter recommends entering 20 for the Max Hours to Use Tube Set, so that the tube set
expires shortly before (instead of shortly after) the previous daily setup.
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SETTING UP THE SYSTEM (CONTINUED) OPTIONS

The System Cont. tab is a continuation of the System tab.
To access the continued system options:

1. Atthe menu screen, tap Tools > Options.
2. Atthe Options window, tap the System Cont. tab.

[system [ rulaind Security | Directories | [ OEM | OEM Only | OEM Only (Cont.)

rDatabase Compaction r Acceptable Weight Variance (%)
Compact DB Final Solution - 5.0
Compact After (Days) - 10 Individual Ingredient - 5.0
rManual Add rFlush Between Ul Changes
Max manual add volume ‘50.00 ‘
Volume (mL) ‘30.00 ‘
[/]Alert solution contains manual addition

rReport Printer

IMicrosoft Print to PDF v |

rMixCheck Signature Label
‘Authorized by:

rAuthorization Report Signature Label

"Assembled by: Date: Time:
Assembled by: Date: Time:
Checked by: Date: Time:

[ OK ] [ Cancel ]

Options window, System Cont. tab

Database Compaction
IMPORTANT! Do not change these settings unless directed by Baxter Technical Support.

Select Compact DB if you want to make the compounder compact the database at startup.

Acceptable Weight Variances (%)

For Final Solution, enter the maximum acceptable difference between the expected and actual
weight of the compounded solution. If any compounded solution has a weight outside this
range, an alarm beeps and a message displays the results in red. The results also appear on the
MixCheck Report.

For Individual Ingredient, enter the maximum acceptable difference between the expected and
actual weight of each delivered ingredient. If any delivered ingredient has a weight outside this
range, a message appears. The compounder weighs only ingredient deliveries of 100 mL or
more.

Tip! Baxter recommends entering 5% for the Final Solution and 5% for the Individual
Ingredient.
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Manual Add

For Max manual add volume, enter the maximum volume allowed for a manual addition. If the
volume of the formula ingredient exceeds this amount, a message appears, with options to add
the ingredient manually or cancel compounding.

Flush Between Ul Changes

For Volume (mL), enter the final flush volume used to clear the common fluid pathway after
changing the Universal Ingredient.

NOTE: A Ul flush contains three deliveries with standard volumes of 50, 50 and 30 mL. Changing
the Volume setting changes only the last of the three deliveries.
Report Printer

Select the printer used for printing reports.

MixCheck Data Export Printer

Select the printer used when sending MixCheck data to the DoseEdge system. If MixCheck Data
Export option (System tab) is enabled, the application will display MixCheck Data Export
Printer in the System Cont. tab.

[system |k egud Security | Directories | [ OEM | OEM Only | OEM Only (Cont.) ]

rDatabase Compaction r Acceptable Weight Variance (%)———
Compact DB Final Solution - 5.0
Compact After (Days) - 10000 Individual Ingredient - 5.0
rManual Add rFlush Between Ul Changes

Max manual add vqume‘S0.00 ‘ Vol ( L)‘BO 00 ‘
olume (m .

[7]Alert solution contains manual addition

rReport Printer rMixCheck Data Export Printer

‘ M ‘ M

| HP_LaserJet_P2035

rMixCheck Signature Label
|Authorized by:

rAuthaorization Report Signature Label

Assembled by: Date: Time:
Assembled by: Date: Time:
Checked by: Date: Time:

[ OK ] [ Cancel ]

Options window, System Cont. tab

MixCheck Signature Label
Enter text that you want to include at the bottom of the MixCheck Report.

Authorization Report Signature Label

Enter text that you want to include about required signatures in the Authorization Report.
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SETTING UP THE SECURITY OPTIONS

Use the Security tab to set the security features according to your facility’s protocol.
To access the security options:

1. Atthe menu screen, tap Tools > Options.
2. Atthe Options window, tap the Security tab.

( System J[ System Cont. Jm

( OEM | OEM Only | OEM Only (Cont.) |

rAuto-Logout rBar Code Reader
Use Auto-Logout Enable bar code reader

S L
e i e | - + [v]User bar code verification

Require bar code to initiate compounding

rPassword Expiration

Use Password expiration

rCosignature

[_]Required for Configuration Verification

Days password Valid [ |Required for MixCheck Authorization

-Order Entry Serial number rSolution Limit
Serial Number length - 36 L'm't formula runs
(XXXXXXX-Order ID) max: [l L

[ oK ] [ Cancel ]

Options window, Security tab

Auto-Logout

Select Use Auto-Logout if you want the current user to be logged out automatically after a
period of inactivity.

For Minutes to Auto-Logout, enter the number of minutes after which the user is logged out.

Tip! Baxter recommends entering 1015 for the Minutes to Auto-Logout.

Password Expiration

Select Use password expiration to place an expiration date on each password, if your facility’s
protocol requires that user passwords must be changed on a regular basis.

NOTE: By default, the Use password expiration checkbox is checked.
For Days password valid, enter the number of days after which the password expires.

Tip! Baxter recommends entering 90 (or the number specified by your facility’s protocol) for the
Days password valid.
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Order Entry Serial Number

For Serial number length, enter the maximum number of characters allowed in the serial
number for a formula file.

NOTE: If the Order Entry Serial Number is more than 36 characters, part of it may be truncated
in the reports.

Barcode Reader

Select Enable barcode reader to allow the use of a barcode reader for scanning labels during
verification of the setup and for loading formulas. If you select this check box, these options
become available:

e Select Use barcode verification if you want to require the use of a barcode reader for
scanning labels during verification of the setup.

e Select Require barcode to initiate compounding if you want to require the use of a
barcode reader for loading formulas. If this box is selected, the user cannot manually
select a saved formula.

WARNING
A It is important to use a barcode reader for scanning labels during verification of the
setup and for loading formulas.

NOTE: Compounder supports both 1D and 2D GS1 barcode formats.

Cosignature

Select Required for Configuration Verification if you want to require a second user to log in
and verify the configuration. If this option is not selected, the same user can set up and verify
the configuration.

Tip! Baxter strongly recommends requiring a co-signature.

Select Required for MixCheck Authorization if you want to require a second user to log in and
verify the MixCheck Report on the screen after compounding.

Solution Limit

Select Limit formula runs if you want to limit the number of times a specific formula can be
used for compounding.

For Max, enter the maximum of times an individual formula can be used.

Tip! Baxter recommends entering 1 for the Max.
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SETTING UP THE DIRECTORIES OPTIONS

Use the Directories tab to set the locations of formula files and backups.
To access the directories options:

1. Atthe menu screen, tap Tools > Options.
2. Atthe Options window, tap the Directories tab.

[SystemJ[ System Cont.J{Security] [ OEM ][OEM OnIyJ[OEM Only (Cont.)
rFormula Search

Formula Files
| | Browse )
rReports
Report Directory |Standard Report (Letter paper size) v
rBackups
‘ Browse |

{ Reset Directories ]

[ OK ] { Cancel ]

Options window, Directories tab

3. If you want to allow users to retrieve formula files, select Formula Search.

IMPORTANT! After initial installation, you should not need to change the locations of
the directories. Do not tap Reset Directories unless directed by Baxter Technical
Support. This button changes the locations of the directories from their current
settings.

4. If you want to change the locations of the directories:
a. Tap Browse for Formula Files or Backups.
b. Select the location of the directory.
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VIEWING THE OEM OPTIONS

You cannot edit the information on this tab; however, you may need to view it if directed by

Baxter Technical Support.
To access the OEM options:

1. Atthe menu screen, tap Tools > Options.
2. Atthe Options window, tap the OEM tab.

[ System J[ System Cont. ][ Security }[ Directories ]
Pump

I oeM only | 0EM only (cont.)

Calibration factor: 0.98
Pumped Through Tube Set (L): 1.44

Time of Last Tube Set Change: 9/2/2021 6:36:17 pm

Scale

Offset Calibration: 1052662057.80

Span Calibration: 1769877023.60

[ OK ] [ Cancel ]

Options window, OEM tab
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SYSTEM SETTINGS

IMPORTANT! Access to these functions requires Administration permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To access system settings

1. Atthe main menu, tap Tools > System Settings
2. Inthe left window pane, select a setting option of choice and the right window pane
will display the corresponding information and editable options.

Change Universal Ingredient

Direct Entry

Options

Users

COMPOUND
Database

System Settings

)%ftware Update

Fee LS BIEIPAOIRSTRS HELP

Close

Tools options, Menu screen
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DISPLAY

Brightness:

The brightness of the display can be dimmed or brightened by adjusting the slider left or right

between 0% and 100%.
Sleep Mode:

Sleep mode can be used to turn off the device after a period of inactivity. To adjust the
inactivity period, tap the drop-down menu arrow and select a desired time or Never if you do
not want the display to turn off due to inactivity.

System Settings

Display

Device Information
Date & Time
Language
Ethernet

Wi-Fi

Firewall Settings

Printer Management

Brightness:
21%

st Tt

Sleep Mode:

Turn off device when inactive for:

Close

Operator Manual
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DEVICE INFORMATION

Device information provides information about the ExactaMix Pro display that can be helpful

during service.

System Settings

Display

Device Information
Date & Time
Language
Ethernet

Wi-Fi

Firewall Settings

Printer Management

Device Type:

Software Version:

Software Build Number:

Display Serial Number:

Display Manufacturing Date:
Board ID:

PCBA Revision:

PCBA Serial Number:

Device IP Address:

Device Mac Address:

Device Hostname:

Real Time Clock Battery Voltage:
Device Certificate Validity Status:
Wi-Fi Certificate Availability:
Printer Availability:

Close

EM2400

0.9.0
0.9.0.20210914034434
EB1041

16/09/2021

EB1.5
EMIX-2400-2021-021

00:04:f3:bc:75:34
ccimx6qgpsbc-761a30

3.02v [Prescribed 2.7v to 3.3v]
Not Enrolled

Not Available

Available

DATE & TIME

Device Information screen

IMPORTANT! These functions require System Settings permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120.

To change the date and time, select the Edit button on the System Settings screen. From this
screen you can set time and date manually by entering the desired time or date in the fields, or
use automatic time settings.
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System Settings

Display Current Date & Time: 10/4/2021, 4:32:49 PM
Device Information Current Time Zone: (UTC) Coordinated Universal Time
Date & Time Daylight Save: Off
Language Auto Date & Time: Off
Ethernet
Edit
Wir

Firewall Settings

Printer Management

Close

Date & Time screen

Turning on automatic date and time

1. Connect the ExactaMix Pro display to an internet source.

Tap the toggle button so that it reads ON.

Enter an NTP Server URL into the box next to NPT Server URL.
Tap OK.

Date and Time Settings

Automatic Date & Time (requires Internet)

NTP Server URL

P WN

Current Date ‘10/6/2021 ‘(M/d/yyyy)
Current Time ‘6:23:44 PM ‘(h:mm:ss AP)
Region ‘(UTC) Coordinated Universal Time v

[]Adjust for daylight saving
[ OK ] [ Cancel ]

Date and Time Settings screen

Changing region

1. Tap the drop-down arrow in the box next to Region.
2. Select the desired region from the list.
3. Tap OK.
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Turning on daylight savings time

4. After setting the time, check the box next to Adjust for daylight saving if the
compounder is located in a region where Daylight Savings Time is observed.
5. Tap OK.

Date and Time Settings

(' )OFF) Automatic Date & Time (requires Internet)

NTP Server URL

Current Date 10/6/2021 (M/d/yyyy)
Current Time 6:23:44 PM (h:mm:ss AP)
Region (UTC) Coordinated Universal Time v

| ]Adjust for daylight saving
[ OK ] [ Cancel ]

Date and Time Settings screen

LANGUAGE

IMPORTANT! Access to these functions requires System Settings permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To view/edit language settings, click the Language tab on the System Settings screen.

System Settings

Display Current Language: English
Device Information Format Preview:

Date & Time Date: 10/6/2021
Language Time: 6:23:50 PM
Ethernet Number: 9999.99

Wi-Fi

Firewall Settings

Printer Management

Close

Language screen
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ETHERNET

IMPORTANT! Access to these functions requires Network Configuration permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120,

To view/edit ethernet settings, click the Ethernet tab on the System Settings screen.

System Settings

Display @‘ Ethernet
Device Information IP:

Date & Time Subnet:
Language Gateway:
Ethernet DNS:

Wi-Fi

Firewall Settings

Printer Management

Close

Ethernet screen

WI-FI

IMPORTANT! Access to these functions requires Network Configuration permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To view/edit wi-fi settings click the Wi-Fi tab on the System Settings screen. Select the desired
available network and connect to it.

System Settings

Display @) WiFi

e e e
Date & Time . BaxMobility

Language ® 1074997668

Ethernet

Wi-Fi

Firewall Settings

Printer Management

Connect | Add Network l

Wi-Fi Screen
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FIREWALL SETTINGS

IMPORTANT! Access to these functions requires Network Configuration permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To view/edit firewall settings click the Firewall Settings tab on the System Settings screen.

System Settings
990 tep

Device Information Enabled
Date & Time
Language

Ethernet

Wi-Fi

Firewall Settings
Printer Management

L Add ][ Edit ][ Remove ]

Close

Firewall Settings screen
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PRINTER MANAGEMENT

IMPORTANT! Access to these functions requires Network Configuration permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

To view/add/edit printer settings click the Printer Management tab on the System Settings
screen.

1. To add a printer, tap the Add Printer button.
2. To find printers on the network, tap the Find New Printers button.

3. To manage already added printers, tap the Manage Printers button.

System Settings
Display

Device Information
Date & Time .. .
Administration

Language
Ethernet .

o Printers
Wi-Fi
FlreWa” Settlngs Add Printer || Find New Printers Manage Printers
Printer Management Jobs

Manage |cbs

Close

Printer Management screen
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SETTING UP THE USERS

Each user must have an account so that the compounder can track activity. Users are assigned
to groups that have the appropriate permissions to perform the required tasks.

WORKING WITH GROUPS

Adding or Editing a Group
IMPORTANT! These functions require Administration permissions.

1. Atthe menu screen, tap Tools > Users > Edit Users and Groups.

Edit Users and Groups

rGroups

Pharmacy Admin
Pharmacist
Technician

IT Admin

Add

rUsers

Login Name

Edit Users and Groups window
2. Atthe Edit Users and Groups window, in the top half, do one of these options:
e Tap Add to add a group.
The Add Group window appears.
e Select the group you want to edit from the Name list, then tap Edit.
The Edit Group <name> window appears.
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Edit Group Pharmacy Admin

Group Name|Pharmacy Admin

Permissions

[v]Administration [v]Verification

[v]Formulary

Compounder

Edit Configuration Report

Formula Delete Network Settings

Direct Entry [ ]system Settings

Change Unviersal Ingredient

Save J [ Cancel ]

Edit Group <name> window

3. Atthe Add Group window or Edit Group <name> window, select the permissions for
the group.

IMPORTANT! These permissions will apply to an entire group of users. You cannot
assign unique permissions directly to a user; however, you can create a group that
contains only one user.

Permissions

Administration

Allowed Functions

Use Tools > Options

Use Tools > Users > Edit Users and Groups
Use the Inlet Editor

Use the Bag Inventory Editor

Add / Update Flow Factors

Update Date/Time

Restore Database & access device logs.

Baxter recommends
assigning to:
Pharmacy Admin and

IT Admin

Formulary

Use the Formulary Editor
Use the Ingredient Group Editor

Pharmacy Admin

Edit Configuration

Use the Configuration Editor

Pharmacy Admin

Direct Entry

Create and save direct-entry formulas

Pharmacy Admin,
Pharmacist and
Technician

Operator Manual
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Permissions Allowed Functions Baxter recommends
assigning to:
Formula Deletion Delete a formula Pharmacy Admin
Change Universal Change the Universal Ingredient without changing the Pharmacy Admin,
Ingredient configuration Pharmacist and
Technician
Verification e  Perform cosignhature authorization of the priming and | Pharmacy Admin and
verifying steps during setup Pharmacist

e  Perform authorization and cosignature authorization
of the MixCheck Reports

Compounder e (Calibrate the load cell Pharmacy Admin,
e  Select the configuration Pharmacist and
e Change the tube set Technician

e  Prime the inlets

e C(Calibrate the compounder
e Compound the solution

e  Edit the source remainders

Report e View reports Pharmacy Admin, IT
e Export reports Admin Pharmacist
e  Print reports (except MixCheck Report) and Technician
Network Settings e Authentication type (username/password OR Pharmacy Admin and
certificate based) IT Admin

e Username & Password to access server share

e Ethernet settings (enable/disable, automatic IP, static
IP & DNS)

e Wi-Fi settings (enable/disable, automatic IP, static IP
& DNS)

e Firewall settings (Allow/Reject ports, display
configured ports)

e Wi-Fi security protocol parameters & certificates
(WEP, WPA2, WPA2-Enterprise)

e  Configuration of paths for PAT/FRM files (Part of
Options)

e Select Print Report type

e  Export Report Location

e Database and logs Backup Location

Tip! Baxter recommends having a pharmacist perform the verification.

4. Tap Save.
5. Atthe Edit Users and Groups window, tap OK.
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Deleting a Group

IMPORTANT! This function requires Administration permissions.

1. Atthe menu screen, tap Tools > Users > Edit Users and Groups.
2. Atthe Edit Users and Groups window, in the top half:

a. Select the group you want to delete from the Name list.
b. Tap Delete.

3. Atthe Delete user group <name>? message, tap Yes to delete the group.

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message
4. At the Edit Users and Groups window, tap OK.

WORKING WITH USERS

Adding or Editing a User
IMPORTANT! These functions require Administration permissions.

1. Atthe menu screen, tap Tools > Users > Edit Users and Groups.
The Edit Users and Groups window appears.

Edit Users and Groups

rGroups

e _______|
Pharmacy Admin
Pharmacist
Technician

IT Admin

Add

rUsers

Login Name

Edit Users and Groups window
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2. Atthe Edit Users and Groups window:
a. Inthe top half, select the group from the Name list.
b. Inthe bottom half, do one of these options:
e Tap Add to add a user.

The Add User window appears.

Add User

Login Name: ‘ ‘

User Name: ‘ ‘

Group: Pharmacy Admin o]

[ Save ] [ Cancel ]

Add User window

e Select the user you want to edit from the Login Name list, then tap Edit.
The Edit User <name> window appears.

Edit User ADMIN

Login Name: [ADMIN |

User Name: ‘ADMIN \

Group: Pharmacy Admin 0]

[ Save ] [Reset Password] [ Cancel ]

Edit User <name> window

3. Atthe Add User window or Edit User <name> window:
a. Enter the Login Name.
b. Enter the User Name.

Tip! Baxter recommends using a short Login Name and full User Name.

c. Select the Group to which the user is assigned.
d. Tap Save.
4. Atthe Edit Users and Groups window, tap OK.

NOTE: The password will be the same as the Login Name until the user logs in and
changes the password. Baxter requires that new users change their passwords upon
their first login attempt.
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Operator Manual

Deleting a User
IMPORTANT! This function requires Administration permissions.

1. Atthe menu screen, tap Tools > Users > Edit Users and Groups.
2. Atthe Edit Users and Groups window:
a. Inthe top half, select the group from the Name list.
b. Inthe bottom half, select the user you want to delete from the Login Name list,
then tap Delete.
3. Atthe Delete user <name>? message, tap Yes to delete the user.

( @ ,  Delete user DEFAULT ?

{ Yes ] [ No ] { Cancel ] [ Yes to All ]

Message

4. At the Edit Users and Groups window, tap OK.
Changing a Password

1. Atthe menu screen, tap Tools > Users > Change Password.
2. Atthe Change Password window:
a. Enter the Old password.
b. Enter the new password.
c. Enter the new password again to confirm it.
d. Tap OK.
IMPORTANT! Passwords are case-sensitive.

Baxter requires that a new password shall be a minimum of 8 characters and a maximum of 40
characters. It shall contain at least 1 number, 1 alphabetic letter, and 1 special character. Also,
it shall not match any of the previous 5 passwords or any commonly used passwords.

Change Password

Username:
ADMIN

Old Password:

Enter New Password:

Verify New Password:

\ |
[ OK ] [ Cancel ]

Password Requirements:
* Minimum of 8 characters.
¢ Maximum of 40 characters.
« At least 1 alphabet character.
* At least 1 numeric character.
* At least 1 special character.
+ Shall not match any of the previous 5 passwords used.
+ Shouldn't be commonly used passwords (e.g. p@sswoOrd, etc.).

NOTE: Password is case sensitive.

| . 4

Change Password window
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Logging in as a Different User

1. Atthe menu screen, select Tools > Users > Change User.
2. Atthe Login window:
a. Enter a different Login name.
b. Enter the Password. (NOTE: Passwords are case-sensitive)

c. TapLogln.
Login |\ |
Password ‘ ‘
[ Login ] [ Cancel ]
Login window
Operator Manual ExactaMix Pro 2400 Compounder
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USING THE CONFIGURATION EDITOR

Use the Configuration Editor to manage the configurations.

IMPORTANT! These functions require Edit Configuration permissions. For more information
about user groups and permissions, refer to Setting Up the Users on Page 120. Before making
any changes in the Configuration Editor, contact Baxter Technical Support. Refer to Getting
Help on Page 20.

IMPORTANT! The Configuration Editor is to be used only to create and manage non-active
configurations. All changes to the Universal Ingredient of an active configuration must be made
through the Changing the Universal Ingredient functionality described on Page 98.

At the menu screen, tap Edit > Configuration Editor.

1
»F Configuration Editor

Formulary Editor

ENISE Ingredient Group Editor
Inlet Editor

Bag Inventory Editor

FOIONES REPORTS CIREAINE

Close

Menu screen, Edit menu
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The Edit Configurations window appears. It lists the available configurations and allows you to
add, edit or delete configurations.

Edit Configurations

Configuration
Sample
Manual Add
EM2400 DEMO

Edit Configurations window

ADDING OR EDITING A CONFIGURATION

WARNING

It is strongly recommended that a Baxter Technical representative review and
iji approve every new or edited configuration before it is placed into service.

Baxter Technical Support is available for reviewing and approving all new and
updated configurations. Refer to Getting Help on Page 20 for additional
instruction.
1. Atthe Edit Configurations window, do one of these options:
e Tap Add to add a configuration.

The Add Configuration window appears.

e Select the configuration you want to edit, then tap Edit.
The Edit Configuration <name> window appears.

e Select the configuration you want to copy and then tap Copy.
The Copy of <copied configuration name> window appears.

NOTE: You can use the Copy option to make minor edits to an existing configuration
and save it with a new name.
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Add Configuration

Name

Universal Ingredient

‘ .

Final Flush Volume

- 30.00 +

: olicloNoNoNoNoNoNoNoNoNo
{Auto-Addmons ] QQ?QQQQQQQQQ
o
[ Cancel

Add Configuration window

2. Enter the Name of the configuration.
3. Tapaport.

The Edit Port <number> window appears.

Prime Volume
(®Standard - 60.00mL (Recommended)

() Minimum- 30.00mL

Port: 11

Sequence: 9

rProduct

» Cardioplegic Sol |
» Chromic Cl 4mcg/mL

» CitratePhosphateDex

» Clindamycin

¥ Clinisol 15%

Baxter Clinisol 15% 500 Bag
» ClinOleic 20%
» Clinolipid 20%
» Cupric Sulfate 0.4mg/mL

r Flush With
NO FLUSH |Volume 0.00
[ OK ] [ Cancel ]
Edit Port <number> window
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4. At the Edit Port <number> window:
a. Select the Product to associate with the port.

NOTE: For a product to appear in the list, it must first be in the formulary and
active. Refer to Using the Formulary Editor on Page 138.

b. Select the Prime Volume. You can leave the standard volume that is
automatically selected, or select the minimum volume.

Tip! Baxter recommends using the standard prime volume to ensure that the
inlets are primed and any bubbles are removed.

NOTE: The prime volume is used during setup of the compounder. This volume
must be set for each product that is in each configuration. Auto-addition
ingredients are always primed with the standard volume.

c. If the selected product requires an ingredient flush after it is delivered, select the
flush ingredient in the Flush With list and set the flush volume in the Volume
field.

NOTE: For example, to force a flush when lipids are pumped in a 3-in-1 bag, set
the port with the appropriate flush ingredient and volume. Typically, the flush
ingredient is the Universal Ingredient, but it can be any ingredient in the
configuration and the formula. For an ingredient to appear in the Flush With list,
it must first be specified as an allowable Universal Ingredient in the formulary.
Refer to Using the Formulary Editor on Page 138.

d. Tap OK.

5. Repeat Steps 3 and 4 for all the ports you want to use.
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The configuration window now shows the product that is associated with each port. If
you requested an ingredient flush for a product, the ingredient button includes a red
downward arrow that represents the flush. If the ingredient is set to use the minimum
prime volume, the ingredient button includes the letter M.

Select Configuration

Name
NaAc2 Csoll5
‘EM24OO DEMO v |
3 9

Univel‘sal Ingredient Clinolip NaPhos3 NacCla

a
Sterile Water for In v 8 5 1

[l I I

1 3 5 7 9 11 13 15 17
Final Flush Volume . O . . . . O O O

20,00 ©C 000 O e O O
2 4 6 8 10 12 14 16 18
I I I
KPhos3 KCiz MTES5Conc
10 14
i ‘ “ ‘ ") "
6 2 v 10
InfuvA KAc2
e 8 |
[ Cancel My 4

Configuration window with products

6. At the configuration window:
a. Select the Universal Ingredient.

NOTE: For the Universal Ingredient to appear in the list, it must first be in the
configuration. Universal Ingredients must be assigned to ports 19-24; they
cannot be assigned to ports 1-18. A port specified for the Universal Ingredient is
labeled U. For commonly used ingredients such as the Universal Ingredient, you
can set up an electronic Y-site.

b. Enter the Final Flush Volume.

Tip! Each formula must include at least this volume of the Universal Ingredient.
Baxter recommends using at least 30 mL. The minimum is 25 mL.

c. If you want to specify ingredients for auto-addition, tap Auto-Additions.
Otherwise, skip to Step 8.
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A list of ingredients that are available for auto-addition appears on the right side
of the window.

NOTE: For the ingredient to be listed as available for auto-addition, it must first
be specified as an allowable auto-addition in the formulary. Refer to Using the
Formulary Editor on Page 138.

Add Configuration

Name
Universal Ingredient
Final Flush Volume

- 30.00 + [ ]Hep Na 100units/mL-NaCl

] [ JHeparin 1000 units/mL

Check ingredient name to allow as auto-addition

[ Return to Products

Selecting auto-additions

7. To select auto-additions:
a. Select the check box for each desired ingredient.
b. To select a specific product or add an ingredient flush for the selected ingredient,
tap Edit Selected.
c. When you are finished, tap Return to Products.

8. At the configuration window, tap Edit Sequence.
NOTE: This option is available only for existing configurations. If you do not edit the
sequence (pumping order), the compounder will use the sequence of the port
numbers (1, 2, 3 and so on).
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A sequential list of ingredients appears on the right side of the window.

Edit Configuration EM2400 DEMO

Name

‘EM24OU DEMO ‘

| T T

1 Na Chloride 4mEg/mL  False

Universal Ingredient

|Steri\e Water for In

Final Flush Volume

= 30.00 +

2 K Chloride 2mEqg/mL False
3 Na Acetate 2mEqg/mL False
4 K Acetate 2mEq/mL False

5 Na Phosphate3mMol/m... False

Ret to Product
[ eturn fo Froducts ] 6 K Phosphate 3mMol/m... False

LKl

7 Infuvite Adult False
8 Clinolipid 20% False
9 Clinisol 15% False

Editing the sequence

9. To edit the sequence:
a. Select an ingredient, then use the arrows to move it up or down in the sequence.
b. When you are finished, tap Return to Products.

10. At the configuration window, tap OK.
11. At the Edit Configurations window, tap Close.

WARNING
A A Baxter pharmacist must approve every new or edited configuration before it
is placed into service.

12. Print a Configuration Report for the new or edited configuration. Refer to
Configuration Report on Page 173.

CONFIGURATION GUIDANCE

There are two primary guiding requirements for port placement and ingredient sequencing in a
configuration:

1. To minimize or eliminate opportunities for chemical interaction between
concentrated ingredients
2. To maximize the efficiency of valve movement
In view of these requirements, there are certain ingredients that should never be placed on the
compounder, and as a result must be added as a “manual add”. These ingredients include:

e Iron-containing salts — highly reactive and will cause lipid emulsions to crack

e Insulin —adsorbs onto PVC tubing and causes unreliable drug delivery

e Albumin >10% — this is a harvested blood protein whose behavior within the
pumping system can be inconsistent due to the variant viscosity of the product.
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Every configuration requires a Universal Ingredient (Ul), which is the ingredient that is in the
common fluid path when pumping starts, and is the last ingredient pumped to clear the
common fluid path when a preparation is complete. Typically, the Ul is Sterile Water for
Injection (SWFI), although it may be other ingredients such as dextrose or amino acids
depending on the requirements of the order. The Ul must be mounted on ports 19 or greater;
preferably mounted on port 23 and/or 24. If not ports 23 or 24, the Ul must be mounted as far
back on the valve set as possible to ensure complete flushing of the entire valve set.

An Electronic Y-Site allows for the same ingredient to be mounted on more than one port and is
generally used with the high-volume base components, such as SWFI or Dextrose.

An Auto Addition (AutoAdd) defines those ingredients designated in the formulary that are
mounted only if and when they are needed.

The compounder does allow for unique customer applications. The standard configuration
below can be modified provided that the potential for chemical interactions is taken into
consideration and maximization of the efficiency of valve movement is achieved.

Not all ports must be used. Depending on the customer needs and the number of ingredients
to be used, ports may be omitted from the configuration. These are noted as “OPEN” in the
configuration table. It is recommended to position the omitted, unused ports between the
ingredient groups to allow for future additions to the configuration.

Example of a Standard Recommended Configuration

IsequencellPortll  ingredient  Jlcomment]

1 9 Sodium Chloride -

2 8 Potassium Chloride -

3 7 Sodium Acetate -

4 6 Potassium Acetate -

5 5 Sodium Phosphate -

6 4 Potassium Phosphate -

7 3 Multivitamins Pediatric -

8 2 Multivitamins Adult -

9 1 Lipids -

10 10 Amino-Acid AutoAdd
11 11 Amino-Acid -

12 12 OPEN -

13 13 Trace Elements Pediatric -

14 14 Trace Elements Adult -

15 15 Single Trace Element -

16 16 Single Trace Element -

17 17 Other TPN Drug -

18 18 Other TPN Drug -

19 21 Dextrose -

20 19 L-Cysteine -

21 20 Magnesium Sulfate -

22 23 | Sterile Water for Injection | Ul, Y site
23 24 | Sterile Water for Injection | Ul, Y site
24 22 Calcium Gluconate
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The following offers information to support the recommended sequencing and port placement
of the general categories of the standard recommended configuration.

Monovalent Salts:

Sodium chloride, potassium chloride, sodium acetate, potassium acetate, sodium phosphate,
and potassium phosphate are recommended to be sequenced first (1 through 6 in the above
example) and mounted on ports 4 through 10. Preferably the phosphate containing ingredients
are pumped after the other salts.

Fat Soluble Ingredients (multivitamins and lipids):

Multivitamins are generally mounted on ports 3 through 5 and sequenced directly after the
electrolytes.

Lipids are emulsions of oil and water, held in suspension by an anionic (negatively charged)
surfactant.

Acidic ingredients will not be sequenced directly after lipids. Lipids have a very low specific
gravity as compared to other ingredients. As lipids are “lighter” than other ingredients, they
have the potential to “migrate” along the common fluid path. Because of this potential, it is
recommended that lipids have a minimum of 4 ports separating the next sequenced ingredient.
Lipids are recommended to be sequenced prior to the Aminos and are mounted on ports < 4.

Amino Acids:

This is the first major flush. Amino acids, such as Travasol, Clinisol, Prosol and Premasol, are
generally one of the larger ingredient volumes in a TPN formula. These can be used to dilute
the other ingredients and minimize incompatibilities. It is recommended to sequence the Lipids
prior to the amino acids to assist with the dilution of the Lipids.

Multi Trace Elements:

Trace Elements, either a combination product such as Trace Elements-4 or Trace Elements-5, or
individual elements such as zinc, chromium, copper and selenium are sequenced and mounted
after the Amino Acids. The combination product, (Trace Elements-4 or Trace Elements-5), are
preferably mounted on ports 13 or 14 and sequenced 13 or 14. The individual elements (e.g.,
zinc, chromium, copper, selenium), are preferably mounted directly after the combination
products and before Other Drugs and Dextrose, preferably on ports 13 through 16 and
sequenced 13 through 16.

Other TPN Ingredients:

Include ingredients such as famotidine, ranitidine, heparin, and L-carnitine which are mounted
and sequenced after the Trace Elements.

Dextrose:

This is the second major flush. Dextrose is also one of the larger ingredient volumes in a TPN
formula. It is mounted next to or immediately before SWFI and sequenced after the Trace
Elements and Other Drugs to assure maximum dilution before Magnesium and Calcium
products are pumped. This will minimize the inherent physical incompatibilities.
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Divalent Salts - Magnesium:

Di-valent cations also affect the stability of lipids. Magnesium and calcium are the most
common of these found in a TPN formula. Magnesium should be mounted after the Trace
Elements and Other TPN Ingredients groupings and sequenced after Dextrose and before SWFI
to maximize dilution of the lipids.

Sterile Water for Injection (SWFI):

This is the final major flush. Sterile water for injection is used to calibrate the compounder.
Every configuration should require the presence of Sterile Water for Injection.

SWFI is mounted last and generally sequenced after the Magnesium products to maximize the
dilution of the solution and flush the valve set prior to the addition of the Calcium product (the
final ingredient).

Divalent Salts - Calcium:

The interaction of calcium and phosphorus to form insoluble calcium phosphate is the most
critical interaction to address. Calcium phosphate precipitates immediately in most aqueous
solutions. It is the buffering provided by the amino acids in a TPN that permit small quantities of
calcium and phosphorus to be mixed without forming a precipitate. The smaller the
concentrations of calcium and phosphorus at the time they are mixed, the less likely it is that a
precipitate will form. This condition occurs when Calcium is added last, with phosphate being
diluted as much as possible in the TPN. On the EM2400 TPN Compounder, the phosphate-
containing salts (sodium phosphate and potassium phosphate) are added early within the
electrolyte group, generally sequenced < 10 and on ports < 10. The calcium salts are added last
and mounted on port > 20, after the addition of amino acids; dextrose and water provide the
maximum dilution of the phosphate salt.

Exceptions:

L-cysteine and ascorbic acid are included in this group. However, these ingredients are highly
acidic and may react with other ingredients.

L-cysteine is highly acidic (very low pH 1.4) and affects the stability of lipids (“cracking”) as well
as having undesirable interactions with other TPN ingredients, such as:

e Folic acid — orange precipitate

e Cimetidine — cysteine-cimetidine complex green in color

e Copper — cysteine-copper complex green in color
Ascorbic acid reacts with copper and other heavy metals that are components of Trace
Elements resulting in the degradation of the Ascorbic acid. Therefore, L-cysteine and Ascorbic
acid are to be mounted at least 2 ports after the Trace Element group and sequenced directly
after the Dextrose and before Magnesium group.

Non-TPN Ingredients:

These ingredients include Anticoagulant Citrate Dextrose (ACD)/Citrate Phosphate Dextrose
(CPD), Tromethamine (THAM), sodium bicarbonate, mannitol, lidocaine, and bupivacaine.
These ingredients are not used in TPN but in the compounding of other non-TPN preparations.
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The recommended practice is to set up a separate software configuration to accommodate the
non-TPN use e.g., cardioplegia, Continuous veno-venous hemodialysis (CVVHD), epidurals. To

avoid the potential for error, these ingredients should not be included in any TPN configuration,
even as an Auto-Addition.

DELETING A CONFIGURATION

1. At the Edit Configurations window:

a. Select one or more configurations you want to delete.
b. Tap Delete.

2. Atthe Delete configuration <name>? message, tap:
e Yes to delete the configuration

e Yes to All to delete all configurations selected in the Edit Configurations window

NOTE: If only one configuration is selected, only one will be deleted.

‘ @ , Delete configuration Sample ?

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message

3. At the Edit Configurations window, tap Close.
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USING THE FORMULARY EDITOR

Use the Formulary Editor to manage the ingredients and products in the formulary.

IMPORTANT! These functions require Formulary permissions. For more information about user
groups and permissions, refer to Setting Up the Users on Page 120. Before making any changes
in the Formulary Editor, contact Baxter Technical Support. Refer to Getting Help on Page 20.

At the menu screen, tap Edit > Formulary Editor.

1
» Configuration Editor

Formulary Editor

RN E Ingredient Group Editor
Inlet Editor

Bag Inventory Editor

I OIONES REPORTS RHEIL[F

Close

Menu screen, Edit menu
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Using the Formulary Editor
The Formulary Editor window appears. The top list identifies the ingredients that can be

included in a formula. The bottom list identifies each Product Name, with its Drug ID, that can
be used for each ingredient type.

Tapping the Inlets button displays the Inlet Editor. For instructions on using this feature, refer
to Using the Inlet Editor on Page 149.

Formulary Editor
ringredient

Abbreviation I

Amino Acids 15%

Aminl5
Aminosyn 10% SF Aminl0
Aminosyn 8.5% Electro SF AmIi85ESF
Aminosyn 8.5% SF Amin85SF

[v]Show Available Ingredient

Add [ Show Cal. Ingredient ]

rProduct

Product Name

[ nlets. )| oK )

Formulary Editor window
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WORKING WITH INGREDIENTS

Adding or Editing an Ingredient
1. Atthe Formulary Editor window, in the top half, do one of these options:
e Tap Add to add an ingredient.
The Add Ingredient window appears.
e Select the ingredient you want to edit from the Name list, then tap Edit.
The Edit Ingredient <name> window appears.

Add Ingredient

Name l\ |
Abbr | ] Groups [<NoONE>
Spec Gr ‘1.000 l E::sl::;te

[ ]warn If Manual Addition
[|Can Be Used For Universal Ingredient
[ ]Auto - Addition

Ingredient Abbrevation

[ |Available Preview
[ =
I—
[ Save ] [ Cancel ]
Add Ingredient window

2. Atthe Add Ingredient window or Edit Ingredient <name> window:
a. Enter the Name.
b. Enter the Abbr (abbreviation).

NOTE: The information entered in the Abbr field will appear on the Ingredient
Abbreviation preview and in the ingredient button on the pump screen.

c. Enter the Spec Gr (specific gravity).
d. Inthe Groups list, select the group to which the ingredient belongs. For more
information, refer to Using the Ingredient Group Editor on Page 145.
e. If desired, select one or more of these check boxes:
e Warn If Manual Addition to make a message appear when a formula that
includes this ingredient is used, but this ingredient is not in the current
configuration

e Can be used for Universal Ingredient to allow this ingredient to be used as a
Universal Ingredient

e Auto-addition to allow this ingredient to be added for temporary use at an
open port
f. Tap Save.
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Deleting an Ingredient

1. Atthe Formulary Editor window, in the top half:
a. Select one or more ingredients you want to delete from the Name list.
b. Tap Delete.
2. Atthe Delete ingredient <name>? message, tap:
e Yes to delete the ingredient

e Yes to All to delete all ingredients selected in the Formulary Editor window

NOTE: If only one ingredient is selected, only one will be deleted.

, @ \ Delete ingredient Glucose 5%7?

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message

Viewing an Ingredient’s Usage Information

1. Atthe Formulary Editor window, in the top half:
a. Select the ingredient you want to view from the Name list.
b. Tap Contained In.

A message with the ingredient’s current usage appears, including:
e The groups to which the ingredient belongs
e The products that contain the ingredient

e The configurations and formulas that contain the ingredient
2. Atthe Information message, tap OK.

* Dextrose 70% belongs to no Ingredient Group.
» Dextrose 70% is contained in Products:
o Baxter Dextrose 70% 2000 Bag
o ICU Medical Dextrose 70% 2000 Bag
o ICU Medical Dextrose 70% 500 Bag
o B Braun Dextrose 70% 2000 Bag
» Dextrose 70% is contained in Configurations:
o EM2400 CONFIG.
= Copy of EM2400 CONFIG.
* Dextrose 70% is used by Formulas:
o JaneDoeManualAddition/DE 30Sep2021

195427
Message
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The Calibration Ingredient

The calibration ingredient is used for calibrating the compounder’s pump.

WARNING
A sterile water product is required as the calibration ingredient.

If you think the calibration ingredient needs to be changed, contact Baxter Technical Support.
Refer to Getting Help on Page 20.

Viewing the Calibration Ingredient

1. Atthe Formulary Editor window, in the top half, tap Show Cal. Ingredient.
The calibration ingredient is highlighted.
2. Tap OK.

WORKING WITH PRODUCTS

Adding or Editing a Product

1. Atthe Formulary Editor window:
a. Inthe top half, select the ingredient from the Name list.
b. Inthe bottom half, do one of these options:
e Tap Add to add a product.

The Add Product window appears.

e Select the product you want to edit from the Product Name list, then tap
Edit.

Manufacturer “ }

Ingredient Name Sterile Water for In

Inlet <

Container Size |0 mL

Barcode ID ‘Sterile woo ‘

Drug ID ‘ ‘

Max Hang Time |24.00 Hours

Container Type ()Bag

(O Bottle

(O syringe

YW
(Vial

(®)Other

Name ‘ Sterile Water for In 0 Other

Regenerate Name

)

(

Save

)(

Cancel

)

Add Product window

2. At the Add Product window or Edit Product <name> window:

a.

Operator Manual

Enter the product’s Manufacturer.
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= @

Operator Manual

NOTE: The Ingredient Name field populates automatically with the ingredient
name in the formulary. You cannot change this field.

WARNING

It is important to select the correct inlet type for the container. Selecting
the incorrect inlet type can lead to occlusions and incorrect volume
delivery, resulting in patient harm.

Select the appropriate Inlet for the container. For information about the available
inlet types, refer to Valve Sets on page 17.

Enter the Container Size.

Scan the barcode to enter the Barcode ID.

NOTE: For items that do not have a Barcode ID from the manufacturer, you can

enter the data manually.

Tip! Baxter recommends always using the barcode reader when possible.
WARNING
If a Drug ID is assigned to one product in the order-entry software, and
that number is assigned to a different product in the compounder’s
formulary, the compounder may pump the wrong ingredient. It is the
user’s responsibility to ensure that Drug ID numbers are properly and
consistently assigned in both systems.

Enter the Drug ID.

NOTE: The Drug ID is used to identify products uniquely. In the United States, the
Drug ID is usually the NDC.

Enter the Max Hang Time.

NOTE: This setting is the maximum amount of time the product can be attached
to the compounder. The compounder displays a message if the product remains
attached longer than the specified time.

Select the product’s Container Type.

If you want to change the Name, tap Regenerate Name or enter a new name.
NOTE: Based on the product information, the Name is generated automatically
for new products. This name is used when the product’s barcode is printed.

Tap Save.
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Deleting a Product

1. Atthe Formulary Editor window:
a. Inthe top half, select the ingredient from the Name list.
b. Inthe bottom half, select one or more products you want to delete from the
Product Name list, then tap Delete.
2. Atthe Delete product <name>? message, tap:
e Yes to delete the product from the ingredient

e Yes to All to delete all products selected in the Formulary Editor window
NOTE: If only one product is selected, only one will be deleted.

‘ @ ,  Delete product Baxter Glucose 5% 100 Bag?

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message

Viewing a Product’s Usage Information

1. Atthe Formulary Editor window:
a. Inthe top half, select the ingredient from the Name list.
b. Inthe bottom half, select the product you want to view from the Product Name
list, then tap Contained In.

A message with the product’s current usage appears, including:
e The configurations that contain the product
e The solutions that contain the product

2. Atthe Information message, tap OK.

Information

» Baxter Dextrose 70% 2000 Bag is contained in
Configurations:
o EM2400 CONFIG.
> Copy of EM2400 CONFIG.
» Baxter Dextrose 70% 2000 Bag is not contained
in any Solution.

o« )

Message
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USING THE INGREDIENT GROUP EDITOR

Use the Ingredient Group Editor to manage the ingredient groups, assign the products that are
in the formulary to the correct groups and specify which groups are incompatible.

WARNING

Any calcium-containing products must be assigned to the calcium members group,

A and any phosphate-containing products must be assigned to the phosphate members
group to ensure the software will warn users about formulas that may cause a
precipitate in the tube set during the compounding process.

IMPORTANT! These functions require Formulary permissions. For more information about user
groups and permissions, refer to Setting Up the Users on Page 120. Before making any changes
in the Ingredient Group Editor, contact Baxter Technical Support. Refer to Getting Help on
Page 20.

At the menu screen, tap Edit > Ingredient Group Editor.

1
»F Configuration Editor

Formulary Editor

ESNSE Ingredient Group Editor
Inlet Editor

Bag Inventory Editor

T OIONES RIEIPAOIRGIES RHEL

Close

Menu screen, Edit menu
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The Ingredient Groups window appears. It lists the available ingredient groups and allows you

to add, edit or delete ingredient groups. Calcium and Phosphate groups are created
automatically.

Ingredient Groups

Ingredient Group Name
Calcium

Phosphate

Ingredients Groups window

ADDING OR EDITING AN INGREDIENT GROUP

1. Atthe Ingredient Groups window, do one of these options:
e Tap Add to add a new ingredient group.

The Add Ingredient Group window appears.
e Select the group you want to edit, then tap Edit.
The Edit Ingredient Group <name> window appears.
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Edit Ingredient Group Calcium
Name |SEIEN |

wonvemnee—————— s

Addamel N Ca Chloride 10%

Aminosyn Il 10% SF »> Ca Gluconate 0.465mEqg/mL

Aminosyn Il 15% SF « Hyperlyte CR

Aminosyn PF 10% Lactated Ringers

Aminosyn PF 7% Lactated Ringers, 5% Dex

m Compatible Groups | Incompatible Group Flush Volume I

Phosphate 100

[/]Allow All Groups to Flush Flush Volume
{ Save ] [ Cancel ]

Edit Ingredient Group <name> window

2. Enter the Name of the group.
3. Specify the members of this group.
e To add an ingredient to this group:
a. Select the ingredient in the Nonmembers list.
b. Tap >>to move the ingredient to the Members list.
e Toremove an ingredient from this group:
a. Select the ingredient in the Members list.
b. Tap << to move the ingredient to the Nonmembers list.
4. Specify the groups that are incompatible with this group.
e To make another group incompatible with this group:

a. Select the other group in the Compatible Groups list.
b. Enter a Flush Volume.

NOTE: The flush ingredient will be any ingredient that is not listed as
incompatible.

c. Tap >>to move the group to the Incompatible Groups list.
e To make another group compatible with this group:
a. Select the other group in the Incompatible Groups list.

b. Tap << to move the group to the Compatible Groups list.
5. To modify the flush volume for an incompatible group:

a. Select the group in the Incompatible Groups list.
b. Edit the Flush Volume.

c. Tap Modify Flush.
6. Tap Save.

7. Atthe Ingredient Groups window, tap Close.
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DELETING AN INGREDIENT GROUP

1. Atthe Ingredient Groups window:
a. Select one or more ingredient groups you want to delete.
b. Tap Delete.
2. Atthe Delete ingredient group <name>? message, tap:
e Yes to delete the ingredient group

e Yes to All to delete all ingredient groups selected in the Ingredient Groups window
NOTE: If only one ingredient group is selected, only one will be deleted.

‘ @ | Delete Ingredient Group Calcium ?

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message

3. Atthe Ingredient Groups window, tap Close.
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USING THE INLET EDITOR

The priming volume and pumping speed for inlets may differ depending on the inlet’s spike and
tube diameter. The Inlet Editor allows you to adjust the priming volumes for all the inlets.

IMPORTANT! These functions require Administration permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120. Before making any
changes in the Inlet Editor, contact Baxter Technical Support. Refer to Getting Help on Page 20.

At the menu screen, tap Edit > Inlet Editor.

ENSE

EOIONES

Operator Manual

1
K Configuration Editor

Formulary Editor
Ingredient Group Editor
Inlet Editor

Bag Inventory Editor

RIEPIOIRTES RHEIL [

Close

Menu screen, Edit menu
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Using the Inlet Editor

The Inlet Editor window appears. It lists the available inlets and allows you to add, edit or delete
inlets.

Dextrose Inlet 173
Macro Spike, Micro Tubing Inlet 751
Non-Vented, Macro Inlet 173
Syringe Inlet 176
Vented, Macro Inlet 174
Vented, Micro Inlet 175
Add
Close

Inlet Editor window

ADDING OR EDITING AN INLET

1. Atthe Inlet Editor window, do one of these options:
e Tap Add to add a new inlet.

The Add Inlet window appears.
e Select the inlet you want to edit, then tap Edit.
The Edit Inlet <name> window appears.

Edit Inlet Non-Vented, Macro Inlet

Order Number 173

Description ‘Non-Vented, Macro Inlet

Max Speed & 375 —+

Priming Speed 126

Standard Priming Volume EErEr—— ,-
60

[ Save ] [ Cancel ]

Edit Inlet <name> window
Operator Manual ExactaMix Pro 2400 Compounder
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Using the Inlet Editor

IMPORTANT! For the order number, description and recommended priming volume
for each inlet, refer to Inlets on Page 17.

NOTE: Use of this function is not recommended without Baxter instruction.
WARNING

Modifying these settings without contacting Baxter Technical Support
could result in ingredients over or under delivering and may cause
patient harm.

2. Atthe Add Inlet window or Edit Inlet <name> window:
a. Enter the Order Number.
b. Enter the Description.

WARNING
A The Max Speed and Priming Speed are set automatically. Do not
change them unless directed by Baxter Technical Support.

c. If desired, edit the Standard Priming Volume.

NOTE: The software will not allow you to set a Standard Priming Volume that is
less than what Baxter recommends.

d. Tap Save.
3. Atthe Inlet Editor window, tap Close.

DELETING AN INLET

1. Atthe Inlet Editor window:
a. Select one or more inlets you want to delete.
b. Tap Delete.
2. At the Delete inlet <name>? message, tap:
e Yes to delete the inlet

e Yesto All to delete all inlets selected in the Inlet Editor window
NOTE: If only one inlet is selected, only one will be deleted.

(@) Delete inlet Non-Vented Macro Inlet (173) ?

[ Yes ] [ No ] [ Cancel ] [ Yes to All ]

Message

3. Atthe Inlet Editor window, tap Close.

VIEWING AN INLET’S USAGE INFORMATION

1. Atthe Inlet Editor window:
a. Select aninlet.
b. Tap Used By.

A message with the inlet’s usage information appears.

Operator Manual
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2. Atthe Information message, tap OK.

* Non-Vented, Macro Inlet (173) is contained in
Configurations:
° Manual Add
o EM2400 DEMO
° Sample
* Non-Vented, Macro Inlet (173) is used by
Products:
o Baxter Clinisol 15% 2000 Bag
° Baxter BranchAmin 4% 500 Bag
= Baxter Prosol 20% 2000 Bag
o Baxter Travasol 10% 1000 Bag
o Baxter Clinisol 15% 500 Bag
o Baxter Intralipid 20% 500 Bag
o Baxter PremaSol 10% 1000 Bag
° Baxter PremaSol 6% 500 Bag
o Baxter Intralipid 30% 500 Bag
o Baxter Hepatasol 8% 500 Bag
° Hospira Normosol-R 1000 Bag
° Hospira Aminosyn 10% SF 1000 Bag
o Hospira Aminosyn 10% SF 500 Bag

o )

Message

3. Atthe Inlet Editor window, tap Close.

VIEWING AN INLET’S SPEEDS AND FLOW FACTORS

IMPORTANT! All the ingredients need flow factors prior to compounding. Contact Baxter
Technical Support for adding/updating flow factors.

IMPORTANT! These settings affect the delivery volume, so they must be accurate. Do not make
any changes unless directed by Baxter Technical Support. Baxter has determined the flow
factors for all ingredients commonly used in TPN. If you think that a flow factor needs to be
changed, or a flow factor for a new ingredient needs to be added, contact Baxter Technical
Support. Refer to Getting Help on Page 20.

NOTE: Only the OEM user is able to view or edit the flow factors.
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1. Atthe Inlet Editor window:
a. Selectaninlet.
b. Tap Speeds/Flow Factors

2. Atthe Speeds for Inlet <name> window, follow the instructions of Baxter Technical
Support.

Speeds for Inlet: Non-Vented, Macro Inlet

51 0.00
198 5.00
375 12.50
( Add )
[ Delete ]
( Edit Speed )
[ Close ]

Speeds for Inlet <name> window

3. Atthe Inlet Editor window, tap Close.
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USING THE BAG INVENTORY EDITOR

The Bag Inventory Editor allows you to manage the bags that are available for use on the
compounder.

CAUTION
A Before making any changes in the Bag Inventory Editor, contact Baxter Technical
Support. Refer to Getting Help on Page 20.

IMPORTANT! These functions require Administration permissions. For more information about
user groups and permissions, refer to Setting Up the Users on Page 120. Use only bags validated
by Baxter for use with the compounder. For details, refer to Bags on Page 18. Using non-
validated bags voids all manufacturer warranties. In addition, the accuracy of the finished
solution will not be validated.

At the menu screen, tap Edit > Bag Inventor Editor.

1
» Configuration Editor

Formulary Editor

ESNSE Ingredient Group Editor
Inlet Editor

Bag Inventory Editor

i OIONES KIERORTS CIENNE

Close

Menu screen, Edit menu
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The Bag Inventory window appears. It lists the available bags and allows you to add, edit or
delete bags.

Bag Inventory

x37
x36
x38
735

EVA Container 250mL
Calibration 500mL
EVA Container 500mL
Calibration 1000mL
EVA Container 1000mL
Dual Chamber 1500mL
EVA Container 2000mL
Dual Chamber 3000mL
EVA Container 3000mL
EVA Container 4000mL
EVA Container 5000mL

Delete

Bag Inventory window

ADDING OR EDITING A BAG

IMPORTANT! Before adding a bag, contact Baxter Technical Support. Refer to Getting Help on

Page 20.

Close

1. Atthe Bag Inventory window, do one of these options:

Operator Manual

Tap Add to add a new bag.
The Add Bag window appears.

Add Bag

Part Number ||

Description |

Bag Size (mL) |0.00 |

Empty Weight (g) ‘0.00 ‘

Tolerance (g) ‘0.00 ‘

Cancel

[ Save

)

)

Add Bag window
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e Select the bag you want to edit, then tap Edit.
The Edit Bag <name> window appears.

Edit Bag 735

Part Number | |

Description ‘Calibration 1000mL ‘

Bag Size (mL) |1000.00

Empty Weight (g) ‘46.00 ‘

Tolerance (g) ‘3.50 ‘

[ Save ] [ Cancel ]

Edit Bag window
2. Atthe Add Bag window or Edit Bag <name> window:

a. Enter:
e Part Number
e Description
e BagSize
e Empty Weight

e Tolerance
NOTE: You can obtain the empty weight and tolerance of approved bags from
Baxter.

b. If you are adding a new bag, enter other information as directed by Baxter.

c. Tap Save.

3. Atthe Bag Inventory window, tap Close.
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DELETING A BAG

1. Atthe Bag Inventory window:
a. Select one or more bags you want to delete.
b. Tap Delete.
2. Atthe Delete bag <name>? message, tap:
e Yes to delete the bag
e Yes to All to delete all bags selected in the Bag Inventory window

NOTE: If only one bag is selected, only one will be deleted.

. @ | Delete bag x37 (EVA Container 250mL)?

[ Yes ] [ No ] { Cancel ] [ Yes to All ]

Message

3. Atthe Bag Inventory window, tap Close.
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USING REPORTS

The compounder offers standard reports that document compounding activity and support
various utilities. All reports are formatted for printing on 8.5 x 11 in. (21.6 x 28 cm) paper or on
A4 paper size of 70X25, 4 mm (or comparable paper).

NOTE: To use A4 paper, refer to Printing Options on Page 15.

IMPORTANT! Viewing, printing and exporting reports requires Report permissions. For more
information about user groups and permissions, refer to Setting Up the Users on Page 120.

NOTE: To select the printer used for printing reports, refer to Report Printer on Page 107.

To view reports:

1. Atthe menu screen, select Reports > Standard.

QOGO

RINE EDIT COMPOUND

Standard

Custom Reports

EOLIONES REPORTS RHEIL (7

Close

Menu screen, Reports menu
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2. Select the report you want to view.

MixCheck

Authorization
Formula
Log

Configuration

ESIfIEE Calibration Summary
Formula Precision
Ingredient Usage
Bag Usage

Flow Factors

Formulary

TOOLS

Product Barcodes

R T e Vs M

Standard reports

3. View the report. Refer to the instructions on the upcoming pages.

NOTE: The report screen may include scroll bars on the right side and/or the bottom.

The top of the report screen may include these navigation options:

o The print button allows you to send the report to the specified printer.

The export icon allows you to save the report to a USB drive.

o
o The percentage list controls the zoom.
o

The arrows and the number field allow you to move to different pages of a multi-

page report.
4. When you are finished using the report, tap Exit.

[ Exit )

Navigation options for reports
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MIXCHECK REPORT

The MixCheck Report provides details about the compounding process for an order. It reports
information including the expected bag weight, measured bag weight, ordered ingredients and
volumes, and manual additions that are required. This report can be exported in PDF format.

Customizing MixCheck Reports

IMPORTANT! When using the Use Online MixCheck Authorization, authorization and
cosignature authorization of this report require Verification permissions. For more information
about user groups and permissions, refer to Setting Up the Users on Page 120.

The following options are available for customizing the MixCheck Report:

e To make this report display and/or print automatically after compounding, and/or allow
on-screen authorization, refer to MixCheck Report on Page 102.

e To require a cosigner to authorize the MixCheck Report, refer to Cosignature on
Page 109.

e To allow exporting of this report directly to the DoseEdge system, refer to MixCheck
Data Export on Page 104.

e To specify signature-related text that you want to include at the end of the report, refer
to MixCheck Signature Label on Page 107.

Using MixCheck Reports

WARNING

It is important to print a MixCheck Report for every order, then have a cosigner
(pharmacist) view and approve the entire report, especially the Formula Name;
Expected Weight, Measured Weight and Difference; Manual Additions; and
Details.

For instructions on viewing and approving the MixCheck Report, refer to the following pages.

Using Online MixCheck Authorization

If “Auto-Display” and “Use Online MixCheck Authorization” are enabled in the options (Menu >
Tools > Options > System tab > MixCheck Report), the MixCheck report will display
automatically on the screen after compounding is completed. Go to step 2(b).

If the Use Online MixCheck Authorization option is enabled, “Review Unauthorized Solutions...”
dropdown option is enabled under the MixCheck Report menu option:
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1. At the menu screen, tap Reports > MixCheck > Review Unauthorized Solutions...
2. Atthe Solutions window:

a. Select a formula. The Report Preview — MixCheck window appears.

L | oon -] (e )

MixCheck Report
Formula Name No Ingredient Too Small Date/Time  10/13/2021 10:57:54 AM
Serial Number O0F687C-91 User OEM User
Configuration Sample Elapsed Time 00:00:49
Expected Weight (g):  173.30 Measured Weight (g):  157.94 Difference (%):  -B.86
Manual Additions: Details:
Ingredient Name Vol (mL) | Added | Selected bag %39 EvA Container 1000mL
‘Aminosyn 11 10%. 2000 | NO Dextrose 70% is possibly underweight by 10.67
grams

The final weight of this solution is outside of the
acceptable limit of +/- 5.00%

User Comments:

Ordered Volume

Dextrose 70%
Port: 19 Hospira Dextrose 70% 2000 Bag Drug ID: 0409-7120-07 Seq(1) 100.00

Sterile Water for In
Port: 24 Haspira Sterile Water for In 2000 Bag Drug ID; 0409-7118-07 Seq(2) 50.00

Total (mL): 150.00 |

Authorized By:

[ Accept ] [Postpone] [ Update Manual Add & User Comments )

MixCheck report preview

b. Click on Update Manual Add & User Comments to verify if all the Manual
ingredients have been added by selecting YES/NO adjacent to the listed
ingredient and click Update.

Edit Mixcheck Report

Manual Additions: User Comments:
Aminosyn Il 10% 20.00 No v

[ Update ] [ Close ]

Update Manual Add & User Comments screen
c. Tap one of these buttons on the Report Preview screen:
e Accept to authorize the report

e Postpone to save the report for later verification

e Print to send the report to the assigned printer

Operator Manual ExactaMix Pro 2400 Compounder
0719003109 Rev. A, Effective Jan 2022 Page 161




Using Reports

Operator Manual

MixCheck Report
Formula Name DOE,JANE(5678) Date/Time 12/15/2021 03:35:10 pm
Serial Number 1CB881D-100184 User ADMIN
Configuration EM2400 CONFIG Elapsed Time 00:09:42
Expected Weight (g): 1,094.74 Measured Weight (g): 1,093.06 Difference (%): -0.15
Manual Additions: Details:
Ingredient Name Vol (mL) | Added Selected bag x39 EVA Container 1000mL.
: Container at port 1 exchanged with new container of
Infuvite Adult 10.50 NO Baxter Clinolipid 20% 500 Bag
: Container at port 23 exchanged with new container
K Chloride 2mEq/mL 7.88 NO of Baxter Sterile Water for In 2000 Bag
The final weight of this solution is within the
acceptable limit of +/- 5.00%
User Comments:
Ordered Volume
Ca Gluconate 0.465mEq/mL
Port: 19 Fresenius Kabi Ca Gluconate Drug ID: 63323-360-03 Seq (11 22.58
0.465mEqg/mL 50 Vial
Clinolipid 20%
Port: 1 Baxter Clinolipid 20% 500 Bag Drug ID: 0338-9540-03 Seq(3) 40.00
Port: 1 Baxter Clinolipid 20% 500 Bag Drug ID: 0338-9540-03 Seq(4) 91.25
131.25
Dextrose 70%
Port: 21 Baxter Dextrose 70% 2000 Bag Drug ID: 0338-0719-06 Seq(7) 210.00
K Phosphate 3mMol/mL PO4
Port: 6 Hospira K Phaosphate 3mMol/mL PO4 15 Drug ID: 0409-7295-01 Seq(2) 1.75
Vial
Magnesium Sulfate 4.06mEq
Port: 20 Fresenius Kabi Magnesium Sulfate Drug ID: 63323-642-50 Seq(8) 0.52
4.06mEq 50 Vial
Multitrace-5 Concentrate
Port: 14 *Am Reg MTE-5 ConC 10mL Drug ID: 0517-8210-25 Seq(6) 1.05
Na Chloride 4mEq/mL
Port: 9 APP Pharm Na Chloride 4mEg/mL 30 Drug ID: 63323-187-30 Seq (1) 2.63
Vial
Sterile Water for In
Port: 23 Baxter Sterile Water for In 2000 Bag Drug ID: 0338-0013-06 Seq (9) 150.00
Port: 24 Baxter Sterile Water for In 2000 Bag Drug ID: 0338-0013-06 Seq ( 10 61.85
Port: 23 Baxter Sterile Water for In 2000 Bag Drug ID: 0338-0013-06 Seq (12 30.00
241.85
Travasol 10%
Port: 12 Baxter Travasol 10% 1000 Bag Drug ID: 0338-0644-04 Seq(5) 420.00
Total (mL): 1,031.63
Authorized By:
Serial Number 1CB881D-100184 Page 1 of 1 Display Number Fiokokickokk
Date/Time 12/15/2021 03:35:10 pm
Sample MixCheck Report
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Verify that the Formula Name matches the
patient name on the label on the patient
bag.

Verify that the Serial Number (unique for

) / Configuration EM2400 CONFIG
each order) matches the serial number on/

the label of the patient bag. If the Serial
Number of the formula is greater than 36
characters then 36 characters followed by
‘... is printed.

If Manual Additions are listed:

1. Verify that they match the label on the /

patient bag and/or the original formula.
2. Add these ingredients to the solution
manually.
3. Place your initials in the Added column.

In the signature-related section at the end
of the report, follow your facility’s protocol.

MixCheck

). Formula Name DOE,JANE(5678)

Serial Number 1CB881D-100184

Expected Weight (g):  1,094.74 Measured Weight (g

Manual Additions:

Ingredient Name Vol (mL) | Added

/ Infuvite Adult 10.50 NO

K Chloride 2mEqg/mL 7.88 NO

User Comments:

Ca Gluconate 0.465mEq/mL
Port: 19 Fresenius Kabi Ca Gluconate
0.465mEg/mL 50 Vial

Clinolipid 20%
Port: 1 Baxter Clinolipid 20% 500 Bag
Port: 1 Baxter Clinolipid 20% 500 Bag

Dry
Dry

Dextrose 70%
Port: 21 Baxter Dextrose 70% 2000 Bag

K Phosphate 3mMol/mL PO4
Port: 6
Vial

Hospira K Phosphate 3mMol/mL PO4 15 Dry

Magnesium Sulfate 4.06mEq

Port: 20 Fresenius Kabi Magnesium Sulfate
4.06mEq 50 Vial

Dry

Multitrace-5 Concentrate
Port: 14 *Am Reg MTE-5 ConC 10mL

Na Chloride 4mEqg/mL

Port: 9 APP Pharm Na Chloride 4mEqg/mL 30
Vial

Dry

Sterile Water for In

Port: 23 Baxter Sterile Water for In 2000 Bag
Port: 24 Baxter Sterile Water for In 2000 Bag
Port: 23 Baxter Sterile Water for In 2000 Bag

Dry
Dry
Dry

Travasol 10%
Port: 12 Baxter Travasol 10% 1000 Bag

\ Authorized By:

Serial Number 1CB881D-100184

Page 1

Sample MixCheck Report (left side)

Operator Manual
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Report

Date/Time

User

12/15/2021 03:35:10 pm =

ADMIN

Elapsed Time 00:09:42

Verify that the Date/Time

):

1,093.06

Difference (%):  -0.15 T

matches the date and time the
order was fulfilled.

Compare the Measured Weight of the
solution to the Expected Weight. Verify that

Details:

Selected bag x39 EVA Container 1000mL.

Container at port 1 exchanged with new container of
Baxter Clinolipid 20% 500 Bag
Container at port 23 exchanged with new container
of Baxter Sterile Water for In 2000 Bag

The final weight of this solution is within the
acceptable limit of +/- 5.00%

Ordered Volume

22.58 \

Date/Time

12/15/2021 03:35:10 pm

hg ID: 63323-360-03 Seq ( 11

hg ID: 0338-9540-03 Seq(3) 40,00

hg ID: 0338-9540-03 Seq(4) 91,25
131.25

ig ID: 0338-0719-06 Seq (7) 210.00

hg ID: 0409-7295-01 Seq(2) 1.75

hg ID: 63323-642-50 Seq(8) 0.52

g ID: 0517-8210-25 Seq(6) 1.05

ig ID: 63323-187-30 Seq (1) 2.63

hg ID: 0338-0013-06 Seq(9) 150.00

hg ID: 0338-0013-06 Seq ( 10 61.85

hg ID: 0338-0013-06 Seq (12 30.00
241.85

g ID: 0338-0644-04 Seq(5) 420.00 J

Total (mL): 1,031.63| e —
of 1 Display Number Horkdok ok

Operator Manual

PR

the Difference is within acceptable limits per
your facility’s protocol.

Evaluate the information in the Details
section to verify that the solution was
compounded properly. This section lists any
interruptions that occurred while
compounding, such as ingredient changes,
ingredient replacements, occlusions,
bubbles, pump pauses, pump door
openings and other interruptions.

p——\/erify that each ingredient and its Ordered

Volume match the label on the patient bag
and/or the original formula.

Verify that the Total (mL) matches the label
on the patient bag and/or the original
formula.

NOTE: The Total (mL) does not include the
volume of the Manual Additions.

Sample MixCheck Report (right side)
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AUTHORIZATION REPORT

The Authorization Report contains information about the compounder setup, including:
e The user who set it up (in the Assembled column) and the optional cosigner who
performed the verification (in the Verified column)

NOTE: Users can print the report and write their initials in these columns, or the
software can be set up to populate these columns automatically.

e The ingredient name, port and inlet used during setup
The following options are available for customizing the Authorization Report:

e To require a cosigner to verify the setup, refer to Cosignature on Page 109.

e To make the Assembled and Verified columns populate automatically, refer to
Authorization Report on Page 102.

e To specify signature-related text that you want to include at the end of the report, refer
to Authorization Report Signature Label on Page 107.

You will be able to select a configuration for this report in the select configuration window.

To view the Authorization Report:

1. Atthe menu screen, tap Reports > Standard > Authorization.
2. Atthe Select Report Date window:

a. Enter the date for the report.

b. Tap OK.

c. This report can be exported in PDF format

Select Report Dates

First date included in report ‘6/15/2021 ‘

Last date included in report ‘6/15/2021 ‘

Select Report Date window

Operator Manual ExactaMix Pro 2400 Compounder

0719003109 Rev. A, Effective Jan 2022 Page 165



Using Reports

Authorization Report
Configuration: TPN-Test Current user:  Administrator
Port Ingredient name InletPN  Container (mL) Remainder(mlL) Assembled Verified Date / Time
7 K Chloride 0.4mEg/mL 751 50 44.00 Administrator Pharmacist 11/13/2018 4:12:38PM
9 Travasol 10% 173 1000 940.00 Administrator Pharmacist 11/13/2018 4:12:43PM
19 Dextrose 70% 173 2000 1940.00 Administrator Pharmacist 11/13/2018 4:12:49PM|
24 Sterile Water for In 173 2000 1610.00 Administrator Pharmacist 11/13/2018 4:12:54PM
Part Number Count
173 3
751 1
Assembled by: Date: Time:
Assembled by: Date: Time:
Checked by: Date: Time:
Print Date / Time: 11/13/2018 4:13:42PM Page 1 of 1

Sample Authorization Report

Operator Manual ExactaMix Pro 2400 Compounder
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FORMULA REPORT

The Formula Report is a summary of a specific formula.
To view the Formula Report:

1. Atthe menu screen, tap Reports > Standard > Formula.
2. Atthe Select Formula window:
a. Select Show All Formulas, or select another filter to reduce the number of
formulas displayed.
NOTE: You can tap Formula Name to sort by name or tap Serial Number to sort
by number.
b. Select a formula.
c. Tap OK.
d. This report can be exported in PDF format.

Select Formula

Doe, Jane 388375 DE 060ct2021 175955

rFilter
(OsShow All Formulas (@ Show Unpumped Formulas (O Show Pumped Formulas

[ OK ] [ Close ]

Select Formula window

Operator Manual ExactaMix Pro 2400 Compounder
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Formula Report
Formula Name:  DOE, JOHN(5551212) Date:  12/22/2017
Serial Number: A1TFAO01E32-5984912 Time:  1:05:14PM
Delivery Count: 1
Ingredient Name Requested Volume (mL)
Clinisol 15% 40.08
Dextrose 70% 50.72
Infuvite Adult 50.64
K Chloride 0.4mEg/mL 55.64
Sterile Water for In 75.54

Page 1 of 1

Sample Formula Report

Operator Manual ExactaMix Pro 2400 Compounder
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If the Serial Number of the formula file contains more than 50 characters, then the Formula
Report prints up to 50 characters followed by “...".

Formula Report

If the Serial Test Patient(123456789

F la N : Date:
Number of the ormula Name es ient( ) ate:  6/6/2019
formula is % PATABCDES1-123456789012345678901234567890123456789... Time:  3:25:45PM
greater than Delivery Count: 1
50 characters,
then 50 .

Ingredient Name Reguested Volume (mL
characters
followed by *_.” Dextrose 70% 50
roflo Y| K Chloride 0.4mEg/mL 101.34
Is prmted' Sterile Water for In 801

Page 1 of 1
Sample Formula Report
Operator Manual ExactaMix Pro 2400 Compounder
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LOG REPORT

The Log Report is a summary of the formulas that were used for compounding on a specific day.
To view the Log Report:

1. Atthe menu screen, tap Reports > Standard > Log.
2. Atthe Select Report Dates window:
a. Enter the date for the report.
b. Tap OK.
c. This report can be exported in PDF, Excel and txt format

Select Report Dates

First date included in report |2/9/2018

Last date included in report |2/9/2018

- )

Select Report Dates window

Operator Manual ExactaMix Pro 2400 Compounder
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Log RE‘pOI"t
Date: 2/9/2018
Formula Serial #  AM1FA0ME25-100038 Formula Mame:  LOQEY, BABA[Z123456T89AA)
Dextrose T0% 305 mL
K Chloride 0.4mEa/mL 164 mL
Sterile Water for In 100 mL
Travasol 10% 074 mL
K Chloride 2mEa/mL 8813 mL MANUAL ADD
Date Delivered: 2/92018 Expected Weight 112.42 g
Time Delivered: 3:18:31PM Measured Weight: 11265 g
Elapsed Timea: 00:00:13 Percent Error: 0.21 %
Formula Serial #  A1FAQ01E41-5984912 Formula Name: DOE, JOHN(5551212)
Dextrose T0% 30 mL
K Chloride 0. 4dmEg/mL 35 mL
Sterile Water for In 7554 mL
Travasol 10% 55 mL
Clinisel 15% 40.08 mL MANUAL ADD
Infuvite Adult 5064 mL MANUAL ADD
Date Delivered: 2972018 Expected Weight- 205.05 a
Time Delivered: 3:19:58PM Measured Weight: 205.41 a
Elapsed Timea: 00:00:15 Percent Error: 0.18 %
Page 1 of 1
Sample Log Report
Operator Manual ExactaMix Pro 2400 Compounder
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If the Serial Number of the formula file contains more than 80 characters, then the Log Report
prints up to 80 characters followed by “...".

If the Serial Log Report
Number of the Date: 6/6/2019
formula is greater Formula Serial #  PATABCDES1-123456789012345678901234567890123456789012345678901234567890123456789...
than 80 characters, Formula Name:  Test Patient(123456789)

Dextrose 70% 50 mL
then 80 char'ac'tfers Sterile Water for In 60.1 mL
followed by “..." is K Chloride 0.4mEq/mL 101.34 mL MANUAL ADD
prlnted. Date Delivered: 6/6/2019 Expected Weight: 121.75 ¢

Time Delivered: 12:02:13PM Measured Weight: 12119 ¢

Elapsed Time: 00:00:14 Percent Error: -0.46 %

Page 1 of 1
Sample Log Report

Operator Manual ExactaMix Pro 2400 Compounder
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CONFIGURATION REPORT

The Configuration Report provides information about a specific configuration.
To view the Configuration Report:

1. Atthe menu screen, tap Reports > Standard > Configuration.
2. Atthe Select Configuration window:

a. Select the configuration.

b. Tap OK.

c. This report can be exported in PDF format.

Select Configuration

[EM2400 Config. (Current) |

( 0K ][ cancel )

Select Configuration window

Operator Manual ExactaMix Pro 2400 Compounder

0719003109 Rev. A, Effective Jan 2022 Page 173



Using Reports

Configuration Report

Configuration: EM2400 CONFIG Date: 01/10/2022
User: ADMIN Time: 03:13:58 pm
Sequence Port Ingredient

1 9 Na Chloride 4mEg/mL

2 10 K Chloride 2mEg/mL

3 7 Na Acetate 2mEqg/mL

4 B K Acetate 2mEaq/mL

5 5 Na Phosphate3mMol/mL PO4

[ B K Phosphate 3mMol/mL PO4

7 4 Infuvite Adult

8 1 Clinolipid 20%

9 Auto-Add A Travasol 10%

10 11 Clinisal 15%

11 14 Multitrace-5 Concentrate

12 21 Dextrose 70%

13 20 Magnesium Sulfate 4.06mEq

14 23 u Sterile Water for In

14 24 u Sterile Water for In

15 19 Ca Gluconate 0.465mEag/mL

'U'marks the default universal ingredient for this configuration.

"A' marks the allowed Auto Addition Tor this configuration,

Page 1 of 1

Sample Configuration Report
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FORMULARY REPORT

The Formulary Report lists the ingredients that are included in the formulary. Only ingredients
that may actually be mounted on the compounder should be in the formulary. This report can
be exported in PDF/Excel format.

To view the Formulary Report, tap Reports > Standard > Formulary at the menu screen.

Formulary Report
Date: 10/4/2021
Time: 7:37:07 PM
Ingredient Name Availability
Product Name Drug ID Inlet Sp. Gravity Size
Addamel N No
Fresenius Kabi Addamel N 10 Vial 63323-0143-97 751 1.10 10
Aminosyn Il 10% SF No
Hospira Aminosyn Il 10% SF 2000 Bag 0409-7172-17 173 1.03 2,000
Aminosyn Il 15% SF No
Hospira Aminosyn Il 15% SF 2000 Bag 0409-7171-17 173 1.05 2,000
Aminosyn PF 10% No
ICU Medical Aminosyn PF 10% 1000 Bag 0990-4179-05 173 1.03 1,000
Aminosyn PF 7% No
Hospira Aminosyn PF 7% 500 Bag 0409-4178-03 173 1.02 500
Anticoagulant Na Citrate No
Fenwal Anticoagulant Na Citrate 500 Bag 0942-9504-10 173 1.02 500
Ca Chloride 10% No
American Regent Ca Chloride 10% 10 Via 0517-2710-25 175 1.06 10
|
Ca Gluconate 0.465mE Yes
Fresenius Kabi Ca Gluconate 0.465mE 10 63323-360-19 175 1.05 10
Vial
Fresenius Kabi Ca Gluconate 0.465mE 10 63323-360-61 175 1.05 100
0 Vial
Fresenius Kabi Ca Gluconate 0.465mE 50 63323-360-59 175 1.05 50
Vial
Cardioplegic Solution No
Baxter Cardioplegic Solution 1000 Bag 0338-0341-04 173 1.00 1,000
Clinimix 4.25/10 No
Baxter Clinimix 4.25/10 1000 Bag 0338-1134-03 173 1.05 1,000
Baxter Clinimix 4.25/10 2000 Bag 0338-1091-04 173 1.05 2,000
Clinimix 4.25/5 No
Baxter Clinimix 4.25/5 1000 Bag 0338-1133-03 173 1.03 1,000
Baxter Clinimix 4.25/5 2000 Bag 0338-1089-04 173 1.03 2,000
Clinimix 5/15 No
Baxter Clinimix 5/15 1000 Bag 0338-1137-03 173 1.07 1,000
Baxter Clinimix 5/15 2000 Bag 0338-1099-04 173 1.07 2,000
Clinimix 5/20 No
Baxter Clinimix 5/20 1000 Bag 0338-1138-03 173 1.09 1,000
Baxter Clinimix 5/20 2000 Bag 0338-1101-04 173 1.09 2,000
Clinimix 6/5 No
Baxter Clinimix 6/5 1000 Bag 0338-0198-01 173 1.03 1,000
Page 1 of 8

Sample Formulary Report
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PRODUCT BARCODES REPORT

The Product Barcodes Report displays the barcodes for products that are in the formulary. You
can print the report onto labels for use with products that do not have a manufacturer’s

barcode.

To view the Product Barcodes Report:

1. Atthe menu screen, tap Reports > Standard > Product Barcodes.
2. Atthe Select Product window:

Operator Manual

Select the product.
b. Tap OK.
This report can be exported in PDF format

Select Product

Baxter Cardioplegic Solution 1000 Bag
Baxter ClinOleic 20% 250 Bag

Baxter ClinOleic 20% 500 Bag

Baxter Clinimix 4.25/10 1000 Bag
Baxter Clinimix 4.25/10 2000 Bag
Baxter Clinimix 4.25/5 1000 Bag
Baxter Clinimix 4.25/5 2000 Bag
Baxter Clinimix 5/15 1000 Bag

Baxter Clinimix 5/15 2000 Bag

Baxter Clinimix 5/20 1000 Bag

[ OK ] [ Cancel

Select Product window

ExactaMix Pro 2400 Compounder
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Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Baxter Infuvite Adult 100 Vial

Operator Manual

Sample Product Barcodes Report
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INLET BARCODES REPORT

The Inlet Barcodes Report displays the barcodes for the inlets. You can print the report onto
labels, in case you make a mistake during setup and need an extra barcode label. This report
can be exported in PDF format.

To view the Inlet Barcodes Report, tap Reports > Standard > Inlet Barcodes at the menu screen.
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Sample Inlet Barcodes Report
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BLACKBOX REPORT

The Blackbox Report is a chronological list of all important system activity for a specific period
of time. If necessary, Baxter may use this information for troubleshooting.

NOTE: Exporting the Blackbox report takes several minutes. Baxter recommends doing the
export at the end of the day.
To view the Blackbox Report:

1. Atthe menu screen, select Reports > Standard > Blackbox.
2. Atthe Enter Begin and End Times window:
a. Enter the starting and ending times for the report.

b. Tap OK.
c. This report can be exported in PDF format.

Select Date and Time
First date included in report [10/6/2021 6:20:23 PM

Last date included in report [10/6/2021 6:20:23 PM

[ OK ] [ Cancel ]

Enter Begin and End Times window

ExactaMix Pro 2400 Compounder

Operator Manual
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For assistance with reading this report, contact Baxter Technical Support. Refer to Getting Help
on Page 20.

BlackBox Report

Entry Date Entry Time User Name Audit Category Audit Message

12/15/2021 09:29:26 am  SYSTEM VALVE Port 17 acutations:0,Port 18 acutations:0,Port 19
acutations:5,Port 20 acutations:2,

12/15/2021 09:29:26 am SYSTEM WVALVE Port 21 acutations:2,Port 22 acutations:0,Port 23
acutations:7,Port 24 acutations:10,

12/15/2021 09:29:26 am SYSTEM WALVESENT 0x0210

12/15/2021 09:29:26 am SYSTEM VALVERCVD 0Ox0210FEQQOOOO

12/15/2021 09:29:26 am SYSTEM SCALESENT 0x0301

12/15/2021 09:29:26 am SYSTEM SCALERCVD 0x0301

12/15/2021 09:29:27 am SYSTEM SCALESENT 0x0302

12/15/2021 09:29:27 am SYSTEM SCALERCVD 0x0302015363616C6530323134

12/15/2021 09:29:27 am SYSTEM SCALE FirmwarelD: Scale0214

12/15/2021 09:29:27 am  SYSTEM SCALE CompounderScaleMain::ScaleSequenceDaone

12/15/2021 09:29:27 am SYSTEM SCALESENT 0x0311

12/15/2021 09:29:27 am SYSTEM SCALERCVD 0x031100A08D1922

12/15/2021 09:29:27 am SYSTEM BELLSENT 0x0901

12/15/2021 09:29:27 am SYSTEM BELLRCVD 0x0901

12/15/2021 09:29:29 am SYSTEM BELLSENT 0x0902

12/15/2021 09:29:29 am SYSTEM BELLRCVD 0x090201415544494F30343134

12/15/2021 09:29:29 am SYSTEM BELL FirmwarelD: AUDIO0414

12/15/2021 09:29:2% am  S5YSTEM GuUl GUIRESPINIT status is 0 and

0} tatus™:false } JtusMessage":"Request processing
got failed"}]s":0}]:1} Jome ready.
"}H

12/15/2021 09:30:16 am SYSTEM SECURITY LOGON attempted by password: Username admin
(Passward is empty)

12/15/2021 09:30:16 am SYSTEM SECURITY LOGIN FAILED: Username admin

12/15/2021 09:30:37 am SYSTEM GUIINTERFACE GetGroupNameByLeginName Error in
UserGrouplistModel

12/15/2021 09:30:37 am SYSTEM GuI ["maa.login”,48,
{"LoginName":"ADMIN","password": "+t |

12/15/2021  09:30:37 am  SYSTEM MODEANDACCESS  LOGON attempled by password: ADMIN

12/15/2021 09:30:37 am  SYSTEM Database Opened database: /var/persist/database/em2400.db

12/15/2021 09:30:37 am SYSTEM CompDB Configure SQLite busy timeout as 30000 ms ->
Succeeded

12/15/2021 09:30:40 am SYSTEM CompDB SQLITE rollback method set as WAL

12/15/2021 09:30:40 am SYSTEM MODEANDACCESS LOGON successful for ADMIN

12/15/2021 09:30:40 am ADMIN Gul REQUESTED TO ENABLE USB AFTER USER LOGIN

12/15/2021 09:30:40 am ADMIN UsB Erum: Attached Mass Storage (vid: 5118, pid:
16675, iclass: 8, isub-class: 6, iprotocol: 80)

12/15/2021 09:30:40 am ADMIN UsB Check device Mass Storage attached: Attached

12/15/2021 09:30:40 am  ADMIN GuUl Mass storage is attached and enabling it.

12/15/2021  09:30:40 am  ADMIN usB Enable mass storage driver: ENABLED

12/15/2021 09:30:40 am ADMIN Gul USB mass storage hot-plugin events has been
subscribed.

12/15/2021 09:30:40 am ADMIN use Hotplugin monitoring thread started.

12/15/2021 09:30:40 am  ADMIN UsB Subscription {Mass Storage: Attached) is completed.

12/15/2021 09:30:40 am ADMIN usB Subscription (Mass Storage: Detached) is completed.

12/15/2021 09:30:40 am  ADMIN GuUl Barcode reader hot-plugin events has been
subscribed.

12/15/2021 09:30:40 am ADMIN UsSB Subscription (Barcode Reader: Attached) is
completed.

12/15/2021 09:30:40 am ADMIN UsB Subscription (Barcode Reader: Detached) is
completed.

12/15/2021 09:30:40 am ADMIN Gul HLA configurations: serial num = D1D2138037, mfg
date = 24/09/2021

12/15/2021 09:30:40 am ADMIN GuI Formula files directory configured with USB path

Page 1 of 222

Sample Blackbox Report
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CALIBRATION SUMMARY REPORT

The Calibration Summary Report summarizes the calibration processes for the pump and the
load cell during a specific period of time. It also distinguishes between automatic and manual
calibrations.

To view the Calibration Summary Report:

1. Atthe menu screen, tap Reports > Standard > Calibration Summary.
2. Atthe Select Report Dates window:
a. Enter the First and Last dates for the report.
NOTE: The available dates are still limited by the amount of time this information
is stored. For more information, refer to Storage on Page 104.
b. Tap OK.
c. This report can be exported in PDF format.

Select Report Dates

First date included in report ‘6/15/2021 ‘

Last date included in report ‘6/15/2021 ‘

Select Report Dates window

Operator Manual ExactaMix Pro 2400 Compounder
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Calibration Summary
Pump Calibration
From: 6/27/2017 To: 6/27/2017
Time Type Result
User Cal Product Port Volume
6/27/2017
3:30.04AM  Auto-adjustment Succeeded
Administrator 0338-0013-29 24 602.24
3:30:37AM Manual using load cell Succeeded
Administrator 0338-0013-29 24 200.00
Load Cell Calibration
Time User Result
6/27/2017
2:52:34AM  Administrator Succeeded
Page 1 of 1
Sample Calibration Summary Report
Operator Manual ExactaMix Pro 2400 Compounder
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FORMULA PRECISION REPORT

The Formula Precision Report summarizes the precision of the compounding process (how
accurately the actual weight matched the expected weight) during a specific period of time.

To view the Formula Precision Report:

1. Atthe menu screen, tap Reports > Standard > Formula Precision.
2. Atthe Select Report Dates window
a. Enter the First date and Last dates for the report.
NOTE: The available dates are still limited by the amount of time this information
is stored. For more information, refer to Storage on Page 104.
b. Select Acceptable Weight Variance (%) from the drop-down list.
c. Tap OK.
d. This report can be exported in PDF format.

Select Report Dates

First date included in report 12/22/2017
Last date included in report 12/22/2017
Enter Acceptable Weight Variance(%) |... v
Enter a Value 0.00

[ OK ] [ Cancel ]

Select Report Dates window
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From:

Serial Number Formula Name

12/22/2021

A1FAD1E32-598 DOCE, JOHN(5551212)
4912

Acceptable Weight Variance: - 5.00% to 5.00%

Formula Precision Summary
12/22/2021 To:  12/22/2021

Delivered User Expected (q) Measured (q) %Variance

1:00:52PM Administrator 194.83 193.88 -0.49

Summary:

-5% + variance

-4% to -4.99% variance
-3% to -3.99% variance
-2 % to -2.99% variance
-1% to -1.99% variance
-0.01% to -0.99% variance
0% to 0.99% variance
1% to 1.99% variance
2% to 2.99% variance
3% to 3.99% variance
4% to 4.99% variance
5% + variance

Number of bags

Maximum positive variance 0.49 %

Maximum negative variance -1.40 %

Average variance -0.49 %

Median variance -0.49 %

0O O O O O = = = = O 0 O

Total Bags
Bags within range

Bags out of range

LI

Printed Date /Time: 12/22/2021

1:.02:

37PM Page 1 of 1

Operator Manual
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If the Serial Number of the formula file contains more than 36 characters, then the Formula Precision

Report prints up to 36 characters followed by “...".

Formula Precision Summary
If the Serial From:  12/12/12021 To: 12122021
Number of the Acceptable Weight Variance: - 5.00% to 5.00%
formula is Serial Number Formula Name Delivered User Expected (gq) Measured (q) %Variance
greater than 36 |1212/2021
Test Patient(123456789) 12:02:13PM OEM User 121.75 121.19 -0.46
characters then m
36 characters 56789012345
fO||Owed by l...' Summary: Number of bags
is printed.
-5% + variance 0
-4% to -4.99% variance 0 Maximum positive variance 0.49 %
20, _ 0, .
3% to -3.99% variance 0 Maximum negative variance -1.40 %
-2 % to -2.99% variance 1
=19 - 0, i
1% to -1.99% variance 1 Average variance -0.49 %
-0.01% to -0.99% variance 1
0% to 0.99% variance 1 Median variance -0.48 %
1% to 1.99% variance 0
2% to 2.99% variance 0
3% to 3.99% variance 0
4% to 4.99% variance 0
5% + variance 0
Total Bags 4
Bags within range 4
Bags out of range
Printed Date /Time: 12/12/2021  3:16:36PM Page 1 of 1

Sample Formula Precision Report
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INGREDIENT USAGE REPORT

The Ingredient Usage Report summarizes the ingredient usage during a specific period of time.
This report is used to manage inventory.

To view the Ingredient Usage Report:

1. Atthe menu screen, select Reports > Standard > Ingredient Usage.

2. Atthe Select Report Dates window:
a. Enter the First and Last date for the report.

b. Tap OK.
c. This report can be exported in PDF/Excel format.

Select Report Dates

First date included in report |2/20/2018

Last date included in report |2/20/2018

- )
v

Select Report Dates window

ExactaMix Pro 2400 Compounder
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Ingredient Usage

From:  2/20/2018 To: 212012018
Ingredient Name Volume Used (ml)  Containers
Formulary Ingredients
Dextrose 70% 30.00
Baxter Dextrose 70% 2000 Bag 0338-0719-06 30.00 1
K Chloride 0.4mEqg/mL 35.00
Baxter K Chloride 0.4mEqg/mL 50 Bag 0333-0703-41 35.00 1
Sterile Water for In 75.54
Baxter Sterile Water for In 5000 Bag 0333-0013-29 75.54 1
Travasol 10% 55.00
Baxter Travasol 10% 1000 Bag 0333-0644-04 55.00 1

Manual Add Ingredients

Clinisol 15% 40.08

Infuvite Adult 50.64

Page 1 of 1

Sample Ingredient Usage Report
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BAG USAGE REPORT
The Bag Usage Report summarizes the bag usage during a specific period of time. This report is
used to manage inventory.

To view the Bag Usage Report:
1. Atthe menu screen, tap Reports > Standard > Bag Usage.

2. Atthe Select Report Dates window:
a. Enter the First and Last date for the report.

b. Tap OK.
c. This report can be exported in PDF/Excel format.

Select Report Dates

First date included in report ‘6/15/2021

Last date included in report ‘6/15/2021

)
A

Select Report Dates window

ExactaMix Pro 2400 Compounder
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Bag Usage
2/20/2018 2/20/2018

Part Number Description Number Used
x39 EVA Container 1000mL. 1

Total: 1

Page 1 of 1
Sample Bag Usage Report
Operator Manual ExactaMix Pro 2400 Compounder
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FLOW FACTORS REPORT

The Flow Factors Report lists the flow factors for all the ingredients in the current configuration.
To view the Flow Factors Report, tap Reports > Standard > Flow Factors at the menu screen.

You will be able to select a specific configuration or all configurations on the screen for the Flow
Factors Report. This report can be exported in PDF format.

NOTE: You do not need to view this report unless directed by Baxter Technical Support.

Flow Factors
Configuration: TPN-TEST
Date: 1/8/2020
Time: 4:18:50PM
Port Seq Product Name Min Vol (mL) Max Vol (mL) Flow Factor
6 1 Baxter K Chloride 0.4mEg/mL 50 Bag
0.00 10.00 1.0040
10.00 12,000.00 1.9890
9 2 Baxter Travasol 10% 1000 Bag
0.00 5.00 1.0030
5.00 12.50 0.9730
12.50 12,000.00 1.0050
11 3 Baxter Dextrose 70% 2000 Bag
0.00 5.00 1.9870
5.00 12.50 1.9960
12.50 12,000.00 1.0220
12 4 Baxter Sterile Water for In 5000 Bag
0.00 5.00 1.9930
5.00 12.50 0.9640
12.50 12,000.00 1.9970
Page 1 of 1
Sample Flow Factors Report
Operator Manual ExactaMix Pro 2400 Compounder
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CUSTOM REPORTS

The custom reports can be created for your facility for a fee. For more information on custom
reports, contact Baxter Technical Support. Refer to Getting Help on Page 20.

To view custom reports, select Reports > Custom Reports.

RRIRISE EXDAIRD COMPOUND

Standard >
Custom Reports >

I CIGNES BIEIRIOIRGIRS GEEINE

Close

Menu screen, Reports menu

Operator Manual ExactaMix Pro 2400 Compounder
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TROUBLESHOOTING

HANDLING INTERRUPTIONS AND ERRORS

If you encounter any of these interruptions or errors, take the suggested actions. If the issue
persists, contact Baxter Technical Support. Refer to Getting Help on Page 20.

Issues with the Barcodes

Explanation ‘
The barcode on the source
container is not legible.

Issue / On-screen Text |
The label on the source
container cannot be

Suggested Actions
1. Check that the barcode on the source container is
legible.

scanned. 2. Follow the process to print the barcode through
the ExactaMix software. Refer to Product Barcodes
Text: Report on Page 176.

Unable to scan

Check that the barcode on the source container
is legible.

The label on the source
container cannot be

The ingredient is not in 1.
the formulary.

scanned. Check that the Barcode ID in the formulary is
correct. Refer to Adding or Editing a Product on
Text: Page 142.

Not in Formulary

If the ingredient is not in the formulary, add the

ingredient. Refer to Adding or Editing an
Ingredient on Page 140.

The barcode reader is not 1.
operational.

The label on the patient
bag cannot be scanned.

Check that the green LED on the barcode

reader illuminates when you scan a barcode.

e |[fthe LED does not illuminate, check that
the cable for the barcode reader is
connected properly to the display.

e |f the LED illuminates, reboot the
compounder. Refer to Rebooting and
Shutting Down on Page 32.

2. Check that the barcode reader and its cable are

not damaged.

3. Contact Baxter Technical Support. Refer to

Getting Help on Page 20.

Disconnect the cable for the barcode reader

from the display, then reconnect this cable.

2. Check that the barcode reader and its cable are
not damaged.

3. Ifthe cables for the keyboard and mouse are
connected to the display, disconnect these
cables. Then reboot the compounder. Refer to
Rebooting and Shutting Down on Page 32.

4. Contact Baxter Technical Support for a barcode

programming sheet. Refer to Getting Help on

Page 20.

The barcode reader is not 1.
operational.

No barcodes can be
scanned.

Operator Manual
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Issue / On-screen Text

Explanation

Suggested Actions

Text: The .PAT /.FRM file is not 1. Verify the .PAT/.FRM name exists in the Pat file
Unable to retrieve available. share. If not, correct the .PAT/.FRM file in the
formula for scanned order entry software, then print and scan a
barcode <Formula File new barcode label.
Name> from the formula 2. Check that the Ethernet cable is connected
file directory <formula file properly to both the display and the order-
directory>. There may be entry computer.
an issue with network 3. Check that the network is functioning.
connectivity, please 4. Reboot the compounder. Refer to Rebooting
reboot the compounder. and Shutting Down on Page 32.

5. Check the path on both the order-entry
If the problem persists, computer and the compounder. Refer to
please contact Baxter Setting Up the Directories Options on Page 110.
Technical Support
Text: The 2D Formula Barcode 1. Correct the serial number of the 2D Formula
2D Formula Barcode serial | serial number does not Barcode, then print and scan the new 2D
number (X) does not meet the Order entry Formula Barcode.
meet current Order Entry | specification
specification and cannot
be loaded.
Text: The 2D Formula Barcode 1. Correct the content of the 2D Formula Barcode,

The following formula
name or data is not
supported.

Contact the Order Entry
System Administrator.

Content: "%s"

does not meet the Order
entry specification

then print and scan the new 2D Formula
Barcode.

Text:

2D Formula Barcode serial
number format (X) does
not meet the current
configured maximum
serial number length.
Refer to security tab in
options screen or contact
the Order Entry systems.

2D Formula Barcode serial
number format (X) does
not meet the configured
maximum serial number
length, set in options
screen - security tab.
The serial number length
should be less than or
equal to the value
specified in the security
tab.

Do one of the following:

Correct the length of the serial number of the
2D Formula Barcode (Maximum up to the value
specified in the security tab), then print and
scan the new 2D Formula Barcode

Increase the serial number length value in the
options screen->security tab, such that the
serial number length available in the 2D
Formula Barcode is lesser than or equal to the
configured value in security tab.

Operator Manual
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Issue / On-screen Text
Text:
2D Formula Barcode
contains the following
errors. So 2D Formula
Barcode (X) cannot be
loaded.

1) Following Ingredient
ID(s) exceeds the

maximum characters (20).

(%s)

You must correct the
Ingredient ID(s) then load
the formula.

Explanation
The 2D Formula Barcode
contains ingredient(s)
whose Ingredient ID(s)
exceeds the maximum
allowable characters (20).

Suggested Actions
Correct the length of the Ingredient ID, it must
not exceed 20 characters.
Print the 2D Formula Barcode and scan the new
2D Formula Barcode.

Text:

2D Formula Barcode
contains the following
errors. So 2D Formula
Barcode (X) cannot be
loaded.

1) Following manual
Ingredient Name(s)
exceeds the maximum
characters (25).

(%s)

You must correct the
manual Ingredient
Name(s) then load the
formula.

The 2D Formula Barcode
contains ingredient(s)
whose ingredient name(s)
exceeds the maximum
allowable characters (25).

Correct the length of the Ingredient Name, it
must not exceed 25 characters.

Print the 2D Formula Barcode and scan the new
2D Formula Barcode.

Text:

2D Formula Barcode
contains the following
errors. So 2D Formula
Barcode (X) cannot be
loaded.

1) Following Ingredient
Volume(s) does not meet
the format (HiHi#.##).

(%s)

You must correct the
Ingredient Volume(s)
format then load the
formula.

The 2D Formula Barcode
contains ingredient(s)
whose ingredient volume
does not meet the format
(Rt ).

Correct the format of the Ingredient Volume, it
must be of the format (###.##).

Print the 2D Formula Barcode and scan the new
2D Formula Barcode.

Operator Manual

ExactaMix Pro 2400 Compounder

Page 194

0719003109 Rev. A, Effective Jan 2022




Issue / On-screen Text
Text:
2D Formula Barcode

Explanation
The 2D Formula Barcode
contains same ingredients

Suggested Actions
Correct the Ingredient names having the same
ingredient name multiple times.

contains the following appearing multiple times 2. Print the 2D Formula Barcode and scan the new
errors. So 2D Formula whose volumes are 2D Formula Barcode.
Barcode (X) cannot be different.

loaded.

Ingredient (%s) appears
multiple times, with
volume (%d1) and
volume(%d2)

The barcodes for formulas | 1.
must use the Code39 2.
symbology, which has a
restricted character set.

Text:

Barcode reader (X):
barcode contains an
invalid Code 39 character.

Reprint the barcode.
Scan the barcode again.

The barcodes for formulas | 1.
must use the Code39 2.
symbology with a MOD43
check digit appended.

Text:

Barcode reader (X):
barcode contains an
invalid MODA43 check

Reprint the barcode.
Scan the barcode again.

digit.

Text: The barcode that was 1. Check that the network settings are correct.
Barcode reader (X): scanned does not matcha | 2. Check that the Ethernet cable is connected
invalid barcode or formula. properly to both the display and the order-

formula not available. entry computer.
3. Check the database to ensure that the formula

exists.

Issues with the Barcode Scanner Holder

Issue / On-screen Text Suggested Actions

Barcode scanner holder is loose | Use a Philips screwdriver to tighten the two screws that secures the
and moves when picking up or barcode scanner holder to the back of the display.
putting back the scanner If problem persists, please call Baxter Technical Support.

Barcode scanner holder is
broken

Call Baxter Customer Service to get a new barcode scanner holder. For
contact details, refer to Help.

Missing Barcode scanner holder | Call Baxter Customer Service to get a new barcode scanner holder. For

contact details, refer to Help.

Issues with the Display Cable

Issue / On-screen Text Suggested Actions

The display cable cannot be Make sure the smaller connector end of the cable is being used to plug
connected to the display into the display module. See the photos on page 24.

If problem persists, please call Baxter Technical Support.

Make sure the larger connector end of the cable is being used to plug
into the main module. See the photos on page 24.

If problem persists, please call Baxter Technical Support.

Call Baxter Technical Support to get a display cable. For contact details,
refer to Help.

Make sure the display cable connections are not loose.

If problem persists, please call Baxter Technical Support.

The display cable cannot be
connected to the main module

The display cable is damaged
(connectors and/or insulation)
Display has power but is not
communicating with the main
module
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Issue / On-screen Text
Text:
This formula contains
<ingredient name>, which
is not currently on the
configuration. Do you
wish to add it to the
configuration?

Explanation
The ingredient is an auto-
addition ingredient.

Issues with the Formulas, Ingredients and Configurations

Suggested Actions
Add the ingredient. Refer to Performing an Auto-
Addition on Page 90.

Text:

Configuration must be
verified before
compounding.

The configuration is not
primed and verified.

Prime and verify the configuration. Refer to Priming
and Verifying on Page 54.

Text: One or more ingredients 1. Tap Cancel.

The following ports are expired. 2. Check the expiration dates of all the
contain products that ingredients.

have been spiked longer 3. Change the container of each expired
than allowed. Port ingredient.

Product Time Spiked

Allowed Hang Time

(Hours) <list of products>.

Text: The ordered volume of the | 1. Tap Cancel.

Ingredient <ingredient
name> must be manually
added and its requested
volume of <requested
volume> mL exceeds the
maximum manual add
volume of <max manual
add volume> mL.

product exceeds the
maximum volume for
manual additions.

2. Check that the Drug ID is correct and that it
matches the Drug ID number from the order-
entry software. Refer to Adding or Editing a
Product on Page 142.

Text: The product is not Add the product manually. Refer to Performing a
Manual Add included in the Manual Addition on Page 84.
configuration, or its
ordered volume is less
than 0.2 mL.
The product is included in | Check that the Drug ID is correct and that it matches
the physical configuration, | the Drug ID number from the order-entry software.
and its ordered volume is Refer to Adding or Editing a Product on Page 142.
at least 0.2 mL, but it does
not match any products in
the software
configuration.
Text: The container is almost Check that the container is almost empty.

Swap Container: Your
container of <ingredient
name> is empty. You
have <remaining volume>
mL left to run. Please
change the container
now.

empty and needs to be
replaced.

e If the container is almost empty, replace it.
Refer to Replacing a Source Container on
Page 83.

e |f the container is not almost empty, check
that it is the correct container, and contact
Baxter Technical Support. Refer to Getting
Help on Page 20.
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Issue / On-screen Text
The OK button is not
active on the Hang Source
Containers screen, and the
ingredient buttons do not
change to a blue color.

Explanation
The ingredient detail
windows have not been
viewed.

Suggested Actions
Tap each ingredient button to view the details.
Refer to Attaching the New Ingredients and Inlets on
Page 45.

During priming, the fluid
does not flow through the
expected inlet.

The inlet is not attached
to the proper port.

1. Remove the source container from the vial rack
or hanger and turn it right-side-up, to prevent
fluid from flowing.

2. Remove the inlet from the incorrect port and
attach it to the correct port.

3. Return the source container to the vial rack or
hanger.

Text:
Formula Conflict:

Formula contains
incompatible ingredients
with insufficient flush
volume between them.

First Ingredient:
<ingredient name>

Second Ingredient:
<ingredient name>

Required Flush: <required
volume>

Available Flush:
<available volume>

There is not enough
ingredient flush between
incompatible ingredient
groups.

1. Tap Cancel.

2. Verify ordered volume of flush ingredient is
correct. If not, re-enter order.

3. Contact Baxter Technical Support. Refer to

Getting Help on Page 20.
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Issue / On-screen Text Explanation Suggested Actions
Text: The formula does not
ForrTN:JIa Conflict: contéin the minimum WARNING
Additional <flush volume> | required Universal
mL of <Universal Ingredient. If you choose to Increase Ingredient

Ingredient> required for Volume, the clinical impact should be
considered. This option increases the

flush.
volume in the bag and is not part of the
original order.

Increasing the Universal Ingredient
volume may change the overall formula
ordered. Consult a pharmacist before
compounding.

e Tap Change Ul To... to change the Universal
Ingredient to one that has the minimum
volume required and does not have flush
ingredient, without increasing the ordered
volume. Then tap OK and continue with the
steps below.

WARNING

A calibration bag must be used during

all Universal Ingredient flushes. You

must replace the original patient bag
A with a calibration bag for the flush, then

reattach the original patient bag. If this

is not done, the patient bag could

contain an unintended volume and/or
ingredient.

1. If a patient bag is attached, remove it. Refer to
Removing the Patient Bagon Page 75.

2. Change the Universal Ingredient. Refer to
Changing the Universal Ingredient on Page 98,
starting at Step 2.

3. Attach the patient bag. Refer to Attaching the
Patient Bag on Page 71.

4. Repeat the compounding process.

Operator Manual ExactaMix Pro 2400 Compounder
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Issue / On-screen Text
Text:
The requested product
<product name> cannot
be added to the
configuration as the flow
factors are not set up for
the associated inlet <inlet
name>.
Please confirm the correct
inlet is associated for this
product or enter the
correct flow factors for
the requested product
and associated Inlets.
Contact Baxter Technical
Support for help

Explanation

All ingredients need flow
factors prior to
compounding.

1.
2.

Suggested Actions
Tap OK on the error message.
Contact Baxter Technical Support for
adding/updating flow factors.

Text:

Formula cannot be
pumped. The following
Products

contain invalid flow
factors:

<list of products>
Please contact Baxter
Technical Support to
obtain the

correct flow factors and
for help to enter them
into the Formulary.

All ingredients need flow
factors prior to
compounding.

Tap OK on the error message.
Contact Baxter Technical Support for
adding/updating flow factors.
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Issues with the Calibration

On-screen Text ‘ Explanation ‘ Suggested Actions
Load cell not calibrated. The load cell is not Tap Yes.
Must calibrate to calibrated. Calibrate the load cell. Refer to Calibrating the

continue. Load Cell on Page 35.

Span The calibration of the load Check that:

Calibration out cell is out of range. e The load cell is level and locked into place.
of Range e There is nothing (for example, the outlet

tube, bag or cable for the load cell) touching

the pan or base of the load cell.
e There are no environmental factors (for

example, fans) interfering with the load cell.
Calibrate the load cell. Refer to Calibrating the
Load Cell on Page 35. Read the on-screen
messages carefully, and make sure that you do
not place the calibration weight on the load cell
too early.

The pump has not been
calibrated since the last
tube set change. This
operation must be
completed prior to
pumping a solution.

Would you like to
calibrate the pump now?

The pump is not
calibrated.

Tap Yes.
Calibrate the pump. Refer to Calibrating the

Compounder on Page 65.

Pump calibration failed.

The calibration of the
pump failed.

Follow steps above for Span Calibration out of
Range.
For the source container of water, check the
following conditions. Refer to Attaching the
New Ingredients and Inlets on Page 45.
i. The correctinlet is used.
ii. Theinletis not kinked.
iii. The bagis spiked properly (all the
way up to the flange). Refer to
Page 49.
Clean any spills near the pump rotor. Refer to
Cleaning the Compounderon Page 93.
Calibrate the load cell. Refer to Calibrating the
Load Cell on Page 35.
Check that the valve set is installed properly.
Refer to Installing the New Valve Set on
Page 42.
Calibrate the pump. Refer to Calibrating the
Compounder on Page 65.

Text:

You have exceeded the
maximum allowed
calibration limit of
20000mL, the system will
recalibrate now. Do you
want to calibrate now?

Too many bags have been
processed without
meeting the 175 mL auto-
calibration threshold.
Therefore, a manual
calibration is required.

Click Yes
Calibrate the pump. Refer to Calibrating the
Compounder on Page 65.
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On-screen Text
Expected Weight:
<calculated weight> gm

Actual Weight: <actual
weight> gm

Difference: <weight
difference>%

The final weight of this
solution is outside of the

acceptable limit of +/-5%

Possible Cause: Unknown

Issues with the Weight and Load Cell

Explanation
The final bag weight is out
of range.

After the compounder
delivers all the
ingredients, the weight of
the patient bag differs
from the expected weight
by more than the
acceptable difference.

Suggested Actions
Check that all the source containers are spiked
properly. Refer to the steps for spiking a
container, starting on Page 48.
Check that the outlet tube is installed properly.
Refer to Installing the New Valve Set on
Page 42.
Turn the spike on the SWFI % turn then
Calibrate the pump. Refer to Calibrating the
Compounder on Page 65.
Calibrate the load cell. Refer to Calibrating the
Load Cell on Page 35 the re-calibrate the pump.
Check that the pump rotor is clean. Refer to
Cleaning the Compounder_on Page 93.

Expected Weight:
<calculated weight> gm

Actual Weight: <actual
weight> gm

Difference: <weight
difference>%

The final weight of this
solution is within the
acceptable limit of +/-5%,
however some
ingredients may not have
delivered correctly.

Possible Cause:
<ingredient name> is
possibly <underweight /
overweight> by <weight
error> grams

An individual ingredient
delivery is out of range.

After the compounder
delivers an ingredient, the
weight of the patient bag
differs from the expected
weight by more than the
acceptable difference.

The compounder checks
the weight after individual
ingredient deliveries over
100 mL.

Check that all the ingredients and inlets are
correct and spiked correctly with emphasis on
the possible cause ingredient.

Check that the valve set is installed properly.
Refer to Installing the New Valve Set on

Page 42 and Attaching the New Ingredients and
Inlets on Page 45.

On the MixCheck Report, check for references
to occlusions and bubbles. Refer to MixCheck
Report on Page 160. Have a pharmacist check
the accuracy.

Check that the pump rotor is clean. Refer to
Cleaning the Compounder_on Page 93.
Calibrate the load cell. Refer to Calibrating the
Load Cell on Page 35.

Calibrate the pump. Refer to Calibrating the
Compounder on Page 65.

Compound a large-volume solution with at
least 205 mL of water to make the compounder
calibrate automatically.

Contact Baxter Technical Support to check that
the flow factors are correct. Refer to Getting
Help on Page 20.

Bag out of range

Dextrose is pumping too
quickly or slowly.

Check that there are no environmental factors

interfering with pumping dextrose.

o Keep the room temperature stable.

o Always allow refrigerated dextrose to return
to room temperature before using it.

Check that the source container is spiked

properly. Refer to the steps for spiking a

container, starting on Page 48.

Check that the correct inlet is assigned to

dextrose in the formulary. Refer to Adding or

Editing a Product on Page 142.

Operator Manual

ExactaMix Pro 2400 Compounder

0719003109 Rev. A, Effective Jan 2022

Page 201




Glossary

On-screen Text
The bag currently on the
load cell does not appear
to be empty.

Explanation
Before pumping starts, the
load cell detects that the
destination bag contains
fluid.

Suggested Actions
If the bag is not empty, and you are:
e Compounding the solution, refer to
Compounding the Solution Step 2 on
Page 72.
e  C(Calibrating the compounder, refer to
Calibrating the Compounder_Step 4 on
Page 65.

If the bag is empty:
1. Tap No.

2. Atthe Operation Cancelled message, tap OK.
3. Remove the bag from the load cell. Refer to:
e Removing the Patient Bag_on Page 75

e Removing the Calibration Bag_on Page 69
4. Calibrate the load cell. Refer to Calibrating the
Load Cell on Page 35.
5. If necessary, reattach the appropriate bag to
the load cell. Refer to:
e Attaching the Patient Bag on Page 71
e Attaching the Calibration Bag on Page 68

There does not appear to
be a bag hung on the
scale.

The load cell detects that
the destination bag is not
attached.

If the bag is not attached, attach the appropriate
bag to the load cell. Refer to:

e Attaching the Patient Bag on Page 71

e Attaching the Calibration Bag on Page 68

If the bag is attached:
e Tap No.
e C(Calibrate the load cell. Refer to Calibrating
the Load Cell on Page 35.

Issues with the Pump

On-screen Text
[Error: 01-13-002] Unable
to start the pump
because the pumpisina
fault state.

Explanation
The pump fault occurred.

Suggested Actions
1. Atthe pump screen, tap Stop and follow the
on-screen instructions.
2. Reboot the compounder. Refer to Rebooting
and Shutting Down on Page 32.

Pump faulted. Unable to
close valve. Valve is
moving.

A system fault or power
loss occurred.

1. Write a large “X” on the label of the patient
bag, then remove and discard the bag.

2. Reboot the compounder. Refer to Rebooting
and Shutting Down on Page 32.

Pump is in fault state and
must be reset before use.
Reset the pump?

A pump fault occurred.

Tap Yes to reset the pump.
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Issues with the Occlusion Detector / “Flow Sensor”

NOTE: For all messages about the occlusion detector self-test, tapping Cancel displays a Contact
Baxter message and disables your ability to compound a solution or calibrate the compounder.

On-screen Text
The Occlusion Detector
Test failed.
Sensor failure.

Select OK to retry
Select Cancel to exit

Explanation
The test failed, possibly
because the detector
malfunctioned or the tube
set was not installed

properly.

Suggested Actions
1. Verify the outlet tube is lying flat along the top
of the occlusion sensor and that the tubing is
pushed all the way down into the bubble
detector.
2. Contact Baxter Technical Support. Refer to
Getting Help on Page 20.

The Occlusion Detector
Test failed.

Air detected in fluid
pathway.

Select OK to Retry.
Select Cancel to Exit.

The test failed because an
air bubble was detected in
the common fluid
pathway.

1. Tap Cancel.

2. To help reduce the occurrence of bubbles and
make their detection more accurate, refer to
the note on Page 87.

NOTE: To perform the test again, you must re-prime
at least one non-Ul inlet and then exit the PRIME
AND VERIFY screen.

The Occlusion Detector
Test failed.
Pump door open.

Select OK to Retry.
Select Cancel to Exit.

The test did not finish
because the pump door
was opened during the
test.

1. Close the pump door.
2. Tap OK. The test occurs again.

The Occlusion Detector
Test failed.
Pump was paused.

Select OK to Retry.
Select Cancel to Exit.

The test did not finish
because the pump was
paused during the test.

Tap OK. The test occurs again.

The Occlusion Detector
Test failed.

Select OK to Retry.
Select Cancel to Exit.

The test failed for an
unknown reason.

Tap OK. The test occurs again.

The Occlusion Detector
Test did not run because
the bubble test failed.

The test did not start
because an air bubble was
detected in the common
fluid pathway, or the
outlet tube was not
installed properly.

1. Tap Cancel.

2. To help reduce the occurrence of bubbles and
make their detection more accurate, refer to
the note on Page 87.

NOTE: To perform the test again, you must re-prime
at least one non-Ul inlet and then exit the PRIME
AND VERIFY screen.

Cannot set flow sensor
status:

The compounder failed to
set the status of the
occlusion detector when
starting to pump.

Contact Baxter Technical Support. Refer to Getting
Help on Page 20.
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Other Issues

Issue / On-screen Text
The compounder does not
power up.

Explanation
The power cord or the
cable for the display is
disconnected.

Suggested Actions

1. Check that the power cord is connected to
the main module and the power source.

2. Check that the cable for the display is
connected properly to both the display and
the main module.

3. Press and hold the power button until the
green LED is illuminated.

4. Clean the power button.

The power source is not
functional.

Connect the power cord to another power source.

The screen of the display
does not respond to
touch.

The cable for the display is
not fully connected.

1. Check that the cable for the display is
connected properly to both the display and the
main module.

The compounder cannot
retrieve orders from the
order-entry computer.

The network is
temporarily unavailable.

1. Verify the order entry computer is powered
on.

2. Verify network connectivity. If the network
is down, load the formula by connecting a
USB drive. Refer to Loading a Formula by
Connecting a USB Drive on Page 206.

The MixCheck Report does
not print.

The printer is
disconnected or turned
off.

Check that the printer is connected and turned on.

Printing was cancelled
inadvertently.

The message about the MixCheck Report being
printed appears after you tap OK at the message
about the final weight. If you quickly tap more than
once, you might inadvertently tap Cancel Printing.
Reprint the report.

The path to the printer is
not set up properly.

Check the path to the printer. Refer to Setting Up
the Directories Options on Page 110.

Text:

An unknown pump
error/valve error
occurred

An internal software error
occurred.

1. Reboot the compounder.
Contact Baxter Technical Support. Refer to Getting
Help on Page 20.

Text:
Bad file format

The 2D Formula
Barcode/.PAT/.FRM file
being read does not match
the expected format.

Create a new order in the order-entry software.

Text:

Cancellation in progress.
Solution will need to be
discarded. Continue?

During the compounding
process, a hecessary
container replacement
was cancelled.

1. Tap Continue.
2. Write a large “X” on the label of the patient
bag, then remove and discard the bag.

Text:
Cannot open DB file X
exclusively

Compaction of the
database failed because
another program was
accessing the database.

1. Close the other program that is accessing the
database.

2. Try compacting the database again. Refer to
Compacting the Database on Page 97.

3. Reboot the compounder. Refer to Rebooting
and Shutting Down on Page 32.

Operator Manual

ExactaMix Pro 2400 Compounder

Page 204

0719003109 Rev. A, Effective Jan 2022




Issue / On-screen Text
Text:
Cannot open DB X after
compaction

Explanation
The database was
compacted but cannot be
opened. There may be a
hard drive error or
database corruption.

Suggested Actions
Contact Baxter Technical Support. Refer to Getting
Help on Page 20.

Text: The pump failed to Close the pump door.
Cannot resume: resume compounding.
Text: The cable for the display is | Check that the cable for the display is connected

Compounder connection
not established. Must
connect to continue.

disconnected or damaged.

properly to both the display and the main module,
and that the cable is not damaged.

Text:
No Pump Device Assigned

A software error occurred.

Reconnect the cord and cables. Refer to Step 6 on
Page 24.

Text:
No Scale Device Assigned

A software error occurred.

Reconnect the cord and cables. Refer to Step 6 on
Page 24.

Text:
No Valve Device Assigned

A software error occurred.

Reconnect the cord and cables. Refer to Step 6 on
Page 24.

Text:
Time out.

A hardware
communication error
occurred.

1. Shut down the compounder. Refer to
Rebooting and Shutting Down on Page 32.

2. Check that the cord and cables are connected
properly. Refer to Installing the Compounder
on Page 22.

3. Turn the compounder on. Refer to Starting Up
and Logging In on Page 30.

Text:
Unable to save current DB

The current database
cannot be saved. There
may be a hard drive
failure, missing directory,
network failure (if the
destination is on a
network drive) or issue
with permissions.

Contact Baxter Technical Support. Refer to Getting
Help on Page 20.

Text: A port cannot be closed. Reboot the compounder. Refer to Rebooting and
Valve is moving. Shutting Down on Page 32.
Text: Backup failed due to If you are saving backups on a server confirm the

Backup failed:
‘<Configured Backup path
with Database name>’ is
not a valid path. Make
sure that the path name
is spelled correctly and
that you are connected to
the server on which the
file resides

either a network failure or
an incorrect backup folder
path.

network connectivity.

If the problem persists, check the path of the
backup folder. Refer to Setting Up the Directories
Options on Page 110.

Text:

Your account has been
locked because the
number of consecutive
log-in failures exceeded
the maximum allowed

For security purposes,
your account is locked
after 3 unsuccessful
consecutive attempts to
login.

After your account is locked, you must wait at least
5 minutes before attempting another login.
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LOADING A FORMULA BY CONNECTING A USB DRIVE

Some facilities may use this method if they use order-entry software but the network is
temporarily unavailable.

IMPORTANT! This method requires:

e Formula Entry permissions. For more information about user groups and permissions,
refer to Setting Up the Users on Page 120.

e Order-entry software on a separate computer. This software must be able to produce
both a .PAT/.FRM file and a corresponding label with a barcode. Both the .PAT/.FRM file
and barcode must be compatible with the compounder. Abacus software meets these
requirements. For more information, or if a barcode cannot be printed, contact Baxter

Technical Support. Refer to Getting Help on Page 20.

e USBdrive
NOTE: Be sure that the USB drive is free of viruses.

e Barcode reader at the compounder
In the order-entry software, the pharmacist creates an order, which creates a barcode and the
corresponding .PAT/.FRM file that contains the patient information and the formula. The
pharmacist saves the order onto a USB drive. A corresponding label with the barcode also prints
at the same time. Typically, a technician applies this label to a new patient bag and brings it to
the compounder. However, this process depends on your facility’s protocol.

At the compounder:
1. Connect the USB drive to a USB port on the bottom of the display.
2. Set up the ExactaMix Pro software to look for formula files on the USB drive. For
instructions, refer to Setting Up the Directories Options on Page 110.
NOTE: The software will continue to look for formula files in this location until you
change it back to the original location.
3. Scan the barcode on the label of the patient bag.

The compounder retrieves the order file from the USB drive and populates the pump
screen with the name and volume of each ingredient to be pumped. The compounder
reads the Drug ID number of each ingredient in the formula and matches this number
to one in the formulary. In the United States, the Drug ID number is usually the NDC.

WARNING

The Drug ID number for each product in the formula must exactly match the
Drug ID number for that product in the compounder’s formulary. If a Drug ID

A number is assigned to one product in the order-entry software, and that

number is assigned to a different product in the compounder’s formulary, the
compounder may pump the wrong ingredient. It is the user’s responsibility to
ensure that Drug ID numbers are properly and consistently assigned in both
systems.
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NOTE: If any ordered ingredients are not in the configuration on the compounder, are
not allowed as auto-additions or have a volume less than 0.2 mL, the compounder
software will identify these ingredients as manual additions.

4. Continue with Fulfilling the Order (Basic Process) on Page 70.

RESTORING THE DATABASE

If certain types of issues occur, Baxter Technical Support may ask you to restore the database.

1. Atthe menu screen, tap Tools > Database > Restore Database.
2. Atthe Do you wish to backup message, if you:
e Want to back up the current database before restoring, tap Yes and continue with
the next step.

e Do not want to back up the current database before restoring, tap No and skip to
step 5.

‘ @ Do you wish to backup the current database before
) ~ restoring?

[ Yes ] [ No ]

Message

3. Atthe Backup Database Location window:
a. If desired, change the location of the backup by tapping the button to the right of
the current location (not recommended).
b. Check Overwrite Existing File? to replace the previous backup file.
c. Tap OK.

Backup Database Location

Database File Name

‘D /EM/em2400bak2021-10-04-16-57-27.db ‘ I

[v]Overwrite Existing File?

[ oK ] [ Cancel ]

Backup Database Location window

4. At the Backup succeeded message, tap OK.

Backup succeeded: file is /[EM/
em2400bak2021-10-04-16-57-27.db.

Message

-
A
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5. Atthe Restore Database Location window:
a. If desired, change the location of the backup you want to restore by tapping the
button to the right of it.
b. Tap OK.

Restore Database Location

Database File Name

§ /EM/em2400bak.db | (..)

[ oK ] [ Cancel ]

Restore Database Location window

6. Atthe Database restored successfully message, tap OK. The compounder is now ready
to use the restored database.

0 Database restore of /EM/em2400bak.db succeeded.

Message

NOTE: Upon login Baxter recommends resetting the directories to the correct path. Refer to
Setting Up the Directories Options on Page 110.
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Use this glossary to help you understand any terms that may be unfamiliar.

Term

Definition

acceptable weight

The percentage by which the final weight of the compounded solution, or the

variance weight of an ingredient delivery, is allowed to differ from the expected weight.
You can specify the variance.
Alarm An audible tone that indicates an error state.

Auto-addition

An option that allows you to add an ingredient to the existing configuration when
needed, instead of selecting a new configuration (which would require you to
prime and verify all the inlets and ingredients).

Backup The process and result of saving database information to a location other than the
compounder.

Base plate The common base on which the compounder’s components sit.

Blackbox data The logged activities of the compounder, mainly based on the communication
between software, firmware and user actions.

Cardioplegia A specific combination of ingredients used to induce cardiac arrest during cardiac

surgery.

Common fluid pathway

The area from the port through the valve set to the destination bag. One or more
ingredients can be present in this area.

Compounder The complete device with all of its hardware components and software, excluding
the tube set and bags.
Compound / The process of pumping ingredients into a patient bag.

compounding

Configuration

A designation of the products that will be attached to the ports, the sequence in
which they will be pumped, any allowable auto-additions, the ingredient and
volume to use for any ingredient flushes, the Universal Ingredient and the volume
to use for the final flush.

Continuous Renal
Replacement Therapy
(CRRT)

A form of therapy to dialyze acute patients continuously, when these patients
cannot tolerate conventional dialysis.

Daily setup

The process of attaching all the ingredients for a specific configuration to the
compounder and preparing to compound solutions. Includes priming, verification
and calibration.

Daily use components

The disposable components (tube set) and destination bags.

Database

Information containing operating parameters, the formulary and other definable
variables to be used by the compounder.

Deliver / delivering

The act of pumping ingredients from a source container to the destination bag.

Delivery

A single, measured volume of fluid that has been pumped into the destination
bag.

Destination bag

A sterile container that holds the fluid pumped from the source containers. It can
be a patient bag (used for delivering the finished solution to a patient) or a
calibration bag (used for collecting any fluid that is not intended for a patient).

Direct entry mode

A mode where you enter a formula manually by specifying the ingredient and
volume to be delivered from each port.

Display The touch-screen display for the user interface. It mounts to the base plate.
Disposables See tube set.
Dose A specific volume and concentration of an ingredient.

Electronic Y-site

A setup option that helps to improve the efficiency of pumping common
ingredients. When the first container of this ingredient has emptied, the
compounder continues pumping from the next container of this ingredient.

Enhanced flush

Two intermediate flushes followed by the final flush.

Epidural

An injection into the epidural space of the spine for regional anesthesia.
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Term Definition
Equivalent ingredient Products of the same ingredient type that may have different container sizes,
products container types or manufacturers.
Final flush A delivery of fluid that is pumped to clear all delivered ingredients from the

common fluid pathway, to ensure that these ingredients are fully present in the
finished solution. The fluid used for this flush is always the Universal Ingredient.
The standard volume is 30 mL, but it can be changed.

Finished solution

The ingredients in the patient bag after compounding, including manual additions.

Flow factor

A value associated with each ingredient that compares the flow of that ingredient
to the flow of water. The flow factor accounts for the ingredient’s viscosity, the
size and type of its source container, its inlet, its venting and other factors that
affect its delivery.

Fluid pathway

See common fluid pathway.

Flush See final flush, ingredient flush or intermediate flush.

Formula A recipe of ingredients to be compounded. Typically, it is created by the
pharmacist, based on a prescription from a physician.

Formulary The list of ingredients, and associated products, that can be attached to the

compounder.

Incompatible group

A group of ingredients that you identify as having interaction concerns with other
ingredients.

Ingredient

A solution of a specific chemical entity at a specific concentration, regardless of
the container size, container type or manufacturer. One ingredient may have
several associated products.

Ingredient flush

A delivery of fluid that is pumped to clear the common fluid pathway between the
delivery of certain ingredients that have interaction concerns. The fluid used for
this flush is usually the Universal Ingredient, but it can be any compatible
ingredient in the configuration and formula.

Ingredient group

A list of chemically similar ingredients, used for defining incompatible groups.

Inlet

A sterile tube with a spike or Luer end attached. The spike or Luer end attaches to
a source container, and the other end attaches to a port on the valve set.

Intermediate flush

A delivery of fluid that comes just before the final flush as part of an enhanced
flush. The fluid used for this flush is always the Universal Ingredient, and it is
pumped in two deliveries of 50 mL each.

Large-volume delivery

See macro ingredient.

Load cell

The component that holds the destination bag, weighs the compounded solution
and reports the measurement to the software. It mounts to the base plate.

Macro ingredient

A generic term used to describe an ingredient that uses a large-bore inlet and is
delivered in volumes equal to or greater than 5 mL.

main module

The component that contains the valve actuators, occlusion detector, bubble
detector, pump chamber and power supply. It mounts to the base plate.

Maintenance

The act of performing scheduled or expected work on the compounder.

Manage

The act of creating, modifying, saving or deleting information within the software.

Manual addition

A product that is added to the compounded solution manually, after compounding
has finished.

Message

Small on-screen window or other text that provides information or instructions
but does not allow entry of information.

Micro ingredient

A generic term used to describe an ingredient that uses a micro inlet and is
delivered in volumes less than 5 mL.

National Drug Code

A unique, three-segment number used in the United States to identify drug

(NDC) products used by humans.
Occlusion A blockage in the fluid pathway.
OEM Original Equipment Manufacturer i.e., Baxter Healthcare
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Term
outlet tube

Definition
The section of tube on the discharge side of the valve set. It connects the valve set
to the destination bag.

.PAT file Afile, created in the order-entry software, that contains the patient information
and formula.
.FRM file An encrypted file, created in the order-entry software, that contains the patient

information and formula.

2D Formula Barcode
Label

A label, printed by the order-entry software, that includes patient information and
formula and a 2D Barcode.

Patient

The recipient of the finished solution.

Permissions

The privileges granted to groups of users to allow them to perform specific
functions.

Pop-up message

A temporary window that appears to notify the user that they need to take an
action.

port The interface between the valve set and the inlets for source containers.

prime To pump a small volume of an ingredient through an inlet, to remove air bubbles
from the inlet and prepare it for compounding the solution.

privileges See permissions.

product An ingredient in a particular container size and type from a specific manufacturer.
Several products can be associated with one ingredient.

pump A peristaltic device used to push fluid through the outlet tube.

pump module See main module.

remainder A value in the software that represents the actual volume of fluid remaining in the
source container.

scale See load cell.

screen Information window that occupies the entire display

sequence The order in which ingredients are pumped/delivered to the destination bag.

solution The mixture of ingredients that have been compounded.

small-volume delivery

See micro ingredient.

source container

A container (bag, bottle, vial or syringe) that holds one ingredient.

tolerance

The amount by which any characteristic (for example, dimensional, chemical,
physical or mechanical properties) may vary from that specified.

Total Parenteral
Nutrition (TPN)

A form of intravenous therapy that requires multiple fluid ingredients to be
accurately compounded into a single solution to support a patient’s nutritional
needs.

tube set

The valve set and inlets.

Universal Ingredient (Ul)

The ingredient that is used to flush the common fluid pathway. This ingredient
must be included in the configuration and the formula being compounded.

unload

The precaution of removing a formula from the pump screen when you navigate
away from this screen. Unloading does not delete the formula from the database.

user accounts

The accounts that contain the user names, user permissions and other attributes
as determined by the facility.

valve set A sterile, multiple-port valve with an outlet tube attached. The valve body fits over
the valve actuators on the compounder, protecting them from damage. The outlet
tube attaches to the destination bag.

variance One measure of statistical dispersion, averaging the squared distance of its
possible values from the expected value (mean).

volume The physical amount of the ingredient that is delivered, typically in milliliter (mL)
units.

window An on-screen feature that provides information or instructions and allows you to

make choices or enter information. Pay attention to the text, because some
windows may include critical information.
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APPENDIX

SPECIFICATIONS

Display
Operating software: Linux Yocto Project
CPU: Quad-core Arm® Cortex®-A9 1.2 GHz
System on Module (SOM) ConnectCore 6+, Cortex®-A9
Memory: 8 GB flash, 2 GB DDR3, 64 GB Micro SD card
Screen Resolution: WXGA (1280 x 800)
Ethernet: 1 Gigabit Ethernet network connectivity
USB ports: 4 ports, USB 2.0 supporting USB 1.1/2.0
Wi-Fi Compatibility IEEE 802.11 a/b/g/n/ac
For radio frequencies and power transmitted, refer to:
ConnectCore 6 Plus Hardware Reference Manual (digi.com)
Barcode scanner holder Length: 4.4 in. (11.3 cm)
specifications Width: 3.33 in. (8.5 cm)
Height: 7.4 in. (18.8 cm)
Weight: 0.14 |b (0.06 kg)

The display supports the connection and use of a USB 1.1/2.0 keyboard and mouse.

Dimensions

Main module: Width: 24 in. (61 cm)
Depth: 10 in. (25.4 cm)
Height: 10 in. (25.4 cm)

Display: Width: 11.5in. (29.1 cm)
Depth: 2.2 in. (5.5 cm)
Height: 7.9 in. (20 cm)

Load cell: Width: 13 in. (33 cm)
Depth: 8 in. (20.3 cm)
Height: 10 in. (25.4 cm)

Compounder, Width: 33 in. (76.2 cm)

without vial rack: Depth: 19 in. (48.3 cm)
Height: 12 in. (30.5 cm)

Compounder, Width: 41 in. (104 cm)

with vial rack: Depth: 20 in. (50.8 cm)

(these may vary with vial Height: 30 in. (76.2 cm)

rack size)

Weight

Main module: 40.0 1b (18.14 kg)

Display: 4.31b (1.95 kg)

Load cell: 5.11b (2.3 kg)

Base: 13.01b (5.89 kg)

Vial rack: Less than or equal to 13.2 Ib (6 kg)

Compounder Approx. 75 Ib (34 kg)
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https://www.digi.com/resources/documentation/digidocs/pdfs/90002278.pdf

Electrical

Power: 100-240 V AC RMS, 50-60 Hz, 336 W
Line cord: Use only a Baxter approved line cord
Display Cable: Use only a Baxter approved display cable

Fuse ratings:

EXACTA-M

There are two 4 AMP, 5x20mm, SLOW BLOW fuses located in the AC
power inlet connector under the EXACTA-M Main Module.

2400-M

There is no user accessible fuse on the 2400-M Main Module.

Performance

Accuracy:

+0.03 mLat0.2 mL;
+0.03 mL at 0.4 mL;
+0.06 mLat1mL;

+ 5% at 10 mL and greater

Dispensing of ingredients:

Increments of 0.01 mL

Volume of source containers:

0.2-5,500 mL

Volume of destination bags:

125-5,000 mL

Maximum flow rate of water:

16.6 mL/second

Maximum number of ingredients:

24

Maximum capacity of vial rack:

16 (small-volume vials and 60 mL Luer syringes)

Environmental Conditions

Operating temperature:

59-86°F (15-30°C)

Storage temperature:

32-147°F (0-64°C)

Maximum relative humidity:

10-80%

Maximum altitude:

Not to exceed 3,000 m

Main supply voltage fluctuation:

Not to exceed +10%

Sound pressure level:

Not to exceed 85 dBA

For Indoor Use Only

ISO Class 5 (Class 100) cleanroom as defined in ISO 14644-1:1999

Class | Equipment (Grounded Type)

Installation (Over Voltage) Category |l

Pollution Degree 2 Environment

The maximum circuit voltage of USB 1.1/2.0is 5.0 V DC with a maximum current of 500 mA DC
(all ports combined). Use only Baxter-supplied USB devices.

This equipment is intended for use in a “basic electromagnetic environment” as defined per IEC
61326; such as an office, pharmacy, or clinic. It is not intended to be used in an “industrial
environment” or near equipment either sensitive to electromagnetic interference or near
equipment that emits electromagnetic interference such as large electrical machinery or near
MRI, CAT, Electrosurgical or Electrocautery or similar equipment. If you find that this
equipment creates interference with other nearby equipment or is affected by other nearby
equipment try changing the orientation or separation of each equipment to reduce the effect.
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IMPORTANT! In the event of an Electrostatic Discharge (ESD), a system shutdown may occur.
Upon system restart, any in-progress formulations before the ESD event will be unloaded and
the valve set will be flushed. See the Power Interruption information on page 76.

WEEE Compliance

e This symbol on a Baxter product or its packaging means that the product
should not be disposed of with general waste. It is your responsibility to
dispose of your waste equipment separately from the municipal waste
stream. The correct disposal of your end-of-life equipment will help prevent
potential negative consequences for the environment and human health.

e Baxter endeavors to reduce the environmental and human health effects of
electrical and electronic equipment at the time it is being discarded and
offers its EU customers details on to facilitate environmentally sound
disposal of this equipment at:
http://www.baxter.com/assets/europe/directives/weee/index.html

WI-FI COMPLIANCE

United States

This device complies with part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

FCC CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

FCC CAUTION: This transmitter must not be co-located or operated in conjunction with any
other antenna or transmitter.

Canada

This device contains licence-exempt transmitter(s)/receiver(s) that comply with Innovation,
Science and Economic Development Canada’s licence-exempt RSS(s). Operation is subject to
the following two conditions: 1. This device may not cause interference. 2. This device must
accept any interference, including interference that may cause undesired operation of the
device.

L’émetteur/récepteur exempt de licence contenu dans le présent appareil est conforme aux
CNR d’Innovation, Sciences et Développement économique Canada applicables aux appareils
radio exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : 1.
L'appareil ne doit pas produire de brouillage; 2. L’appareil doit accepter tout brouillage
radioélectrique subi, méme si le brouillage est susceptible d’en compromettre le
fonctionnement.

for indoor use only
Pour usage intérieur seulement

Data transmission is always initiated by software, which is the passed down through the MAC,
through the digital and analog baseband, and finally to the RF chip. Several special packets are
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initiated by the MAC. These are the only ways the digital baseband portion will turn on the RF
transmitter, which it then turns off at the end of the packet. Therefore, the transmitter will be
on only while one of the aforementioned packets is being transmitted. In other words, this
device automatically discontinues transmission in case of either absence of information to
transmit or operational failure.

La transmission des données est toujours initiée par le logiciel, puis les données sont transmises
par l'intermédiaire du MAC, par la bande de base numérique et analogique et, enfin, a la puce
RF. Plusieurs paquets spéciaux sont initiés par le MAC. Ce sont les seuls moyens pour qu'une
partie de la bande de base numérique active I'émetteur RF, puis désactive celui-ci a la fin du
paquet. En conséquence, I'émetteur reste uniquement activé lors de la transmission d'un des
paquets susmentionnés. En d'autres termes, ce dispositif interrompt automatiquement toute
transmission en cas d'absence d'information a transmettre ou de défaillance.

This equipment complies with ISED radiation exposure limits set forth for an uncontrolled
environment and meets RSS-102 of the ISED radio frequency (RF) Exposure rules as this
equipment has very low levels of RF energy.

Cet équipement est conforme aux limites d’exposition aux rayonnements énoncées pour un
environnement non controélé et respecte les regles d’exposition aux fréquences
radioélectriques (RF) CNR-102 de I'ISDE puisque cet appareil a une niveau tres bas d'energie RF.

Taiwan

ARG L IE N RARGS, JRACHGNE, A3, TABESLHE A AR S S,
IR BT R L HFPER INRE, (KNI £ R BN 2 T4
ERIEME  EIPEATEBIGNG, BE N, W S AR, A
EEIBIE, IRCEREF R S TIE(E. R AR A 8% OB (R
T, BB P A A P R G 2 T

English Translation: Without permission granted by the NCC, any company, enterprise, or user
is not allowed to change frequency, enhance transmitting power or alter original characteristic
as well as performance to approved low power radio-frequency devices. The low power radio-
frequency devices shall not influence aircraft security and interfere legal communications; If
found, the user shall cease operating immediately until no interference is achieved. The said
legal communications means radio communications is operated in compliance with the
Telecommunications Management Act. The low power radio-frequency devices must be
susceptible with the interference from legal communications or ISM radio wave radiated
devices.

R 7, 5 BE R T R 22 R o R A
English Translation: The use of equipment near radar systems should be avoided.
v A iR TP TR L A5 7 381 7 R S R SR

English Translation: High-gain directional antennas can be used only in fixed point-to-point
systems.
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WARRANTY STATEMENT

Baxter Healthcare Corporation provides a limited warranty for the ExactaMix Pro 2400
Compounder.

See your lease or purchase contract for details about the warranty.

If the equipment is under warranty, Baxter will replace the defective equipment. Equipment
that is not under warranty can also be replaced, however, the customer is responsible for the
cost of repairs and shipping.

Baxter Healthcare Corporation warrants that the ExactaMix Pro 2400 Operating Software will
perform as described in the operator manual, by the release notes with the currently released
version and when operated on a properly configured computer using a properly configured load
cell and barcode reader. Where there is a discrepancy between the manual and the operation
of the software, Baxter Healthcare Corporation may, at its discretion, revise either the software
or the text of the manual.

This software is intended solely for the operation of the ExactaMix Pro 2400 Compounder for
the preparation of compounded sterile formulas. It is not intended to replace the professional
knowledge or judgment of a Registered Pharmacist in the preparation of such formulas.

No other warranties, whether express or implied, made by any representative or other agent of
Baxter Healthcare Corporation shall be binding upon Baxter Healthcare Corporation. This is an
exclusive warranty.
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